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For B1500A Users

Agilent B1500A supports the following measurement resources. For reading this
manual, ignore the information about the other resources.

HPSMU High power source/monitor unit (B1510A)

MPSMU Medium power source/monitor unit (B1511A/B1511B)

MCSMU Medium current source/monitor unit (B1514A)

HRSMU High resolution source/monitor unit (B1517A)

MFCMU or CMU Multi frequency capacitance measurement unit (B1520A)
HVSPGU or SPGU High voltage semiconductor pulse generator unit (B1525A)
WGFMU Waveform generator/fast measurement unit (B1530A)

For B1505A Users

Agilent B1505A supports the following measurement resources. For reading this
manual, ignore the information about the other resources.

HPSMU High power source/monitor unit (B1510A)

MPSMU Medium power source/monitor unit (B1511A)

HCSMU High current source/monitor unit (B1512A)

MCSMU Medium current source/monitor unit (B1514A)

HVSMU High voltage source/monitor unit (B1513A/B1513B)

MFCMU or CMU Multi frequency capacitance measurement unit (B1520A)

HVMCU High voltage medium current unit (N1266A with one B1513B and two
B1514A/B1512A)

UHCU Ultra high current unit (N1265A with two B1514A/B1512A)
UHVU Ultra high voltage unit (N1268A with two B1514A/B1512A)



NOTE

In This Manual

This manual describes the reference information of Agilent Technologies EasyEXPERT
which is the system software of Agilent Technologies B1500 device analyzer series.
This manual consists of the following chapters.

1.

Main GUI

Provides the reference information of the EasyEXPERT main GUL.

Classic Test Definition

Provides the reference information of the classic test setup GUI.

Application Test Definition

Provides the reference information of the application test definition setup GUI.
Function Details

Explains the several functions and the initial settings of the B1500/EasyEXPERT.
Built-in Programming Tool

Provides the reference information of the built-in mathematical functions and the
read-out functions.

User’s Guide Vol. 2 consists of the following chapters.

6.
1.
8.
9.

Remote Control Interface
Utilities
Application Library

If You Have a Problem

10. Error Messages

To get the latest firmware/software/manual/support information, go to
www.agilent.com and type in EasyEXPERT in the Search field at the top of the page.
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NOTE

Main GUI

This chapter provides the reference information of Agilent EasyEXPERT main GUI.

“Start EasyEXPERT”
“Workspace Configurator”
“Main Screen”

“Application Test”

“Tracer Test”

“Quick Test”

“Repeat M easurement Setup”
“Organize Preset Group”
“Calibration”

“Configuration”

“Switching Matrix Operation Panel”
“Standby Channel Definition”
“Data Display”

“Preview”

“Text File Export settings’

Touch Screen Operation

If you use touch screen operation than mouse, change the font size of menu. Font
size 14 is recommended for the touch screen operation.

Open the Control Panel, select Appearance and Themes, and select Display to open
the Display Properties dialog box. Select the Appearance tab, and click the
Advanced button to open the Advanced A ppearance dialog box. On the dialog box,
set Item to Menu, and set the Sze of Font to 14.
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Main GUI

To start EasyEXPERT, see “ Start EasyEXPERT” on page 1-4 and “Workspace
Configurator” on page 1-5.

To perform application test setup, see “Application Test” on page 1-29.
To perform classic test setup, see “ Classic Test Definition” on page 2-1.
To perform tracer test setup, see “ Tracer Test” on page 1-31.

To perform quick test setup, see “ Quick Test” on page 1-48.

To perform measurement, see “Main Screen” on page 1-11.

To display measurement data and perform dataanalysis, see“ Data Display” on page
1-84.

To perform self-test or diagnosis, see “ Configuration” on page 1-64.
To perform self-calibration, see “ Calibration” on page 1-58.

To control Agilent B2200A/B2201A/E5250A switching matrix connection, see
“Switching Matrix Operation Panel” on page 1-81.

To set the standby channels and the standby mode, see “ Standby Channel
Definition” on page 1-83.

To define your application test, see “ Application Test Definition” on page 3-1.
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Start EasyEXPERT

File menu

Option menu

Main GUI
Start EasyEXPERT

Sart EasyEXPERT

The Start EasyEXPERT window is opened after the B1500 is booted up or by using
the Start EasyEXPERT menu in the Start menu or the Start EasyEXPERT icon on
Windows desktop. Thiswindow is not opened after the boot if the automatic start
function is effective. This window provides the following graphical user interface.

€ B1500A =Jo&d

File  Option

Start EasyEXPERT

This button launches EasyEX PERT.

Provides the following function.
Exit Closes the Start EasyEXPERT window.

Provides the following functions.

Auto Start of EasyEXPERT Enables or disables the automatic start function. If
thislabel is checked, the function is enabled. From
the next boot or logon, the Start EasyEXPERT
window will be skipped and EasyEXPERT will be
launched. To disable this function, use the Start
EasyEXPERT window opened by the File > Exit
menu on the EasyEXPERT main screen. This
function is not effective for Desktop EasyEXPERT.

EasyEXPERT Database Provides the following functions.

» Backup EasyEXPERT Database

Opens the EasyEXPERT Database Backup Creation Wizard used to make
backup of the EasyEXPERT database. You can make backup easily by following
the wizard. Required time depends on the database size.

» Restore EasyEXPERT Database

Opens the EasyEXPERT Database Restoration Wizard used to restore the
EasyEXPERT database backup. You can restore the backup easily by following
the wizard. Required time depends on the database size.

EasyEXPERT Database is the folder used to store your test setup data and such.
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Main GUI
Workspace Configurator

Wor kspace Configurator

Workspace means the space created in the B1500 internal hard disk drive, and is
used to store the test setup, test result data, and so on. The workspace can be created
and allocated for each user.

The workspace configurator will run after you launch Agilent EasyEXPERT. The
workspace configurator displays a screen used to select the workspace you use.
There are three types of display, depending on the number of existing Workspace.

» “If thereis no workspace”
» “If thereis one workspace”

» “If there are multiple workspace”

If thereisno workspace

EasyEXPERT will automatically create aworkspace (Name: Initial Workspace,
Scope: Private, Owner: Windows|ogin account) and display the EasyEXPERT main
screen.

Fie DataDisplay Help

[ |category - > E
A EE P ﬂ l——-___
= ] 1= < Vad

E ] CMOS | ol > 3

g | Dscrete | Run Option ——
2 | Evercte =1 Choose test categories from the left area, TR T 7] o] ]
?ﬂ [] GenericTest DU':' :

= | Memory Device ID: = -
& |0 MixedsSignal x| E m
= o

% Library v| My Favarite Setup~ @
B -

m |
bl

=]

o

=

=

=]

al =

|Flag |SetuD IName |Date |Coumt |Device I} lRemarks

- [l

Results

[ritial workspace | Mult Display OFF 3] Standby OFF  [b0] 5L zero OFF  [[S] Auto Export OFF  [5] Auta Record ON
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Main GUI
Workspace Configurator

If thereisoneworkspace

You will seethe screen asking you if you want to create a workspace or not. Select
Yes or No for the message and click OK.

You hawe used this instrument previously. Do you want to
cantinig working on the previcus setups and data 7

- Yes, Dwant to conline working cn e previous. sehips
amd data,

Mo, Twant to start a pew session.
Hobe: Even il you start @ new session, you can still
ACCERS ﬂll#ﬁM data rmm.p:wlou: AR,

= Mo, T want to manage Workspaces,

Nt »:

= Work on the zame sartups and dats
i the nex fime

« OK

This button displays the EasyEXPERT main screen using the specified
workspace.

*  Wbrk on the same setups and data in the next time.

If this check box is checked, the workspace selection screen will be skipped at
the next startup and EasyEXPERT will be launched with the workspace used at
the last operation. To perform this setup again, click the File > Close Workspace
menu on the EasyEXPERT main screen.

* Yes, | want to continue working on the previous setups and data.

This button must be selected if you do not want to create a new workspace, and
want to use the workspace previously used.

The OK button will work to open the EasyEXPERT main screen.
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Main GUI
Workspace Configurator

* No, | want to start a new session.

This button must be selected if you want to create a new workspace, and want to
use it instead of the workspace previously used. If you select this button, the
label of the OK button will change to Next.

The Next button will work to display the following entry fields used to set the
workspace name.

e Entry field for the name of the new workspace

« Entry field for the new name of the existing workspace
Thisfield is available only for the owner of the existing workspace.

Check the Allow other users to access this workspace box to create a public
workspace that is opened for all users.

The OK button creates and/or renames the workspace, and opens the
EasyEXPERT main screen.

The Prev button cancel s the workspace creation and returns the screen message
to the previous one.

File Help

Agilent EasyEXPERT software manages setups and data in
enclosures known as "Workspaces.* Since you want to
start a new session, you should create a new Workspace
with a distinctive name. Please specify a name for the new
waorkspace:

[untitied =
™ Allow other users to access this Workspace.
You can also rename a previously defined Workspace:
finitial workspace = .
™ Allow other users to access this Workspace.
«m
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Main GUI
Workspace Configurator

No, | want to manage Wbrkspaces.

This button must be selected if you want to manage workspaces. If you select
this button, the label of the OK button will change to Next.

The Next button will work to change the screen as shown in “If there are
multiple workspace”.

If there are multiple workspace

You will seethe screen as shown in the following example.

File Help

Agilent Desktop EasyEXPERT
Please choose the target Workspace below.
A Workspace is an enclosure of data and application tests. It includes test setups, test

results, graphical plots, and user-customized application tests. You have three options when
starting a session in EasyEXPERT:

1. Create a new Workspace from scratch.
2. Open and use an existing Workspace that you previously created. Continus 9
3. Open and use a public Workspace that has been previously published.
Target Workspace | |5 Chaose the same workspace .

in the nest time.

' Create a new Workspace

workspace Name: | = —

I Allow other users to access this Workspace.

Open an existing Workspace

& Your Workspaces:

hame |Scope | Manage
Initial Workspace Private Workspaces
test Private

€ Public Workspaces owmed by other users:
IName \ Cwner
» Continue
This button displays the main screen with the specified workspace.
L]

Choose the same Workspace in the next time.

If this check box is checked, the workspace selection screen will be skipped at
the next startup, and EasyEXPERT will be launched with the workspace used at
the last operation. To perform this setup again, click the File > Close Workspace
menu on the EasyEXPERT main screen.
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Main GUI
Workspace Configurator

e Create a new Workspace

This button must be selected if you want to create a new workspace. Enter the
name of the new workspace in the Workspace Name field.

Check the Allow other users to access this workspace box to create a public
workspace that is opened for all users.

» Open an existing Workspace
* Your Workspace

This button must be selected if you want to open your workspace. Select the
name to specify the workspace to open.

» Name: Workspace name
e Scope: Private (only for owner) or Public (for all users)

The Manage Workspaces button opens Workspace Manager which provides
the buttons used to manage workspaces. Select the workspace name and
click abutton.

» Delete: Deletes the selected workspace.

» Rename: Renames the selected workspace.

» Duplicate: Makes a copy of the selected workspace.

» Import: Opens adialog box used to import a workspace.

» Export: Opens adialog box used to export the sel ected workspace. The
workspace is exported as afile of the extension xws.

» Public: Changes the scope of the selected workspace to Public.
» Close: Closes the Workspace Manager.
» Public Workspace owned by other users

This button must be selected if you want to open a public workspace created
by another user. Select the name to specify the workspace to open.

» Name: Workspace name

*  Owner: Owner of the workspace
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NOTE

NOTE

Main GUI
Workspace Configurator

Private workspace

Private workspace is secured by the user account of its owner. User accounts other
than the owner cannot open the Private workspace.

User account of owner: <domain name>\<user name>
Example: B1500A-12345678\Agilent B1500 User

If you do not join the domain but login the local computer, <domain name> will be
the computer name.

If you change the user account

If you need to change the domain name, the computer name, or the user name,
change the scope of all workspace in the EasyEXPERT database to Public before
changing the user account.

The new account cannot open the Private workspace created by the previous user
account.

Also, it is recommended to make a backup of the EasyEXPERT database before
changing the user account after changing the scope to Public.
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Main GUI
Main Screen

Main Screen

The EasyEXPERT main screen will be displayed after the workspace is specified or
created by the workspace configurator. The main screen provides several tools and
functions described in this section.

e “Main Screen GUI”

*  “Run Option”

» “DataDisplay Manager”

» “DataDisplay Properties’

* “Test Result Editor”

* “Test Results Data Filter”

»  “Export in My Format”

* “Test Results Data Folder Export”
» “Test Results Data Auto Export”
» “Test Results Data Properties’

File DataDispley Help
[ |Category - "; E
5 |oBeT = ~
% [Doscete | Run Option L
2 |0 Exercise Tl Choose test categories from the left area. b 3] o
? ] GenericTest Ot
& | memary Device ID: —
& |0 Miedsignal v bt
% T v| My Favorite Setups @
i ~
g
i ted
g : —
= 7
= @
(=3
<«
T
i
g
o
# =
] P
A~ |F\ag |Setup Name |Date |C0unt |Device (=] |Remarks
3
"
-1
Tnitial Workspacs | Multi Display OFF  [[ch] Standby OFF  [10] SMU Zero OFF |51 Auto Export OFF | 2] Auto Record ON
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File menu

Data Display menu

Option menu

Main GUI
Main Screen

Main Screen GUI

Provides the following four functions.

Import Test Setup...

Export Test Setup...

Save Data As...

Close Workspace

Exit

Opens adialog box used to specify atest setup to
import.

Opens a dialog box used to specify a destination
file for exporting the present test setup.

Only for the tracer test. Opensthe Save Data As...
dialog box used to specify the file name of the
measurement result data to save. Available data
formats arethe Text, CSV, XML spreadsheet, BMP,
EMF, GIF, and PNG.

Closesthe work space and returns to the workspace
configurator.

Exits the EasyEXPERT software.

Provides the following three functions.

Show Data Display

Manage Data Display...

Default Data Display
Properties...

Opens “Data Display (page 1-84)” used to display
the test result data.

Opens“ Data Display Manager (page 1-20)" used to
control the appearances of the Data Display
windows.

Opens “Data Display Properties (page 1-21)" used
to set the default setting of the Data Display
window.

Provides the following two functions. Only for the tracer test.

Oscilloscope View

Arithmetic Operation

Opens/closes the Oscilloscope View window. For
details, see “ Oscilloscope View” on page 1-42.

Displays the Arithmetic Operation area, and
enables/disabl es the expressions defined in that
arearespectively. For details, see “Arithmetic
Operation Area’ on page 1-47.
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Help menu

Application Test

Classic Test

Tracer Test

Quick Test

Data Display

Calibration

EX)

Configuration

Switching Matrix

Standby

Single

——

Main GUI

Main Screen
Provides the following three functions.
About ThisInstrument... Opens the Configuration window.
About ThisTest... Opens the test description dialog box.

Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.

Thistab selects the application test mode of EasyEXPERT. For details of the
graphical user interfacein this mode, see “ Application Test” on page 1-29.

Thistab selects the classic test mode of the EasyEXPERT. For details of the
graphical user interfacein this mode, see “ Classic Test Definition” on page 2-1.

Thistab selects the tracer test mode of EasyEXPERT. For details of the graphical
user interface in this mode, see “ Tracer Test” on page 1-31.

Thistab selects the quick test mode of the EasyEXPERT. For details of the graphical
user interface in this mode, see “Quick Test” on page 1-48.

Opens“Data Display (page 1-84)” used to display the test result data. EasyEXPERT
always handles the test setup corresponding to the Data Display window now active
or most recently activated.

Opens “ Calibration (page 1-58)" used to see the self-calibration results, to perform
the self-calibration, or to perform the current offset cancel.

Opens “ Configuration (page 1-64)” used to see the module configuration, to see the
self-test results, to perform self-test, to establish the GPIB connection with Agilent
B2200A/B2201A/E5250A switching matrix, or to see the event log.

Not available for the B1505A. Opens “ Switching Matrix Operation Panel (page

| 1-81)" used to control Agilent B2200A/B2201A/E5250A switching matrix.

Opens “ Standby Channel Definition (page 1-83)” used to set the standby channel
which isthe channel to keep the specified output when the standby mode is ON and
in the non-measurement state.

Triggers asingle measurement. To abort measurement, click Stop button that
appears instead of the Single button.
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Append
Repeat
Run Option
Save data
Count
o]
Device ID

My Favorite Setup

Main GUI
Main Screen

Triggers the append measurement. The measurement results will be appended to the
Data Display window that shows the previous measurement results. The Data
Display window can have maximum 10 layers for displaying measurement results.
To abort measurement, click Stop button that appears instead of the Single button.

This button provides a different function depending on the status of the data record
functions (Auto Record and Auto Export). See “Run Option (page 1-19)” for the
datarecord status.

If Auto Record and Auto Export is OFF, this button starts the repeat measurement
immediately.

If Auto Record or Auto Export is ON, this button opens the “Repeat M easurement
Setup (page 1-50)” dialog box for setting the repeat measurement condition.

Opensthe “Run Option (page 1-19)” dialog box for setting the data record functions
(Auto Record and Auto Export) and the Multi Display function.

This button will appear to the right side of the Run Option button if a measurement
is performed when the data record functions (Auto Record and Auto Export) are
OFF. Clicking the button will save the last measurement data as a test result record.

Displays the number of single measurements executed for the test setup now
opened. Effective for the measurements triggered by both Single and Repeat.
The 0 button sets the Count field to zero.

Thisentry field is used to enter a string in the test record. The string can data 1D,
device ID, test ID, or anything you want.

Performing measurement and changing setup do not change the value in this field.
Change the value if you want.
The test setups you create or modify MUST be saved to My Favorite group (preset

group) to reuse them.

Click the My Favorite Setup button to display the menu that provides the following
functions. Select the preset group by using the field below the button. The test
setups can be recalled by using the area below the field.

Cancel Closes the menu.
Preset Group Provides the following seven functions.

Add New Preset Group  Opensthe Add Preset Group dialog box. Creates anew
preset group and savesit as the specified name.
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Recall
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Rename This Preset
Group Opens the Rename Preset Group dialog box. You can
change the name of the present preset group.

Duplicate This Preset

Group Opens the Duplicate Preset Group dialog box. Creates
acopy of the present preset group and savesit asthe
specified name.

Delete ThisPreset Group You can delete the present preset group.

Import Preset Group...  Opensthe Preset Group Import dial og box. Importsthe
specified preset group.

Export This Preset
Group... Opensthe Preset Group Export dial og box. Exportsthe
present preset group as the specified name.

Organize Preset Group... Opensthe “Organize Preset Group (page 1-56)” dialog
box used to organize the preset group.

Rename You can change the name of the selected test setup.
Duplicate Creates a copy of the selected test setup.

Delete Deletes the selected test setup.

Delete All Deletes all test setupsin the present preset group.

The button saves the present test setup into the present preset group as anew test
setup of the group.

The button recalls the selected test setup. This means opening and displaying the
measurement definition of the selected test setup.

If atracer test setup is recalled on the test mode other than the tracer test

The tracer test setup is converted to and recalled as aMulti Channel 1/V Sweep test
setup.

In this conversion process, the VAR dual polarity sweep setup (Dual Polarity) is
ignored. The setup of the positive sweep from start to stop is converted, but the
setup of the negative sweep from - start to - stop is hot converted.

Shows the flag, Important (1), Valid (#), or Questionable (?) set to the record. The
top button sorts the test records by the flag.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 1-15



Main GUI
Main Screen

While the “ Show Deleted Data (page 1-17)” function is enabled, the list area can
show the test records in Delete-group. For the records, * is set to the column to the
left of the Flag column. The top button sortsthe list by *.

Setup Name Shows the test setup name. The top button sorts the test records by name, in
lexicographical order.

Date Shows the date that the test result is recorded. The top button sorts the test records
by date, in chronological order.

Count Shows the measurement count shown in the Count field. The top button sorts the
test records by count, in numerical order.

Device ID Shows the string set to the record by using the Device ID field. The top button sorts
the test records by device ID, in lexicographical order.

Remarks Shows the remarks set to the record. The top button sorts the test records by the
remarksin the lexicographic order.

Thermometer OFF Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
l_ while the Thermometer is enabled. And one of the following informationsis
— displayed instead of “Thermometer OFF”. The information istoggled by clicking
the indicator. Where, XX indicates the temperature value.

e T1:XXdegC

Temperature measured by the thermometer channel 1.
e T2:XXdegC

Temperature measured by the thermometer channel 2.
o dT: XXdegC

Difference between temperature values measured by the channels 1 and 2.

Multi Display ON  Thisindicator islocated at the bottom of the EasyEXPERT main screen and is lit
E while the Multi Display function is enabled.

Standby ON Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
@y while the standby function is enabled (standby mode is ON).

SMU Zero ON Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
K1 whilethe SMU current offset cancel function is enabled.
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Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
while the Auto Export (automatic data export) function is enabled.

Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit

| while the Auto Record (automatic data record) function is disabled.

Field below the Results button shows the present workspace name.

This button provides the following functions. The list area shows the test records.
The up or down arrow button is used to expand or reduce the list area.

Cancel Closes the menu.

Select All Selects all records.

Unselect All Unselects all records.

Display Data Opensthe “Data Display (page 1-84)” and displaysthe

test result data of the selected record. Up to 15
windows can be opened by this function.

Recall Recalls the test setup of the selected record.
Filter Provides the following four functions.
Show Deleted Data Check this function to see the test records of both

Save-group and Delete-group. To set the data group,
see “Flag and Remarks’ on page 1-19. See also “ Test
Result Editor (page 1-23)”.

Filter... Opensthe* Test Results Data Filter (page 1-23)” dialog
box. You can filter the test recordsin the list area.

Expand Application Test
Results Check thisfunction to see all test records created by the
test setups defined in an application test.

If atest record is exported when this function is not
checked, the exported file will contain all records
created by the test setups defined in an application test.
However, if the test record is exported by the Export
As Text File function, the exported file will contain
only the test record of the application test.
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Show All Append Data

Transport Data

Import...

Export AsTest Result...

Export As Compressed
Test Result...

Export AsCSV...

Export AsXML Spread

Export in My Format...

Export AsText File...

Text File Export Setting...

Folder Export...

Check thisfunction to see all test records created by the
append measurement. In the test record list, Sindicates
the test records obtained by a single measurement, and
A indicates the records obtained by an append
measurement.

Provides the following ten functions.

Opens the Test Result Import dialog box. Imports the
specified test record.

Opens the Test Result Export dialog box. Exports the
selected test record as the specified namein the
EasyEXPERT data format.

Opens the Compressed Test Result Export dialog box.
Exports the selected test record as the specified name
in the compressed EasyEXPERT data format.

Opensthe CSV File Export dialog box. Exports the
selected test record as the specified name in the CSV
format that can be read by a spread sheet software.

Opensthe XML Style Sheet Export dialog box.
Exports the selected test record as the specified name
in the XML spread sheet format that can be read by a
spread sheet software.

Opensthe “Export in My Format (page 1-24)” dialog
box. Exports the selected test record as the specified
name in the style converted by using the specified
XSLT filter.

Opens the Text File Export dialog box. Exports the
selected test record as the specified name in the style
defined on the “ Text File Export settings (page 1-111)”
dialog box.

Opensthe “ Text File Export settings (page 1-111)"
dialog box used to define the style of the test record
exported by the Export As Text File function.

Opensthe “ Test Results Data Folder Export (page
1-24)" dialog box used to export the selected multiple
test records to the specified folder.
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Auto Export Setting... Opensthe“ Test Results Data Auto Export (page 1-26)”

dialog box used to set the automatic data export
function and the automatic data save function.

Edit Provides the following two functions.

Flag and Remarks Opens the “ Test Result Editor (page 1-23)" used to put

the selected test record in Save-group or Delete-group.
Also this dialog box can set aflag and remarksto the
selected record. The available data flags are Important
(1), Valid (#), and Questionable (?).

Delete Puts the selected test records in Delete-group. The

records can be displayed in the list area while the
“Show Deleted Data (page 1-17)" is checked.

Properties... Opens the “ Test Results Data Properties (page 1-28)"

dialog box used to set the number of test records listed
inthelist areaand the number of recoverablerecordsin
Delete-group.

Run Option

This dialog box appears by clicking the Run Option button and is used to set the data
record functions (Auto Record and Auto Export) and the Multi Display function.
This dialog box provides the following GUI.

Record Test Result Data Automatically

This check box changes the status of the datarecord functions (Auto Record and
Auto Export). The functions provide four status shown in Table 1-1. Removing
the check sets Auto Export=Auto Record=OFF. And putting the check again
returns the status to the previous one.

In the checked status, the data record functions can be set to one of three status
except for Auto Export=Auto Record=0OFF. To set the functions, use “ Test
Results Data Auto Export (page 1-26)”".

In the unchecked status (Auto Export=Auto Record=0FF), the test result data
will not be recorded. If a measurement is performed in this status, the Save Data
button will appear to the right side of the Run Option button. Clicking the Save
Data button will save the last measurement data as a test result record.
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When the automatic data record function is enabled, one test execution result is
stored in one test record. For the classic test, one test result is stored in one test
record. For the application test, all test results taken by executing one
application test are stored in one test record. However, the automatic data export
function using the Text File type exports the file for each test result.

Table1-1 Record Test Result Data Automatically Check Box and Data Record Functions
Checked status Unchecked status
Auto Export Auto Record Auto Export Auto Record
ON OFF OFF OFF
ON ON
OFF ON

» Allocate Data Display for each test

This check box sets the Multi Display function ON (checked) or OFF. This
function controls the operation of the Data Display window.

OFF Test result datawill be always displayed on the singular Data
Display window even if the test setup is changed.

ON Test result data of the same test setup name will be displayed on the
exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display
window.

Data Display M anager

Thisdialog box is opened by selecting the Manage Data Display... function of the
Data Display menu, and is used to control the appearances of the Data Display
windows. This dialog box provides the following three action buttons.

OK Applies the setup changes and closes this dialog box.
Cancel Cancels the setup changes and closes this dialog box.
Apply Just applies the setup changes.
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Data Display
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Main GUI
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This arealists the Setup Name of the Data Display windows opened. The list items
from top to bottom correspond to the windows from front to back in the screen
image. This area supports the following buttons. To select the item, click onein the
list.

Up Moves the selected item upward.

Down Moves the selected item downward.

Select All Selects al items.

Minimize Minimizes the windows corresponding to the selected items.

The list items move to the Minimized Data Displays area.

Close Closes the windows corresponding to the selected items.

This area lists the Setup Name of the Data Display windows minimized. This area
supports the following buttons. To select the item, click onein thelist.

Select All Selects dl items.
Restore Restores the windows corresponding to the selected items.
Close Closes the windows corresponding to the selected items.

This area provides the following radio buttons and a check box to change the
appearances of the Data Display windows. All functions are available for the opened
windows.

Keep Setup K eeps the present configuration of the Data Display windows.

Tiling Resize and collate the data display windows such that they fill
up the entire screen.

Sacking Resize and collate the data display windows so that they
overlap slightly with an offset.

Overlaying Resize, overlap, and make transparent the data display windows
so that multiple graphs can be viewed and superimposed on one
another.

This check box must be checked to apply the same graph scaleto al graphs.

Data Display Properties

This dialog box is opened by selecting the Default Data Display Properties...
function of the Data Display menu, and is used to set the default setting of the Data
Display window. Click the OK button to apply the setup and close this dialog box.
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Graph Color
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Log Scale
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Main GUI
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Thisareais used to select the area effective when the Data Display window is
opened, and provides the following check box.

X-Y Graph Enables the X-Y Graph area.
Logo ON Displays the Agilent logo at the upper left
of the graph area.
Grid ON Displays the grid on the graph.
Setup Summary
ON Thisisvalid only for the I/V Sweep and

Multi Channel 1/V Sweep classic tests.
Displays the channel setup summary at the
bottom of the graph area. See “ Setup
Summary” on page 1-101.

List Display Enablesthe List Display area.
Parameters Enables the Parameters area.
Thisareais used to set the color map for the X-Y Graph Plot area. You can change

the color of the background, text, graph grid, and line/cursor. The color paletteis
opened by clicking the pattern of the item.

Thisareais used to set visibility, color, and thickness of the datatracesY1to Y8
plotted on the graph. The color palette is opened by clicking the pattern of the item.

Thisareais used to set the maximum number of decadesto show the minor ticks for
on the log axis. If the number of graph decadesis less than or equal to the entered
value, the minor ticks are displayed. If it is greater than the entered value, the minor
ticks are not displayed.

Thisareais used to set the font size for the graph. The available settings are Largest,
Large, Medium, Small, Smallest, and Fixed. For settings other than Fixed, the
appropriate size is automatically selected. For Fixed, afont size entry field is
provided, and the specified font sizeis always applied.

X/Y AxisTitle Font size for the axistitle
Scale Font size for the X and Y coordinate values

L egend Font size for the graph legend
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Test Result Editor

The Test Result Editor appears when measurement is completed or by clicking
Results > Edit > Flag & Remarks. Thisis used to set aflag and remarks to the
associated test record and provides the following GUI.

Divides test records into groups, Save and Delete.

Test recordsin Save-group are aways listed in the lower area of the EasyEXPERT
main screen.

Test recordsin Delete-group can be listed while Results > Filter >
Show Deleted Datais checked.

The following buttons are available. You can set one of the following flags.

* Important ! button
Sets the important flag (!) to the test record.
» Valid # button
Setsthe valid flag (#) to the test record.
* Questionable ? button
Sets the questionable flag (?) to the test record.

You can enter characters into thisfield. The characters will be recorded as the
Remarks value of the test record.

Applies the setup on the Test Result Editor, and closes this dialog box.

Test Results Data Filter
This dialog box appears by clicking Results > Filter > Filter... and is used to specify

the test records listed in the lower area of the EasyEXPERT main screen.
Check this box to list the test records in Save-group.

Check this box to list the test records in Del ete-group.

Select or enter aflag in thisfield to list the test records with the specified flag.
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Select or enter atest namein thisfield to list the test records of the specified name.
Specify the date to list the test records within the specified period.

Specify the count valuesto list the test records within the specified range.

Select or enter the device ID to list the test records of the specified device ID.
Specify the remarks value to list the test records with the specified value.

Performs filtering, and closes this dialog box.

Cancelsfiltering, and closes this dialog box.

Export in My For mat

This dialog box appears by clicking Results > Transport Data > Export in My
Format..., and is used to export the test record by performing the style conversion
using the XSLT filter.

Specify the full path name of the XSLT filter (XML style sheet) used to convert the
style of thetest record. The Browse... button opens the Select XML Style Sheet File
dialog box used to select thefile.

Opens the Export As dialog box. Specify the file name and the file type, and export
the test record.

Cancels data export, and closes this dialog box.

Test Results Data Folder Export

This dialog box appears by clicking Results > Transport Data > Folder Export...
after the test result records are selected (highlighted).

This function is used to export the multiple test records. The test records can be
exported by specifying the records, the destination folder name, and the naming rule
and the file type for the exported files.

Selects the folder used to save the exported test records. The Browse... button opens
the Browse For Folder dialog box used to select the folder.

Specifies the style of the file name for the exported test records.
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File nameis automatically generated by using Setup Name, Device ID, Count, and
Date values defined in the main screen. If an impermissible character isused in a
value, the character is automatically replaced with _ (underscore).

» Default Format: File name without extension is as follows.
Flag SetupName [ DevicelD( Count) _Remarks ; Date]
Example:# 1d-Vd [cnmps1(1l) _ok ; 1 22 2006 3_44 55 PM
» Custom Format: You can specify the style by the File Name Format dialog box.

The File Name Format dialog box appears by clicking the Settings... button. In
the dialog box, enter the desired style into the Format field, for example, the
next example sets the same style as the Default Format.

Example: {4} {0} [{3}({2}) {5}; {1}]
{0}: Setup Name

{1}: Date, mm_dd_yyyy hh_mm_ss AM/PM
{2}: Count

{3}: DevicelD

{4}: Flag

{5}: Remarks

Selects the file type (data format).

Test Result EasyEXPERT data format

Compressed Test Result Compressed EasyEXPERT data format

csv CSV format

XML Spread Sheet XML spread sheet format

My Format Custom format created by the specified XSLT filter. The

following two entry fields are available.

My Format

Specifies the file name of the XSLT filter (XML style sheet) used to export test
records. The Browse... button opens the Select XML Style Sheet File dialog box
used to select the file.

e Extension of Output File
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Enters the appropriate extension, or selects the extension from xml, txt, csv, or
xls.

Text File Custom format defined in the “ Text File Export settings
(page 1-111)" dialog box. The Settings... button opens
this dialog box.

Starts the folder export. This dialog box is closed after the folder export is
compl eted.

Cancels the folder export, and closes this dialog box.

Test Results Data Auto Export

This dialog box appears by clicking Results > Transport Data > Auto Export
Setting... and is used to set the data record functions (Auto Record and Auto
Export).

Thereisthe following check box at the top of this dialog box.

» Enable automatic data export to the specified storage device

Checking this box setsthe Auto Export function (automatic data export) and enables
the following GUI.

Selects the folder used to save the exported test records. The Browse... button opens
the Browse For Folder dialog box used to select the folder.
Specifies the style of the file name for the exported test records.

File nameis automatically generated by using Setup Name, Device ID, Count, and
Date values defined in the main screen. If an impermissible character isused in a
value, the character is automatically replaced with _ (underscore).

» Default Format: File name without extension is as follows.
Flag SetupName [ DevicelD( Count) _Remarks ; Date]
Example:# 1d-Vvd [cnmps1(1l) _ok_ ; 1 22 2006 3_44 55 PM
» Custom Format: You can specify the style by the File Name Format dialog box.

The File Name Format dialog box appears by clicking the Settings... button. In
the dialog box, enter the desired style into the Format field, for example, the
next example sets the same style as the Default Format.

Example: {4} {0} [{3}({2}) {5}; {1}]
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{0}: Setup Name
{1}: Date, mm_dd_yyyy hh_mm_ss AM/PM
{2}: Count
{3}: DevicelD
{4: Fag
{5}: Remarks
Selects the file type (data format).
Test Result EasyEXPERT data format
Compressed Test Result Compressed EasyEXPERT data format
csv CSV format
XML Spread Sheet XML spread sheet format
My Format Custom format created by the specified XSLT filter. The

following two entry fields are available.

* My Format

Specifies the file name of the XSLT filter (XML style sheet) used to export test
records. The Browse... button opens the Select XML Style Sheet File dialog box
used to select the file.

» Extension of Output File

Enters the appropriate extension, or selects the extension from xml, txt, csv, or
xls.

Text File Custom format defined in the “ Text File Export settings
(page 1-111)” dialog box. The Settings... button opens
this dialog box.

Remove a check from the following check box to disable the Auto Record function
(automatic data record).

» Enable automatic data record to the internal storage device
Appliesthe setup, and closes this dialog box.
Cancels the setup, and closes this dialog box.

Automatic Data Record Output
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When the automatic data record function is enabled, one test execution result is
stored in one test record. For the classic test, one test result is stored in one test
record. For the application test, all test results taken by executing one application
test are stored in one test record. However, the automatic data export function using
the Text File type exports the file for each test result.

Test Results Data Properties

This dialog box appears by clicking Results > Properties... and is used to set the
maximum number of test records listed in the main screen and saved in the
Delete-group.

Sets the maximum number of test records listed in the main screen.

Sets the maximum number of test records saved in the Delete-group.

Closes this dialog box.
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Application Test

In the application test mode, the EasyEXPERT main screen has the following
additional graphical user interface.
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Lists the categories of the application test definitions. You can select the categories
by using the check box. The test definitions listed in the Library area depend on the
selection of the categories.

The Category button opens the Categories dialog box used to select the categories.

Thisfield just displays the test definition name of the present application test.
Clicking the left i button displays the help message for the test definition.

Lists the application test definitions that belong to the categories selected by the
Category area.

Clicking anicon displaysits brief introduction message and the Select button.
Clicking the Select button loads the application test definition. Now, the B1500 is
ready to start measurement.

The Library button provides the following six functions.
Close Closes this menu.

Define New Test... Opens the “ Test Definition Window (page 3-3)”
used to create a new application test.
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Open Definition of ThisTest...
Opens the “ Test Definition Window (page 3-3)” to
display the definition of the present (selected)
application test or to modify the definition.

Delete Definition of This Test Deletes the present (selected) application test. The
test will be deleted from the application library.

Import Test Definition... Opens adialog box used to specify the test
definition to import.

Export Test Definition... Opens adialog box used to export the present
application test definition. The test definition will
be saved to the specified file.

Incremental search. Used to search the application test definitions listed in the
Library area.

Used to set the name of test setup. The name must be the identification for the test
setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameis stored in the test result data and is used to differentiate the recordsin
the test record list area.

This area displays the device parameter entry fields if the device parameters are
defined as the variables in the application test definition.

Enter the appropriate value to the entry fields before starting measurement.

This area displays the device connection diagram if it is specified in the application
test definition.

This area also displays the test parameter entry fieldsif the test parameters are
defined asthe variablesin the application test definition. Enter the appropriate value
to the entry fields before starting measurement. If the entry field needs to enter a
vector data, see “Define vector data’ on page 2-18.

This button opens the Extended Setup dialog box that displays the extended
parameter entry fields. See “ Ext” on page 3-6 for the parameters shown in this
dialog box.

Enter the appropriate value to the entry fields and click Close button.
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Tracer Test

In the tracer test mode, you can start 1/V sweep measurement easily and quickly by
setting up the I/V Trace screen only. The EasyEXPERT main screen has the
following additional graphical user interface.

@|1/V Trace Setup Name; [[1-V1

LIN-SGL +

-0y B

v B

400 mi

Interlacing:

Compliance:

IQu\ck T&sti Tracer Test  Classic Test Eﬁ\pphcauun Test

K- -IERER | 2 B 2] msd s 1|
Unit: ¥ Name:  IName: Mode: Function: (& Meas. Time:

(7 SMULHE w vl @ Il m=m Vow o WARL v add 2us B
Step Time:

S00uws @

Used to set the name of test setup. The name must be the identification for the test
setup saved to a My Favorite group (preset group). Enter a unique namethat is
distinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This area displays measurement result graph and provides “ Graph Setup Tool” and
“Option Tool” for setting and changing the graph display.

Mouse drag operation zooms in the graph. To set the graph maximum or minimum
value directly, use the entry field displayed by clicking the value on the graph.

This area defines the channel setups and the variables for the channel output data
and the measurement data.
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Add Adds arow of the channel setup by selecting aSMU listed in
the menu displayed by clicking this button.

Delete Deletes the selected channel setup.

Up / Down Moves the selected channel setup upward or downward.

Unit M easurement resource used for the source output or
measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode Output mode. V (voltage), | (current), VPUL SE (voltage pulse),

or IPULSE (current pulse).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), or CONST (constant)

To select a channel setup, use the left radio button of the channel setup. If multiple
output channels are defined, the channels start output sequentially. The order is top
to bottom of the channels defined in this screen. The output stopsin the opposite
order.

Sample setups Clicking this button displays the sample setup menu. Clicking a setup name applies
its setup to the tracer test environment.

L 1
7

The B1500A provides the following sample setups.

¢ MOSFET: ID-VDS, ID-VGS, ID(off)-VDS, BVDSS
» Diode IF-VF, IR-VR

e BJT: IC-VCE, IC-VCEO, BVCEO

The B1505A provides the following sample setups.

* MOSFET: ID-VDS, ID-VGS, ID(0ff)-VDS, BVDSS

+ Diode IF-VF, IR-VR

* |IGBT: IC-VCE, IC-VGE, IC(off)-VCE, BVCES

* BJT:IC-VCE, IC-VCEO, BVCEO, IC-VCBO, BVCBO

e GaN FET (N1267A): ID-VDS, I1D(off)-VDS, ID-VDS Current Collapse, FET
Current Collapse Oscill oscope View

e GaN Diode (N1267A): IF-VF, IR-VR, IF-VF Current Collapse, Diode Current
Collapse Oscilloscope View

1-32 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



VAR1

Main GUI
Tracer Test

This area defines the primary sweep source output. All of the following parameters
are displayed for the full mode. Only Mode, Stop, NOS, and Compliance are
displayed for the short mode. Click the VARL title bar to switch the mode.

Mode

Sart
Sop
Step

NOS

Interlacing

Compliance

Pwr Comp.

V Compliance

Dual Polarity

Sweep mode. The single mode sweeps from start to stop, and
the double mode sweeps from start to stop to start.

LIN-SGL Linear sweep, single mode
LOG-SGL L ogarithmic sweep, single mode
LIN-DBL Linear sweep, double mode
LOG-DBL L ogarithmic sweep, double mode
Sweep start value

Sweep stop value

Incremental step value of the sweep output. Thevalueis
automatically calculated by using the start, stop, and NOS
values.

Number of sweep steps N. 1 to 1001.
Number of the interlace sweep M. 1 to 100.

Sweep isrepeated M times so that the final sweep step is equal
to Step/M. Total number of steps will be N+(N-1)x(M-1).

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.
Measurement is performed within this value.

Power compliance value (in W), or OFF

Only for UHCU, UHV U, or HVMCU. Limit value for the
voltage sweep output. The output voltage of the measurement
resource isautomatically measured, and the measured voltageis
compared with thislimit value. And then, if it exceeds the limit,
the measurement status is set to the compliance status, and the
sweep measurement stops. Voltage range and setting resolution
depend on the measurement resource.

Dual polarity sweep ON or OFF. If this parameter is ON, the
VAR1 channel performs positive sweep from start to stop and
negative sweep from - start to - stop in this order. For the pulsed
negative sweep, the pulse base value is - 1x(Pulse Base).
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Hold Time Hold time (in seconds) of the primary sweep source output just
before starting a sweep. 0 to 655.35. Setting resolution: 10 ms.
In the hold time, the primary sweep source forces the sweep
start level for staircase sweep output, or the pulse base level for
pulsed sweep output.
At thefirst step of the primary sweep, the longer oneis applied
from the VAR1 and VAR2 Hold Time settings.

The following parameters are also displayed for the full mode if the IPULSE or
VPULSE is set to the VARL channel.

Pulse Base Pulse base value
Pulse Delay Pulse delay time. Set O for HR/MP/HPSMU.
Pulse Width Pulse width. Must be the same value for all of HR/MP/HPSMU.

This area defines the secondary sweep source output. The VAR2 channel performs
the linear single sweep operation. All of the following parameters are displayed for
the full mode. Only Start, Stop, Step, and NOS are effective for the short mode.
Click the VAR2 title bar to switch the mode.

Sart Sweep start value

Sop Sweep stop value

Sep Incremental step value of the sweep output. Thevalueis
automatically calculated by using the start, stop, and NOS
values.

NOS Number of sweep steps. 1 to 101.

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.
Measurement is performed within this value.

Pwr Comp. Power compliance value (in W), or OFF

V Compliance Only for UHCU, UHV U, or HVMCU. Limit value for the
voltage sweep output. The output voltage of the measurement
resource isautomatically measured, and the measured voltageis
compared with thislimit value. And then, if it exceeds the limit,
the measurement status is set to the compliance status, and the
sweep measurement stops. Voltage range and setting resolution
depend on the measurement resource.
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Hold Time Hold time (in seconds) of the primary sweep source output just
before starting a sweep. 0 to 655.35. Setting resolution: 10 ms.
In the hold time, the primary sweep source forces the sweep
start level for staircase sweep output, or the pulse base level for
pulsed sweep output.
At thefirst step of the primary sweep, the longer oneis applied
from the VAR1 and VAR2 Hold Time settings.

The following parameters are also displayed for the full mode if the IPULSE or
VPULSE is set to the VAR2 channel.

Pulse Base Pulse base value
Pulse Delay Pulse delay time. Set O for HR/MP/HPSMU.
Pulse Width Pulse width. Must be the same value for all of HR/MP/HPSMU.

This area defines the constant output source.

Unit M easurement resource for the constant output. If multiple
CONST channels are defined, thisfield is used to specify the
channel for setup.

Source Output value.

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.
Measurement is performed within this value.

V Compliance Only for UHCU, UHV U, or HVMCU. Limit value for the
voltage sweep output. The output voltage of the measurement
resource isautomatically measured, and the measured voltageis
compared with thislimit value. And then, if it exceeds the limit,
the measurement status is set to the compliance status, and the
sweep measurement stops. Voltage range and setting resolution
depend on the measurement resource.

The following parameters are also displayed for the full mode if the IPULSE or
VPULSE is set to the CONST channel. Click the CONST title bar to switch the
mode. The Pulse Peak entry field appears instead of the Source entry field.

Pulse Peak Pulse peak value.

Pulse Base Pulse base value

Pulse Delay Pulse delay time. Set O for HR/MP/HPSMU.

Pulse Width Pulse width. Must be the same value for al of HR/MP/HPSMU.
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Thisfield is used to set the measurement time for a sweep step.

Thisfield is used to set the measurement delay time (from the beginning of pulse
period to the beginning of measurement) for a pulse step. This entry field appears if
a pulse output channel exists.

2 usto Pulse period - Measurement time- 2 ms, 2 us resolution

Measurement delay time = 0 (AUTO) sets the optimum value automatically so that
the measurement is completed when the transition from peak to base is started by
the pulse output channel which starts the transition at first.

Thisfield is used to set the output time for a sweep step. 500 usto 5 s, 100 us step.

Thisfield is used to set the pulse period. This entry field appears instead of the Step
Time entry field if a pulse output channel exists.

About measurement time and measurement error

In the tracer test mode, measurement is always performed by using the following
settings.

e A/D converter: HS ADC (high speed A/D converter)
e Measurement ranging mode: compliance range, fixed

» Effective current measurement range: all for staircase sweep output, 10 nA and
greater for bias output or pulse output

» Measurement time: absolute value entered into the Meas. Timefield

You may find difference between the results measured in the tracer test mode and in
the other test mode. Thisis caused by the differences of setting values for the above
items. The above settings will reduce measurement time and increase measurement
error compared with when using HR ADC (high speed A/D converter) and auto
ranging in the other test mode.

Drag the region of VARL, VAR2, and CONST

Mouse drag operation will scroll this region when it cannot display all setup
parameters.
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Graph Setup Tool
The graph setup tool provides the following GUI for setting the graph display.

This button is used to set the X-axis direction, |eft to right (—) or right to left («-).

This button is used to set the Y-axis direction, down to up ( T ) or up to down ().

Thisfield is used to set the X-axis/Y-axis variable name to plot.

Variable must be V Name or | Name used for sweep output or measurement.

This button is used to set the X-axig/Y-axis scale, linear (LIN) or logarithm (LOG).

Thisbutton isused to set the X-axis/Y-axis polarity, plus (+) only, minus (- ) only, or
both plus and minus (+). Both plus and minus (1) is available only for the linear
scale.

Option Tool
The following tool is available for changing the graph display.

This button is used to set the trace style, line or dot.

This button is available for the graph zoomed in, and is used to return the graph
scale to the original setting. The graph can be zoomed in by the point and drag
operation.

This button is used to set the abnormal region on the graph, and shows the present
status of the abnormal region setup by using the button’s signal color. While the
abnormal region is effective, the measurement is automatically stopped if the
measurement datais in the region.

Green Abnormal region has not been defined. Clicking this button changesthe
button’s signal color to Yellow.
Yellow Status for defining the abnormal region. Clicking this button changes

the button’s signal color to Green.
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The abnormal region can be defined by the point and drag operation. It
will be the square specified by the red grids. After defining the region,
this button’s signal color is changed to Red.

Red Abnormal region is effective. Clicking this button changes the button’s
signal color to Green.

This button opens/closes the dialog box used for managing the record and replay of
traces. For the dialog box, see “ Replay traces’ on page 1-39.

This button is used to capture the trace as the reference trace. Clicking this button
captures one reference trace. Up to 10 traces can be captured. To manage reference
traces, click the reference trace button.

This button opens/closes the dialog box used for managing reference traces
memorized by clicking the Capture button. For the dialog box, see “ Select reference
traces’ on page 1-40.

This button is available for the measurement result which contains at least two
traces by the append measurement. Tracking trace means each trace of this
measurement result. This button opens/closes the dialog box used for managing
tracking traces. For the dialog box, see “ Select tracking traces’ on page 1-41.

This button enables/disables the marker which can be moved on the active trace by
using rotary knob or mouse. The marker position X and Y coordinate values are
displayed in the upper |€eft of the graph.

This button enables the marker and enables/disables the tangent line for the marker
point. The line X-axis intercept, Y-axis intercept, and gradient values are displayed
in the upper right of the graph. The tangent line disables the regression line.

This button enables the marker and enables/disables the line which is given by the
regression calculation. The line X-axis intercept, Y-axisintercept, and gradient
values are displayed in the upper right of the graph. The regression line disables the
tangent line. The measurement data for the regression calculation can be specified
by the point and drag operation.

This button opens/closes the Oscill oscope View window used for monitoring the
waveforms of output signals. For the window, see “Oscilloscope View” on page
1-42.
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This button opens/closes the dialog box used for changing the graph color and trace
thickness. For the dialog box, see “Color and thickness’ on page 1-41.
Replay traces

Thisdialog box isopened/closed by clicking the Replay traces button and is used for
managing the record and replay of traces.

X

HEE

Replay Interval:

11

100ms B

Maximum Records:
100 B

Recording Interval:
os B

This button enables/disables the automatic trace record function. While this button
labels ON, this function is enabled and continues recording the measurement trace.

This button opens the Open Trace Record dialog box which is used to open a
recorded-trace saved by using the Save Trace Record dialog box.

This button opens the Save Trace Record dialog box which is used to save the
recorded-trace selected on this dialog box. The trace datais saved in the
EasyEXPERT Compressed Trace Record format (.gtr).

The slide bar is used to specify the recorded-trace to display. The trace is specified
by N/M put on the space right next to the slide bar. N is the record number assigned
to the recorded-trace now on graph and M is the total number of the recorded-traces.

Clicking this button changes the displayed recorded-trace to the trace N- 1.
Long-click makes this operation fast.

Clicking this button changes the displayed recorded-trace to the trace N- 1.

Clicking this button changes the displayed recorded-trace to the trace N+1.
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Clicking this button changes the displayed recorded-trace to the trace N+1.
Long-click makes this operation fast.

Thisfield isused to set the time interval of the fast back and fast forward operation.
Thisfield isused to set the maximum record count. After the record number reaches
this value, the record numbers are shifted to the newer side and the oldest record is

deleted. This number is always assigned to the last record.

Thisfield is used to set the timeinterval of the automatic trace record operation.

Sdlect referencetraces

This dialog box is opened/closed by clicking the Select reference traces button and
is used for managing the reference traces memorized by clicking the Capture button.

- T—

Time Trace
.............. S

This button enables/disables the graph display of the trace selected/highlighted on
this dialog box.

This button enables/disables the inversion of the trace selected/highlighted on this
dialog box.

This button deletes the trace selected/highlighted on this dialog box.

This button opens the Open Reference Trace dialog box which is used to open a
reference trace saved by using the Save Reference Trace dialog box.

This button opens the Save Reference Trace dialog box which is used to save the

reference trace sel ected/highlighted on this dialog box. The trace datais saved in the
XML spreadsheet format (.xml).
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This field shows the time stamp of the reference trace.

Thisfield shows the title of the reference trace. Thetitle is same as the title appears
top of the graph frame.

Select tracking traces

Thisdialog box is opened/closed by clicking the Select tracking traces button and is
used for managing the tracking traces.

This button deletes the trace selected/highlighted on this dialog box.

This field shows the time stamp of the tracking trace.

Thisfield shows the title of the tracking trace. The title is same as the title appears
top of the graph frame.

%

S - . -
sl Apply | Reset
Time Trace Background - Marker
BI26/2008 5:37:06 P  vi-11
3/26/2009 5:27:02 PM Vi-I Text Line

Axis Waorking Trace R

Grid - Tracking Trace

Frame - Reference Trace

Color and thickness

This dialog box is opened/closed by clicking the Color and thickness button and is
used for changing color of the graph color and the trace thickness.

The graph elements supported by this dialog box are background, text, X and Y
axes, graph grid, frame around graph, marker, line, and traces.

Clicking the color pattern opens the color palette for selecting color. The color
palette provides the function to add the custom colors.

This button applies the setup change made on this dialog box to the graph.

This button applies the initial setting to this dialog box and the graph.
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Oscilloscope View

File DataDisplay Help

Setup Name: |ID_VDS_WAFER

2 Vfdiv.

Meas. Time:
ius B

Pulse Period:
s00ms B

Remarks

tesults - |%]

Thiswindow is opened/closed by clicking the Oscilloscope View button on the
Tracer Test screen, or selecting the Option > Oscill oscope View menu.

This function monitors a point of the pulsed sweep measurement or the pulsed spot
measurement and displays its waveform. The monitoring point is specified by a
rectangular marker on the trace. This function is used for monitoring the time
relationship between multiple channel outputs/measurements, the change of the
output level for the gate drive channel, and so on.

Thisfunctionisvalid for using one or more VPUL SE or IPUL SE channels. And this
function is not available for the following measurement resources.

» HRSMU, HPSMU, MPSMU

+ MFCMU
+ WGFMU
+ SPGU
+ GNDU
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Data names set in the V Name and | Name fields of the channel area are used to
specify the target monitored signals.

During executing the tracer test, the waveforms within the specified duration are
displayed in this window graphically. The display resolutionis 2 us.
Oscilloscope View Window GUI

The Oscilloscope View window provides the following GUI. See Figure 1-1.

Oscilloscope View Window

Marker ~ Time/division  Duration of measurement
£

Oscilloscope View

File Data Setup Window

MARKER: -150 us 100 us/div.

VCE: NaN V [1 V/div. 0 V]
IC: NaN A [1 Afdiv. 0 A]
VGE: NaN Vv [1 w/div. 0 V]
IG: NaN A [1 Afdiv. 0 A]
Marker position 0s
i Time origin ) L ‘
Data at Marker position Vertical data/division and offset value

Provides the following function.

Save Setting Saves the setup data for waveform monitor. The setup datais
saved as apart of the tracer test setup.

Save DataAs...  Opensthe Save Waveform Data dialog box used to specify the
file name of the displayed waveform datato save.

Available data formats are the Text (tab separated), CSV, XML
spreadsheet, BMP (bitmap image), EMF (enhanced metéfile),
GIF image, and PNG image.

Close Closes the Oscilloscope View window.
Lists al the names of voltage/current output data set in the present tracer test with
serial numbers.

Checking a data name enables to monitor the signal corresponding to the data name,
and display the waveform in the Oscill oscope View window. If not checking, the
waveform for the data name is not displayed in the Oscill oscope View window.

Provides the following functions.
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Time > Scale Opensthe Time Scale dialog box. Enter the scale value of the X
axis (time) per division in the dialog box.

Time> Origin Opens the Time Origin dialog box. Enter the origin value of the
X axis (time) in the dialog box.

Sampling Opens the Sampling Setup dialog box. See “ Sampling Setup”
on page 1-45.
N. data name The data names that are checked on the Data menu are listed.

Opens the Data View dialog box. See “Dialog box for changing
datadisplay” on page 1-45. Where, N is a serial number.

Provides the following functions.
Large Changes the window size to the prescribed large window.

Small Changes the window size to the prescribed small window.

This area displays a waveform graph in the center. All monitored waveforms are
displayed on this graph. A vertical marker is available to read out the values on all
waveforms at a certain time.

The waveforms and the relational information are organized by color. To change the
color, select the Setup > N. data name menu to open the Data View dialog box. See
“Diaog box for changing data display” on page 1-45, for this dialog box.

The display itemsin the monitor area are described bel ow.

Marker position
Marker position (X-axis (time) data). Displayed on the upper
left of the graph. To move the marker position, use rotary knob
or mouse.

Data at Marker position
Y-axis (voltage or current) values at the marker position.
Displayed with the data names on the | eft of the graph
respectively.
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Time/division
Time scale value per division. Displayed on the top of the
graph. To change it, click on the displayed value and open the
Time Scale dialog box. Enter the scale value of the X axis
(time) per division in the dialog box.

TimeOrigin

Time origin value. Displayed on the bottom of the graph. To
change it, click on the displayed value and open the Time
Origin dialog box. Enter the origin value of the X axis (time) in
the dialog box.

Duration of measurement

Duration of the measurement for the presently-monitored sweep

step. Indicated by the green horizontal lines displayed on the

top and button of the graph. Hence, you can observe the time

relationship between the measurement time and the waveform.
Vertical data/division and offset value

Y-axis scale value per division and offset value. Displayed on
the right of the graph respectively. To change them, click on the
displayed value and open the Data View dialog box. See
“Dialog box for changing data display” on page 1-45, for this
dialog box.

Dialog box for changing data display

This dialog box is opened by selecting the Setup > N. data name menu, or by
clicking on the scale or offset value shown on the right area of the graph display.
Thisisused for changing the Y-axis scale, offset, the color of theline and characters,
and the line thickness.

Clicking the color pattern opens the color palette for selecting color. The color
pal ette provides the function to add the custom colors.
Sampling Setup

This dialog box is opened by selecting the Setup > Sampling menu. Thisisused for
setting up the sampling conditions of the waveform monitoring.

The target observing step is decided by the following combination:

» Theordinal number of the sweep step on the primary sweep source output
(VARL1 Step)

» Theordinal number of the sweep step on the secondary sweep source output
(VAR2 Step)
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The waveform sampling is started from the beginning of the pulse period within the
target observing step. The observing period on the waveformsis eventually decided
by setting the sampling delay (Delay) and sampling duration (Duration). Figure 1-2
shows a sampling setup example.

NOTE

If the observing period does not fully cover the measurement time, the measurement
data at the sweep step will be "NaN".

Figure1-2

Sampling Setup Example

2nd

3rd

1st
VART | ’ \

' 2nd

Pulse
period
VAR | g |
VAR1 Step =2
VAR2 Step = EACH
Delay=0s

Duration = pulse_period

VAR1 Step:

VAR2 Step:

Oscilloscope View monitors
waveforms in these timeframes.

The ordinal number (N) of the sweep step on the primary sweep
source output. N-th step is specified. For the dual polarity
sweep, the ordinal number of the positive sweep step isvalid.

For the interlacing sweep, every N-th step on repeated sweepsis
specified.

To specify the last step, enter LAST. Changing the number of
sweep step has no impact on the LAST setting.

For the interlacing sweep, every last step on repeated sweepsis
specified.

The ordinal number (M) of the sweep step on the secondary
sweep source output. M-th step is specified.

To specify each step, enter EACH.
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Delay: Sampling delay time. Thisisthe time from the beginning of the
pulse period to the beginning of the waveform sampling, - 30 us
to pulse period.

Duration: Duration to sample the waveforms, 22 usto 24 ms.

Arithmetic Operation Area

This area appears at the top of the graph by clicking the Option > Arithmetic
Operation > Operation N (N: 1, 2, or 3) menu, and is used to define arithmetic
expressions using the measurement result data. Thisfunction isuseful to graphically
display parameters given by the expressions.

Maximum of three expressions can be defined as Operation 1, Operation 2, and
Operation 3. An expression can be defined by two operands and an operator +
(addition), - (subtraction), * (multiplication), or / (division). The following
elements can be the operand.

e Measurement data (e.g. | neas)
* Sourcedata(e.g. Vset)
* Red literal constant (e.g. 2,0. 123, or 100E- 3)

e Operation 1 result (e.g. Vdr op), for the expression of Operation 2 and/or
Operation 3

e Operation 2 result (e.g. Vout ), for the expression of Operation 3
The following example calculates the voltage drop (Vdr op) caused by a 100 kQ
series resistor and measurement current (I neas), then calculates the voltage

(Vout ) applied to a device under test by subtracting the voltage drop from the
setting value (Vset ).

Operation 1:

[ Vdrop ] =] 100e3 ] * [ Ineas ]
Operation 2:

[ Vout ] =1 Vset ] - [ Vdrop ]

“NaN’ isreturned for the invalid calculation results.

To disable the operation, click the Option > Arithmetic Operation > Operation N
menu and uncheck the Operation N menu.
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In the quick test mode, you can execute the test setups saved in a preset group (My
Favorite Setup) sequentially. The EasyEXPERT main screen has the following
additional graphical user interface.

The following menu is displayed by clicking this button.

Cancel Closes this menu.

Duplicate This
Preset Group Opensthe Duplicate Preset Group dialog box. Creates a copy of
the present preset group and savesit as the specified name.

Import Preset

Group... Opens the Preset Group Import dialog box. Imports the
specified preset group.

Export Preset

Group... Opens the Preset Group Export dialog box. Exports the present

preset group as the specified name.

Organize Preset
Group Opens the Organize Preset Group dialog box used to organize
the preset group. See “ Organize Preset Group” on page 1-56.

If the preset group contains a tracer test setup

The tracer test setup is converted to and recalled as aMulti Channel 1/V Sweep test
setup.

In this conversion process, the VAR dual polarity sweep setup (Dua Polarity) is
ignored. The setup of the positive sweep from start to stop is converted, but the
setup of the negative sweep from - start to - stop is hot converted.

The conversion rule for the hold time settings

The VARL hold time setup (Hold Time) is converted and used, and the VAR2 hold
time setup (Hold Time) isignored.
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Preset Group

Setup Name

Quick Test List

Main GUI
Quick Test

Selects the preset group to open.

Lists all test setups saved in the preset group.

To select the test setup for the quick test setup operation, click the line. For multiple
selection, use ctrl-click, shift-click, or Select All.

When you are doing the quick test setup, the softkeys are available to start the
associated test. The softkey label will show the Setup Name.

The following buttons are available for the quick test setup operation.

Select All

Execution on/off

Data save on/off

Up
Down
Recall

Rename

Duplicate

Delete

Selects all test setup in the test setup list.

The & button is effective for the selected test setup and is used
to enable/disable execution of the tests. Once the quick test is
started, only the tests marked with [ will be executed in order
from top to bottom of the test setup list.

The & button is effective for the selected test setup and is used
to enable/disable data save of the tests. The data save will be
performed only for the tests marked with .

Moves the selected test setup upward
Moves the selected test setup downward.

Recalls the selected test setup. The screen is changed to
Application Test or Classic Test.

You can change the name of the selected test setup.

Creates a copy of the selected test setup and placesit at the
bottom of the test setup list.

You can delete the selected test setup.
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Figure1-3

Repeat
Procedures

Main GUI
Repeat Measurement Setup

Repeat M easurement Setup

Thisdialog box is opened by clicking the Repeat button, and is used to set the repeat
measurement condition. This dialog box supports the following action buttons.

Run Starts measurement.

Abort Aborts the measurement.

Cancel Cancels performing the repeat measurement and closes this
dialog box.

The repeat measurement is performed as shown in Figure 1-3. The repeat
measurement operation is controlled by the value of Count and status. Where, Count
is the number displayed in the Count field of the main screen, and status must be a
parameter of the response created by Start Procedure and Iteration Procedure. For
the response, see Figure 1-4.

Repeat M easurement Execution Flow

Repeat Procedures Start
Start Procedure: Count=0
| = _erowse.. | | | Start Procedure | |
Arguments:l ﬁ

TIteration Procedure:

g Browse...
Arguments: 5
Final Procedure:
I ﬁ Browse... |
Arguments: 5
¥ Automatically fill in Device 1D | Test Execution |
I
Thermo-trigger
| | Count=Count+1 |
[” Enabled Thermo-trigger N1265A Thermo-trigger List... | T
Repeat Stop Condition ‘ o | | Iteration Procedure | |

Stop repeating by: No
= l Abort I
l ¥ Counter reaching to: |S 2] ]l

1§ [+ Reset counter before repeating A — | Yes [&—
( Procedure return condition ] | | Final Procedure | |
A n 0
4 {1 Abort is clicked >l
status limit

Count is set to 0 when repeat measurement is started. End

Thisareais used to specify the procedure to be called while the repeat measurement
is performed. The procedure must be the execution file (.exefile). If no procedureis
needed, empty the field. The Browse button opens a file browser.
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Automatically fill
in Device ID

Repeat Stop
Condition

Figure1-4

Main GUI
Repeat Measurement Setup

Sart Procedure  Specifies the procedure executed before starting measurement.

Iteration
Procedure Specifies the procedure executed every single measurement.

Final Procedure Specifiesthe procedure executed after the repeat measurement.
If the procedure requires arguments, enter the values to the Argumentsfield.

If the procedure specified by Start Procedure or Iteration Procedure creates the
response as shown in Figure 1-4, EasyEXPERT performs the operation following
the response. See Figure 1-3. The parameter status value must be the string True or
False, and the parameter device_id value should be any string. EasyEXPERT
ignores the response of the different format.

This check box is available when the Procedure return condition box has been
checked, and is used to enable the device ID automatic input function. Thisfunction
enters the Device ID of the test record automatically. The value is given by
device_id which is a parameter of the response created by Start Procedure and
Iteration Procedure.

Thisareais used to set the repeat measurement stop condition. The following stop
conditions are available.

» Counter Reaching to: limit

The repeat measurement will be stopped if Count > limit. Reset counter before
repeating box must be checked to set Count=0 when the measurement is started.

* Procedure return condition

The repeat measurement will be stopped if the response shows status = True.

Procedure Response Expected by EasyEXPERT
* Response (input to EasyEXPERT):
XML format data
<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response>
status: True (break) or False
device_id: Device ID
* Example: <Response>

<Break>False</Break>
<Target>wafla:3 1</Target>
</Response>
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Thermo-trigger

Figure 1-5

Main GUI
Repeat Measurement Setup

Thisareais used to set the thermo-trigger function using the N1265A ultra high
current expander/fixture.

Enable

Thermo-trigger  Enables/disables the thermo-trigger function.

N1265A

Thermo-trigger

List... Opens the Thermo-trigger List dialog box used to set the
thermo-trigger function. See “ Thermo-trigger List” on page
1-53.

If the thermo-trigger function is enabled, the repeat measurement execution flow is
changed as shown in Figure 1-5. The following steps are added.

1. After Count isjudged, temperature (Temp) is measured.

2. If the measured temperature isin the range of the temperature condition (Center
and Radius), the action (Action) is executed after the delay time (Delay) el apsed.
Or else, the temperature measurement and this judgement are repeated.

Where, thetermsin () are the setup items on the Thermo-trigger List dialog box.

Repeat M easurement Execution Flow with Thermo-trigger Function

Count=0

| | Start Procedure | |

___________________________________

Temp Condition= True?

Yes

Action:|NOP

END
(Status=True)

Test Execution

| Count=Count+1

| | Iteration Procedurel |

Yes [¢———

| I Final Procedure | I

If Abort is clicked >le

End
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Figure 1-6

Main GUI
Repeat Measurement Setup

Thermo-trigger List

Thisdialog box is opened by clicking the N1265A Thermo-trigger List button, and
is used to set the Thermo-trigger function which is defined by listing multiple sets of
the temperature condition and action executed when the condition is satisfied. A
setup in arow of thelist isused for one loop sequence of the repeat measurement.
Thetop row isfor the first sequence of the repeat measurement, the second row is
for the second segquence, and so on. If the repeat measurement is repeated over the
number of rows set inthelist, thelist isused from the top row again. This dialog box
can have a maximum of 1001 rows.

And aso, in this dialog box, you can import any list from an external file and export
thelist to an externd file, in the CSV or XMLSS form.

Thermo-trigger List dialog box

Add | Deletel Up | Downl

0.5 deg C
0.5 deg C
0.5deg C
0.5deg C
0.5deg C

Import...l Export...l Ok | Cancel I Apply |

N (index) Select an entry that you wish to edit during the editing. During
the repeat measurement execution, this button indicates the
current-waiting entry.

Temp Selects the temperature used in the condition from the
following alternatives:

T1: Temperature value measured by the thermometer channel 1.
T2: Temperature value measured by the thermometer channel 2.
T1-T2: Difference between T1 and T2.

Center Specifies the center value of the temperature range in deg C.
Range: - 50 to 300. Resolution: 0.5.
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Main GUI

Repeat Measurement Setup

Radius

Delay

Action

Add

Delete
Up/Down
OK
Cancel

Apply

Specifies the radius value of the temperature rangein deg C.
Range: 0.5 to 50. Resolution: 0.5.

Specifies the delay time from the temperature condition
satisfaction to starting of the action specified by the Action
field, in seconds. Range: 0 to 3600, Resolution: 1.

Selects an action executed if the measured temperatureisin the
specified range, from the following alternatives:

TRIG: Doesthe single test execution after the
specified delay time, and then goesto the
next operation. Thisis useful to do the
single test execution in the specified
temperature range.

NOP: No operation (singletest execution is
skipped). Waits for the delay time, and goes
to the next operation. Thisis useful to wait
in the specified temperature range.

END: Sets the status to True, and exits the repeat
measurement after the delay time. Thisis
useful to exit the repeat measurement in the
specified temperature range.

Adds anew entry for the thermo-trigger condition and action
above the selected entry.

Deletes the selected entry.

Moves the selected entry upward or downward.
Applies the setup changes and closes this dialog box.
Cancels the setup changes and closes this dialog box.
Applies the setup changes.
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Main GUI
Repeat Measurement Setup

Import... Opens the Open File dialog box. Imports the specified file (.cvs
or .xml).

Export... Opens the Save File dialog box. Specify the file format in this
dialog box.
CVs

Exports the current settings as the specified name in the CSV
format that can be read by a spread sheet software. The datais
stored with the same order as the settings on the screen.

XML Style Sheet:

Exports the current settings as the specified name in the XML
spread sheet format that can be read by a spread sheet software.
Thetags are asfollows:
<Therno-trigger List>

<Tenp>A</ Tenp>

<Cent er >B</ Cent er >

<Radi us>C</ Radi us>

<Del ay>D</ Del ay>

<Act i on>E</ Acti on>
</ Therno-trigger List>
Where,

A: Temp field setting, T1, T2, or T1-T2, characters

B: Center field setting, numeric value

C: Radius field setting, numeric value

D: Delay field setting, numeric value

E: Action field setting, TRIG NOP, or END, characters
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Preset Group List

Copy

>>

<<

Close

Main GUI
Organize Preset Group

Organize Preset Group

Thisdialog box is opened by selecting the Organize Preset Group function of the
main screen, the Quick Test setup screen, or the Switching Matrix Operation Panel,
and is used to organize the preset group.

Lists the preset group saved in the workspace. The following buttons are available.

Add Opens the Add Preset Group dialog box. Creates a new preset
group and saves it as the specified name.

Rename Opens the Rename Preset Group dialog box. You can change
the name of the selected preset group.

Duplicate Opens the Duplicate Preset Group dialog box. Creates acopy of
the selected preset group and savesiit as the specified name.

Delete You can delete the selected preset group.

Import Only for the quick test setup. Opens the Preset Group Import
dialog box. Imports the specified preset group.

Export Only for the quick test setup. Opens the Preset Group Export
dialog box. Exports the selected preset group as the specified
name.

Sets the operation of the >> button and the << button. They work as Copy when this
box is checked, and as Move when this box is unchecked.

Copies or moves the preset setup selected in the |eft Preset Group box to the right
Preset Group box.

Copies or moves the preset setup selected in the right Preset Group box to the | eft
Preset Group box.

Closes the Organize Preset Group dialog box.
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Main GUI
Organize Preset Group

Preset Group Lists the preset setup saved in the preset group. The following buttons are available.
Preset Group Selects the preset group to open.

Setup Name Lists all preset setup saved in the preset group.

Select All Selects all preset setup.

Unselect All Unselects all preset setup.

Rename You can change the name of the selected preset setup.

Duplicate Creates a copy of the selected preset setup and placesit at the
bottom of the test setup list.

Delete You can delete the selected preset setup.
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Module Self
Calibration

Select All
Unselect All
Start Calibration
Abort

Full Range
Calibration

Main GUI
Calibration

Calibration

The Calibration window is opened by clicking the Calibration button, and is used to
perform the self-calibration, SMU current offset cancel, CMU data correction, and
SO on.

* “Module Self Calibration”
e “SMU Zero Cancel”
« “CMU Cdibration”

M odule Self Calibration

The Module Self Calibration tab screen is used to perform the self-calibration of
modules. Check the left check box of Name to select the module for self-calibration.
Open the measurement terminals at the cable end before performing the
self-calibration.

Displays the following values.

Name Name of module.

Full Range Full range calibration On or Off. Only for SMU+ASU.
Satus Calibration status. Pass or fail.

Notes Error information when calibration failed.

Selects all modules for calibration. This checks the check box for all modules.
Unselects all modules. This unchecks the check box for all modules.

Starts calibration for the selected modules.

Aborts calibration.

Only for the B1500A. Check this box to enable the 1 pA range calibration of
SMU+ASU.

If you do not use the 1 pA range, uncheck this box. The B1500A does not perform
the 1 pA range offset data measurement and calibration.
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Enable Auto
Calibration

SMU Zero Cancel

Full Range

Integration Time

Main GUI
Calibration

Enables or disables the auto-calibration capability. If this box has been checked
(function ON), and the B1500 automatically starts calibration for all modules every
30 minutes if the output switches of all modules are off for 30 minutes. If
auto-calibration is enabled, do not forget to open the measurement terminals or
disconnect the device under test from the terminal's after measurement.

SMU Zero Cancel

The SMU Zero Cancel tab screen is used to perform the SMU path offset current
measurement, and set the offset cancel function. Check the left check box of Name
to select the effective module. Open the measurement terminals at the cable end
before performing the offset measurement. This function is available for the
following modules. See also “ Current Offset Cancel” on page 4-43.

» SMU+ASU
» HRSMU
« MPSMU
» HPSMU
» HVSMU

Displays the following values.

Name Name of module

Full Range SMU+ASU full range measurement On or Off.

1nA Offset current measurement datain the 1 nA range. Available
for SMU+ASU, HRSMU, MPSMU, HPSMU, and HVSMU.

100pA Offset current measurement datain the 100 pA range. Available
for SMU+ASU and HRSMU.

10pA Offset current measurement datain the 10 pA range. Available
for SMU+ASU and HRSMU.

1pA Offset current measurement datain the 1 pA range. Available

for SMU+ASU only.
Enables (On) or disables (Off) the 1 pA range of the selected SMU+ASU.

Sets the integration time for the offset current measurement of the selected SMU
path. 1 PLC (power line cycle) to 100 PLC, initial setting 16 PLC.
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Select All

Unselect All

Measure...

NOTE

Measure...

Advanced
Options...

Phase
Compensation

Main GUI
Calibration

Selects al modules. This checks the check box for all modules.
Unselects all modules. This unchecks the check box for al modules.

Performs the SMU path offset current measurement for the effective modules.

CMU Calibration

The CMU calibration tab screen is used to perform the measurement data correction
of the multi frequency capacitance measurement unit (MFCMU). For the easy way,
perform the phase compensation and the open correction at |east.

See also “Error Correction” on page 4-25.

For a more accurate measurement, perform correction data measurement at the
measurement frequency before starting the capacitance measurement.

If the measurement frequency isnot included in thelist of default frequencies below,
click the Advanced Options... button and set the measurement frequency on the
Frequency area of the Advanced Options for CMU Calibration window.

Default frequencies:

1k,2k,5k, 10k, 20k, 50k, 100k, 200k, 500k, 1 M, 1.2 M, 1.5M, 2 M, 25 M,
27M,3M,32M,35M,37M,4M,42M,45M, 5MHz

Opens adialog box used to perform correction/compensation data measurement. To
perform the measurement, follow the dialog box.

The correction/compensation measurement data is saved and managed by the
workspace. And the last measured correction/compensation data will be loaded
when the workspace will be opened next time.

Opensthe “ Advanced Optionsfor CMU Calibration (page 1-62)” dialog box used to
set the frequencies for the correction data measurement and the reference values of
the working standard.

This check box is effective after the phase compensation data is measured, and is
used to enable or disable the phase compensation. Uncheck this box to disable the
phase compensation.

To measure the compensation data, open the measurement terminals at the end of
the device side and click the Measure... button.
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Open Correction

Short Correction

Load Correction

Main GUI
Calibration

If you extend the measurement cables to the device end by using the four terminal
pairs method, do not forget to connect following terminal s together at the device
end.

» thehigh potential (Hp) terminal and the high current (Hc) terminal

» thelow potential (Lp) terminal and the low current (Lc) terminal

This check box is effective after the open correction datais measured, and is used to
enable or disable the open correction. Uncheck this box to disable the correction.

To measure the correction data, connect the open standard that has the calibration
value or reference value, or open the measurement terminals at the end of the device
side. Then, click the Measure... button.

If you extend the measurement cables to the device end by using the four terminal
pairs method, do not forget to connect following terminal s together at the device
end.

» thehigh potential (Hp) terminal and the high current (Hc) terminal
» thelow potential (Lp) terminal and the low current (Lc) terminal

If the standard is used, click the Advanced Options... button and enter the reference
value to the OPEN Reference entry fields. If you do not use the standard, enter 0 to
thefields.

This check box is effective after the short correction datais measured, and is used to
enable or disable the short correction. Uncheck this box to disable the correction.

To measure the correction data, connect the short standard that has the calibration
value or reference value, or directly connect the measurement terminals at the end of
the device side. Then, click the Measure... button.

If the standard is used, click the Advanced Options... button and enter the reference
value to the SHORT Reference entry fields. If you do not use the standard, enter 0 to
thefields.

This check box is effective after the load correction datais measured, and is used to
enable or disable the load correction. Uncheck this box to disable the correction.

To measure the correction data, connect the load standard that has the calibration
value or reference value. Then, click the Measure... button.

Before performing the load correction data measurement, click the Advanced
Options... button and enter the reference value to the LOAD Reference entry fields.
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Frequency

NOTE

Main GUI
Calibration

Advanced Optionsfor CMU Calibration

Thisdialog box is opened by clicking the Advanced Options... button, and is used to
set the information required to measure the open/short/load correction data and the
phase compensation data. This dialog box provides the following action button.

OK Applies the setup changes and closes this dialog box.
Cancel Cancel the setup changes and closes this dialog box.

You can select one of the following radio buttons to select the measurement
frequency setup mode.

» Usefactory specified frequencies (Default)

Usually, select this mode. 23 points are automatically set. They are 1k, 2k, 5k,
10k, 20k, 50k, 100k, 200k, 500k, 1M, 1.2M,1.5M,2M,25M,2.7M, 3 M,
32M,35M,37M,4M,42M,45M, and5 MHz.

e Specify list of calibration frequencies

Select this mode when you want to set the frequencies independently. The
frequency must be 1 kHz to 5 MHz. The number of frequencies must be 1 to
101.

Click Add to open adialog box, and enter the value.
For the unnecessary value, select the value and click Delete.
e Specify frequencies by range
Select this mode when you want to set the frequencies sequentially and
automatically.

Specify the start frequency, the stop frequency, the number of steps, and the
scale LINEAR/LOG. The start frequency must be less than the Stop value and at
least 1 kHz. The stop frequency must be more than the Start value and no more
than 5 MHz. The number of steps must be 2 to 1001.

If the device measurement frequency is not equal to the correction data
measurement frequency, calculation will be performed automatically to get the
correction data for the device measurement frequency, and the calculated correction
datawill be used for the data correction of the measurement data.
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Integration Time This area defines the integration time used for measuring phase compensation data
or open/short/load correction data. The number of averaging samples
(Mode=AUTO) or the averaging time (Mode=PLC) is set.

Mode A/D converter operation mode, AUTO or PLC
Factor Factor for the initial value. See “Mode, Factor” on page 4-20.
Reference Thefollowing entry fields are availabl e to set the calibration values or the reference

Standard Values  values of the open/short/load standard. If you use the standard, enter the values to
the following entry fields.

» OPEN Reference: Capacitance and Conductance

If you do not use the reference, enter O in the both fields.
* SHORT Reference: Inductance and Resi stance

If you do not use the reference, enter O in the both fields.

* LOAD Reference: Inductance and Resistance
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Main GUI
Configuration

Configuration

The Configuration window is opened by clicking the Configuration button, and is
used to display the system information and event log, as well asto perform
diagnosis and self-test.

* “Main Frame’

* “Modules’

e “ASU”

e “Switching Matrix”

e “SMU/PG Selector”

*  “Module Selector”

*  “Dual HCSMU Combination”
» “UHC Expander / Fixture”

e “HVSMU Current Expander”
e “UHV Expander”

*  “SMU Output Setting Limits”
* “Event Log”

» “Extended Configuration”

Main Frame

The Main Frame tab screen is used to display the system information and perform
diagnosis.

Model Displaysthe instrument ID. B1500A or B1505A.
Identification

Line Frequency Sets the power line frequency, 50 Hz or 60 Hz.
EasyEXPERT Rev. Displaysthe revision number of the EasyEXPERT.
Firmware Rev. Displays the revision number of the B1500 firmware.

HOST ID Displaysthe host id of the B1500 internal computer.

1-64 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



Main Frame
Diagnosis

Select All
Unselect All

Start Diagnosis

Slot Configuration

Select All
Unselect All
Start Self Test

Recover Module

Abort

Main GUI
Configuration

This arealists Item and Status.
Item Name of diagnosisitem. To select, check the left check box.

Satus Diagnosis status. Pass or fail.

Selects all items for diagnosis. This checks the box for all items.

Unselects all items. This unchecks the box for all items.

Starts diagnosis for the selected items. To perform diagnosis, specify theitemsto
perform and click this button. A dialog box appears. Follow the dialog box to

perform the diagnosis. Some items need your judgement, pass or fail. Also you will
need to connect an adapter, press keys, check LEDs, and so on.

Modules

The Modules tab screen is used to perform self-test of modules.

This arealists Slot, Module Type, Name, and Status.

Slot Slot number where the module isinstalled. To select, check the
|eft check box.

Module Type Module model number

Name Module name. See Table 1-2.

Satus Self-test status, Passed, Failed, Recovered, or - - - - (self-test
has not been performed)

SCuU Specifiesif the module is connected to the SCUU.

Notes Error information when the modul e self-test failed.

Selects al modules for self-test. This checks the check box for all modules.
Unselects all modules. This unchecks the box for all modules.
Starts self-test for the selected modules.

This button isfor service use only. Makes the failed modules respond again. This
button does not solve the problem that causes the Failed status.

Aborts self-test.
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Status LED

Table 1-2

Slot
Module Type

Name

Main GUI
Configuration

Enables (ON) or disables (OFF) the status indicator (LED) of the ASU (Atto Sense
and Switch Unit), the SCUU (SMU CMU Unify Unit), and the module selector.

Module Name

M odule name

M easurement resource

GNDU+ADC B1500 mainframe
SMU<N>:HP HPSMU
SMU<N>:MP MPSMU
SMU<N>:HR HRSMU
SMU<N>:HR/AS SMU+ASU
SMU<N>:HC HCSMU
SMU<N>:DHC Dual HCSMU
SMU<N>:MC MCSMU
SMU<N>:HV HVSMU

SMU<N>:UHC500

UHCU (standard)

SMU<N>:UHC1500

UHCU (with the option N1265A-015)

SMU<N>:HVMC

HVMCU

SMU<N>:UHV

UHVU

Where, <N> is achannel number.

ASU

Only for the B1500A. The ASU tab screen is availableif the B1500A installs the
SMU calibrated with the ASU (Atto Sense/Switch Unit) regardless of the ASU
connection status, and shows the ASU information.

Slot number
Type of module

Name of module
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ASU Serial
Number

ASU I/O Path

Switching Matrix
Type

GPIB Address

Poll

Start Self Test

SWM IN

Main GUI
Configuration

Serial number of the usable ASU. This cell showsthe seria number evenif the ASU
is disconnected.

If an incorrect ASU is connected to the SMU, this cell displays an error message
instead of the serial number. Error message is also displayed if an ASU is connected
to the SMU which is not available for using ASU.

ASU switching operation, SMU or AUX

Value I nput-to-output connection and description

SMU | ASU aways makes the path from the ASU Force input to the ASU
output.

AUX | ASU performs automatic switching in every test. The ASU normally
makes the path from the AUX In input to the ASU output and makesthe
path from the SMU input to the ASU output for the test using the SMU.

Switching Matrix

Not available for the B1505A. The Switching Matrix tab screen is used to confirm
the GPIB connection with Agilent B2200A/B2201A/E5250A switching matrix, and
defines the connections between the measurement modules and the switching matrix
input ports.

Displays the type of the switching matrix. One of the following.

» B2200A Femto Leakage Switch Mainframe

» B2201A 14ch Low Leakage Switch Mainframe

o EB250A Low Leakage Switch Mainframe

» No Switching Matrix (if switching matrix isnot connected)

Specifies the GPIB address of the switching matrix. 1 to 30.

Confirmsif the switching matrix with the specified GPIB Addressis connected to
the B1500A.

This button starts the selftest of the switching matrix.

SWM INn means the switching matrix input port n. where, nisaninteger 1 to 10 for
the E5250A or an integer 1 to 14 for the B2200A/B2201A.
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Kelvin

CmMu

Extended
Configuration

Main GUI
Configuration

Enter the label used to specify the input port to the right entry field. The port name
and the connected module name can be the label. Or select one from the pull-down
menu. There must be no colon (;) in the label.

If the Kelvin check box is checked, the coupled even number port is grayed out.
If the CMU check box is checked, the SWM IN10 for the E5250A or the SWM
IN14 for the B2200A/B2201A is grayed out.

Check this box if this port is used for the Kelvin connection. Connect the switching
matrix inputs to the SMU as follows.

» for the E5250A (m: integer 1to 3)
SMU INPUT 2m+ 1 to the SMU Force terminal
SMU INPUT 2mto the SMU Sense terminal
» for B2200A/B2201A (m: integer 1 to 6)
Input 2m- 1 to the SMU Force terminal
Input 2mto the SMU Sense terminal

Check this check box if this port is connected to the CMU. Connect the switching
matrix inputs to the CMU as follows.

+ for the E5250A
AUX INPUT CV1to the CMU Hpot/Hcur terminals
AUX INPUT CV2to the CMU Lpot/Lcur terminals
+ for B2200A/B2201A
Input 13 to the CMU Hpot/Hcur terminals
Input 14 to the CMU Lpot/Lcur terminals

To obtain accurate capacitance measurement result, perform capacitance
compensation. See Agilent B1500A User’s Guide for the capacitance compensation
when the switching matrix is used.

Also see “Extended Configuration” on page 1-79.

This button opens the “ Extended Configuration” on page 1-79 dialog box.
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SMU/PG Selector

Not available for the B1505A. The SMU/PG Selector tab screen is used to specify
the input connection and the channel connection status of the Agilent 16440A
SMU/PGU selector (B1500A-A04). The selector can be controlled by the B1500A
viathe Digital 1/0 connector and the Agilent 16445A selector adapter.

Two selectors can be used. The first selector must be connected to the Digital 1/0
connector viathe 16445A. And if the second selector is used, it must be connected
to the first selector’s Control Output connector. See “ SMU/PG Selector” on page
4-49.

To use the selector, connect the selector to the B1500A, and check this check box.

CH1 and CH2 indicates the channels 1 and 2 of the first selector respectively.
CH3 and CH4 indicates the channels 1 and 2 of the second selector respectively.

Specifies the SMU connected to the SMU input of the selector channel CH1, CH2,
CHS3, or CH4.

Switching operation of the selector channel CH1, CH2, CH3, or CH4

Value I nput-to-output connection and description

Always SMU | Selector always makes the path from Input SMU to Output.

Normally PGU | Selector performs automatic switching in every test. The

(AUX) selector normally makes the path from Input PGU to Output
and makes the path from Input SMU to Output only for the test
which uses the SMU connected to the Input SMU port.

The CH1 and CH3 also provides the PGU Open status which is set by using the
Advanced window of the Measurement Setup.

M odule Selector

Only for the B1505A. Thistab screen is used to specify the input connection and the
default input-to-output path of the module selector. The selector can be controlled
by the B1505A viathe Digital 1/0 connector.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 1-69



Enable Module
Selector

Input

Output

Status

Auto Detection

Diagnosis

Apply

Main GUI
Configuration

This check box is used to enabl e/disable the modul e selector. If this box is checked,
the modul e sel ector can be used.

Specifies the modul es connected to the modul e selector’s HVSMU, HCSMU, and
HPSMU input ports respectively. For the port which no module is connected, blank
the entry field.

Enable Series Resistor (100 kohm) for HYSMU
This check box is used to connect/disconnect the built-in series resistor (100 k() on
the HV SMU connection path. If this box is checked, the series resistor is connected.

Specifies the module selector connection status in the normal state. The module
selector makes the path to the output port from the input port specified by the
Default field.

When ameasurement is performed, the module selector performs automatic
switching in every test. The selector makes the path to the output port from the
modul e used for the test. The connection statusisindicated by the Status indicator
mounted on the module selector. See Table 1-3 on page 1-71.

Shows one of the following status.

Not Detected Module selector has not been detected yet.
Communication Established  Normal status. Module selector can be used.
Communication L ost Once the modul e selector was detected. However

the communication has been broken now.

This check box is used to enabl e/disable the modul e sel ector automatic detection. If
this box is checked, the automatic detection of the module selector is performed
when EasyEXPERT islaunched.

The Start Diagnosis button is used to start the module selector diagnosis. And the
Status shows the diagnosis result.

This button applies the setting.
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Table 1-3 Module Selector Status Indicator and I nput-to-Output Connection Path
M odule used for Satus I nput-to-output connection? of output terminals
thetest indicator . .
High Sense High Force L ow Sense Low Force
HPSMU or HPSMU HP/MPSMU HP/MPSMU
MPSMU Sense Force
HCSMU
HCSMU or HCSMU I_—|CSMU HCSMU Low Sense
DHCSMU High Sense High Force T HCSMU
HVSMU HVSMU | HVSMU Force GNDU Force | Low Force
Open
HVSMU and built-in HVSMU Force P GNDU Sense

seriesresistor

+ seriesresistor

b

Open Open Open

a. Inthe normal state, the module selector makes the path to the output port from the input port
specified by the Default field. When a measurement is performed, the module selector performs
automatic switching in every test. The selector makes the path to the output port from the mod-
ule used for the test.

b. This condition iswhen all Input fields HYSMU, HCSMU, and HPSMU are blank.

CAUTION

Enable

Master HCSMU

If dual HCSMU (DHCSMU) is used with the modul e sel ector, the maximum current
must be + 30 A to prevent the module selector from performance degradation and
failure.

Dual HCSM U Combination

Only for the B1505A installed with two HCSM U modules. This screen is used to set
the dual HCSMU operation.

This check box is used to enable/disable the dual HCSMU operation. If thisbox is
checked, the dual HCSMU operation is enabled and two HCSMU modules can be a
SMU which supports £ 40 A (pulse), £ 2 A (DC).

Specifies the HCSMU modul e used as the master channel of the dual HCSMU
operation. The module must be connected to the Master port of the 16493S-020/021
dual HCSMU adapter.
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Specifies the HCSMU modul e used as the dlave channel of the dual HCSMU
operation. The module must be connected to the Slave port of the 16493S-020/021
dual HCSMU adapter.

This button applies the dual HCSMU operating condition. To apply the setup
changes successfully, the B1505A must be in theidle state and the Standby output
must be OFF.

UHC Expander / Fixture

Only for the B1505A. Thistab screen is used to set the N1265A ultra high current
expander/fixture. The N1265A can be controlled by the B1505A viathe Digital 1/0
connector.

This check box is used to enable/disable the ultrahigh current unit (UHCU). If this
box is checked, UHCU can be used.

Specifiesthe modules used for controlling the UHCU. For the port which no module
is connected, blank the entry field.

Voltage Control

SMU Specifiesthe module (MCSMU or HCSMU) connected to the V
Control port of the N1265A. The SMU channel set to thisfield
isassigned to the UHCU and is used to indicate the UHCU.

Current Control

SMU Specifies the module (MCSMU or HCSMU) connected to the |
Control port of the N1265A.

Effective only when the Enable Ultra High Current Unit check box is checked.

The Start button starts the self-test for the N1265A. Measurement terminals must be

opened during the self-test. The Status shows the execution result.

Effective only when the Enable Ultra High Current Unit check box is checked.

The Start button starts the self-calibration for the N1265A. Measurement terminals

must be opened during the self-test. The Status shows the execution result.

This check box is used to enable/disable the selector of the N1265A. If thisbox is
checked, the selector can be used.

UHCU Displays the SMU channel assigned to the UHCU.

1-72 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



Output

Enable Gate
Control

Gate Control

HVSMU

SMU

Main GUI
Configuration

Specifies the HV SMU connected to the HY SMU port of the
N1265A directly or viathe N1266A current expander.

Specifies the module (MPSMU or HPSMU) connected to the
SMU port of the N1265A.

For the port which no module is connected, blank the entry field.

Enable Series Resistor (100 kohm) for HYSMU

This check box is used to connect/disconnect the built-in series resistor (100 k() on
the HVSMU direct path. If this box is checked, the series resistor is connected.

Default

Specifiesthe selector input-to-output connection status (UHCU,
HVSMU, SMU, GNDU, or blank) in the normal state. The
selector makes the path to the output port from the input port
specified by the Default field. If thisfield is blank, the output
port is open.

When a measurement is performed, the selector performs
automatic switching in every test. The selector makes the path
to the output port from the measurement resource used for the
test. The connection statusis indicated by the Status indicator
mounted on the N1265A. See Table 1-4.

This check box is used to enabl e/disabl e the Gate path of the N1265A. If thisbox is
checked, the Gate path can be used.

SMU

Resistor

Specifies the module (MCSMU or HCSMU) connected to the
Gate port of the N1265A. For the port which no moduleis
connected, blank the entry field. Built-in series resistor can be
connected to the Gate path. To connect the series resistor, set
the Resistor field.

Specifies the resistance of the built-in series resistors for the
Gate path. If the seriesresistor is not used, select 0 ohm.
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Table 1-4 N1265A Satus|ndicator and Selector Connection Path
Status Selector Output terminals?
indicat . .
indicator Low Sense Low Force High Sense High Force
(off) Open Open Open Open
GNDU Sense GNDU Force Open Open
SMU GNDU Sense GNDU Force SMU Sense SMU Force
UHC UHCU Low Sense | UHCU Low Force | UHCU High Sense | UHCU High Force
GNDU Sense GNDU Force HVSMU Force Open
HVSMU
GNDU Sense GNDU Force HVSMU Force Open
+ Series resistor

a. Inthe normal state, the selector makes the path to the output port from the input port specified
by the Default field. When a measurement is performed, the selector performs automatic switch-
ing in every test. The selector makes the path to the output port from the measurement resource

used for the test.
Thermometer Channd 1
Channd 2
Interval
Format

Auto Detection

Enabl es/disabl es the thermometer channel 1.
Enabl es/disabl es the thermometer channel 2.

Specifies the interval of the temperature measurement. During
executing any classic test, the temperature is not measured
regardless of this setting.

Specifies the record format of the temperature data. The datais
recorded by adding to the end of the Device ID string. Variables
{0} for the channel 1 temperature, {1} for the channel 2
temperature, and {2} for the difference between {0} and {1}
are available for setting the format.

Initial setting: T1={0}, T2={1}, T1-T2={2} deg C

You can use the measurement temperature val ues as the repeat measurement
condition. See “Repeat Measurement Setup” on page 1-50.

This check box is used to enable/disabl e the automatic detection of the N1265A. If

this box is checked, the automatic detection is performed when EasyEXPERT is

launched.
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Shows one of the following status.
Not Detected N1265A has not been detected yet.
Communication Established  Normal status. N1265A can be used.

Communication L ost Once the N1265A was detected. However the
communication has been broken now.

Effective when the Enable Ultra High Current Unit check box, the Enable Selector
check box, or/and the Enable Gate Control check box is checked.

The Start button starts the diagnosis for the N1265A. Dialog box will be opened to
navigate you the cable connection during the diagnosis. The Status shows the
execution result.

This button applies the setting.

Before starting diagnosis

If the N1266A expander is connected between the HV SMU and the N1265A,
disconnect the N1266A. And connect the cable from the HVY SMU Force terminal to
the N1265A Selector Input HYSMU terminal.

HVSMU Current Expander

Only for the B1505A. Thistab screen is used to set the N1266A HVSMU current
expander. The N1266A can be controlled by the B1505A viathe Digital 1/0
connector.

This check box is used to enable/disable the high voltage medium current unit
(HVMCU). If thisbox is checked, HYMCU can be used.

Specifies the HV SMU and the modules used for controlling the HYMCU. For the
port which no module is connected, blank the entry field.

HVSMU Specifies the HY SMU connected to the HVY SMU input port of
the N1266A.

Voltage Control

SMU Specifiesthe module (MCSMU or HCSMU) connected to the V
Control port of the N1266A. The SMU channel set to thisfield
isassigned to the HYMCU and is used to indicate the HYMCU.
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Current Control
SMU Specifies the module (MCSMU or HCSMU) connected to the |
Control port of the N1266A.

Self Test Effective only when the Enable High Voltage Medium Current Unit check box is
checked.

The Start button starts the self-test for the N1266A. M easurement terminals must be
opened during the self-test. The Status shows the execution result.

Output Enable Series Resistor (100 kohm) for HYSMU

This check box is used to connect/disconnect the built-in series resistor (100 k() on
the HVSMU direct path. If this box is checked, the series resistor is connected.

Default Specifies the input-to-output connection status (HV SMU,
HVMCU, or blank) in the normal state. The N1266A makesthe
path to the output port from the input port specified by the
Default field. If thisfield is a blank, the High output port is
open.

When ameasurement is performed, the N1266A performs
automatic switching in every test. The N1266A makes the path
to the output port from the measurement resource used for the
test.

The connection status isindicated by the Status indicator
mounted on the N1266A. See Table 1-5.

Auto Detection This check box is used to enable/disable the N1266A automatic detection. If this
box is checked, the automatic detection is performed when EasyEXPERT is

launched.
Status Shows one of the following status.
Not Detected N1266A has not been detected yet.
Communication Established Normal status. N1266A can be used.
Communication L ost Once the N1266A was detected. However the
communication has been broken now.
Apply button This button applies the setting.
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N1266A SatusIndicator and Input-to-Output Connection Path

I nput-to-output connection? of output terminals
Statusindicator

Low High
(off) GNDU Force and Sense Open
HVMCU HVMCU High
HVSMU HVSMU Force
HVSMU Force + Series resistor

a. Inthenormal state, the N1266A makes the path to the output port from
the input port specified by the Default field. When ameasurement is
performed, the N1266A performs automatic switching in every test. The
N1266A makes the path to the output port from the measurement
resource used for the test.

UHV Expander

Only for the B1505A. Thistab screen is used to set the N1268A ultra high voltage
expander. The N1268A can be controlled by the B1505A viathe Digital 1/0
connector.

This check box is used to enable/disable the ultra high voltage unit (UHVU). If this
box is checked, UHVU can be used.

Specifiesthe modules used for controlling the UHV U. For the port which no module
is connected, blank the entry field.

Voltage Control

SMU Specifiesthe module (MCSMU or HCSMU) connected to the V
Control port of the N1268A. The SMU channel set to thisfield
isassigned to the UHV U and is used to indicate the UHV U.

Current Control
SMU Specifiesthe module (MCSMU) connected to the | Control port
of the N1268A.

This check box is used to enable/disable the N1268A automatic detection. If this
box is checked, the automatic detection is performed when EasyEXPERT is
launched.
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Shows one of the following status.
Not Detected N1268A has not been detected yet.
Normal status. N1268A can be used.

Once the N1268A was detected. However the
communication has been broken now.

Communication Established

Communication L ost

Effective when the Enable Ultra High Voltage Unit check box is checked.

The Start button starts the diagnosis for the N1268A. Dialog box will be opened to
navigate you the cable connection during the diagnosis. The Status shows the
execution result.

This button applies the setting.

SMU Output Setting Limits

Only for the B1505A.. This screen is used to set the upper limit of the SMU output
value and compliance value.

Sets the upper limit of the voltage output value and compliance value.
Effective value: 200 V to 10 kV, in 100 V step.

Sets the upper limit of the current output value and compliance value.
Effectivevalue: 1 A to 1500 A, in 1 A step.

This button applies the setting.

Event Log
The event log tab screen displays the event log.

Displays date and time of the event.
Event message

Process ID of the event

Process name

User name. Windows login name.

1-78 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



Host

Refresh

Save as Hardware
Profile

CMU
Compensation

Main GUI
Configuration

Host name of the B1500

Refreshes the event log.

Extended Configuration

Not available for the B1505A. This dialog box opens by clicking the Extended
Configuration button in the Configuration window’s Switching Matrix screen and
closes by clicking the Close button.

Switching matrix hardware configuration can be saved as the hardware profile.
Save Saves the present hardware profile.

The hardware profile can be made for each workspace individually.

Selects the compensation mode of the capacitance measurement using the switching
matrix. Click one of the radio buttons, No Compensation, Select, and User

Compensation Data File. See Agilent B1500A User’s Guide for the capacitance
compensation when the switching matrix is used.

» No Compensation

Select thisradio button if you do not need the capacitance compensation. The
raw data without compensation is displayed and saved.

» B2200A/B2201A (standard)
The following setup is available for the B2200A/B2201A hardware profile.

e Select

Select thisradio button to perform the capacitance compensation for the path
from the B2200A/B2201A input ports to Agilent 16495F/G connector plate
or Agilent B2220A probe card interface. The data after compensation is
displayed and saved.

DUT I/F Specifies the model number of the path you use. The
selections are the 16495F/G and B2220A.

Cable Specifies the model number of the cable from the
B2200A/ B2201A output to the DUT I/F. The selections
are the 16494A/B/C-001 (1.5 m) / 002 (3 m) / 005 (4 m).

This mode cannot perform the capacitance compensation for the cablesto
positioner/manipulator or the probe card.

» User Compensation Data File
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Select thisradio button and specify the compensation datafile to perform the
capacitance compensation for the path from the B2200A/B2201A input
ports to the end of positioner/manipulator/probe card. See Agilent B1500A
User’s Guide for creating the compensation data file. The data after
compensation is displayed and saved.

e EB5250A (option)
The following setup is available for the E5250A hardware profile.
» User Compensation Data File

Select thisradio button and specify the compensation data fileto perform the
capacitance compensation for the path from the E5250A input ports to the
end of positioner/manipul ator/probe card. See Agilent B1500A User’s Guide
for creating the compensation datafile. The data after compensation is

displayed and saved.

Clear Clearsthe User Compensation Data Filefield.

Triaxial Cable Enter the length of the 16494A triaxial cable
connected between the E5250A outputsto the
connector plate.

User Triaxial Cable Enter the length of the triaxial cable between
the connector plate and the DUT. Enter O if
thetriaxial cableisnot used.

User Coaxial Cable Enter the length of the coaxial cable between

the connector plate and the DUT. Enter O if
the coaxial cableis not used.
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Switching Matrix Operation Panel

Not available for the B1505A. The Switching Matrix Operation Panel is opened by
clicking the Switching Matrix button, and is used to create the switch setup for
Agilent B2200A/B2201A/E5250A switching matrix, send the setup to the switching
matrix, and so on. The switch setup can be saved to the switch setup preset group.
This group is different from the preset group for test setups.

Thisareais used to create the switching matrix switch setup. You can create the
setup by clicking the Input-Output cross point. The switch setup can be sent to the
switching matrix by clicking the Apply Switch Setup button.

Color of cross point Switch setup
green close
gray open
Setup Name Name of switch setup
Clear All Sets dl cross point open.
Input Shows the switching matrix input port and the measurement

resource connected to it. Thisinformation is set in the
“Configuration”.

L abel Shows the label set to the measurement resource. The label is
set in the application test definition or the classic test setup.

ALL Checking this box sets al of thisline to close.
Unchecking this box sets all of thisline to open.

Thisbox isgray and have acheck when across point in thisline
isset to close.

Output Output channels 1 to 12, 24, 36, or 48. Available numbers
depend on the number of the matrix cardsinstalled in the
switching matrix. Thefield below the channel number isused to
enter the label for the output channel.

This button converts the switch setup to the switching matrix setup data format of
the classic test, and savesiit to the present My Favorite Setup group.
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This button sends the switch setup to the switching matrix.

This button reads the switch setup from the switching matrix.
This button opens all relays on the switching matrix.

The switch setups you create MUST be saved to the preset group to reuse them.

Click the Preset List button to display the menu that provides the following
functions. Select the preset group by using the field below the button. The switch
setups can be recalled by using the area below the field.

Cancel Closes the menu.
Preset Group Provides the following three functions.

Add New Preset Group  Opensthe Add Preset Group dialog box. Creates anew
preset group and savesit as the specified name.

Rename This Preset
Group Opens the Rename Preset Group dialog box. You can
change the name of the selected preset group.

Duplicate This Preset

Group Opens the Duplicate Preset Group dialog box. Creates
acopy of the present preset group and savesit asthe
specified name.

Delete ThisPreset Group You can delete the selected preset group.

Organize Preset Group... Opensthe Organize Preset Group dialog box used to
organize the preset group. See “Organize Preset
Group” on page 1-56.

Rename You can change the name of the selected switch setup.
Duplicate Creates a copy of the selected switch setup.

Delete Deletes the selected switch setup.

Delete All Deletes al switch setupsin the present preset group.

The button saves the present switch setup into the present preset group as a new
setup of the group.

The button recalls the selected switch setup. This means opening and displaying the
definition of the selected switch setup.
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Sandby Channel Definition

The Standby Channel Definition window is opened by clicking the Standby button,
and is used to define the standby channels and set the standby mode. See “ Standby
Function” on page 4-38.

The standby channel isthe channel for maintaining specified output when the
standby mode is ON and in the non-measurement state. The standby channels will
be in the standby state, while the other channelswill bein theidle statewhichisOV
output and 100 pA compliance. When the standby mode is OFF and in the
non-measurement state, all channelswill bein theidle state.

This area provides the following button.

Sandby ON/OFF Sets the standby mode ON or OFF.

This area defines the standby channels. The standby channels will start to output in
order, from the top to bottom, aslisted in this area. The order of bias stop is bottom
to top.

Sandby Check the check box to specify the standby channel.

Theradio button is used to select the channel setup availablefor
the Up/Down button.

Unit SMU or UHV U used for the standby output. To specify the
measurement resource connected to the selector (N1258A,
N1259A-300, N1265A) or N1266A expander, the channel must
be set to the Default output in the Configuration window.

Standby channel cannot be set for the SMU connected to the
ASU which makes the path to the AUX port.

Mode Output mode, V (voltage) or | (current)

Source Standby channel output value, inV or A

Compliance Compliance value, in A or V. Enter the current limit value for
the voltage source, or the voltage limit value for the current
source.

Up Moves the selected channel setup upward. To select a channel

setup, use the radio button on the left.
Down Moves the selected channel setup downward.
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Data Display

The Data Display window is opened by clicking the Data Display button, and is
used to display measurement data and analyze the data.

e “DataDisplay GUI”

» “Display Setup”

» “Graph Properties’

e “List Display Properties’
* “Tool Bar”

e “Setup Summary”

e “Data Status’

» “Miscellaneous Operations’

€ idvogm [(1) ; 3/8/2006 6:42:43 PM] - Agilent EasyEXPERT G&lo
File Edit View Marker Cursor Line Window Help
2R EEEEQ QR E
Setup Name: Jid’\'ggm [(1) ; 3/B/2006 6:42:43 PM]
X-Y Graph Plot Properties... | | Parameters |
Y% Agilent
@ . MARKER{ 1.2500000000E-+000 vV  1.571 04 A L 0035 ) ) vth 1.01822 v
1m 1
Ints t:
e gmMax |1 08450 mS
Gradient:
1,084500E-003
Idrain
100 u
fdiv
i Intercept: 1.08822 v
-500 m Vgate (V) 200 m [div F
<] s =l
List Display properties... | |
Indsx | Voate | Vsource | Vdrain Vsubs | Tdrain | am| =
1 -500 v ov 100 miv ov 415 A -157.28 p5 -
2 450 mv ov 100 mv ov 7.449 DA 81.7 pS
3 <400 my v 100 mv v -7.755 pA 71075 ™
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About Display Mode

The Data Display window provides two display mode Overwrite and Append.

In Overwrite mode, the “Display Data (page 1-17)” function opens a new Data
Display window and displays data.

In Append mode, the “ Display Data (page 1-17)” function creates a new display
layer on the present Data Display window and displays data.

Updating Data Calculation

When the classic test result is displayed, you can update the cal culation results of the
user function, analysis function, and auto analysis function. So use the Apply
button. See “Function Setup (page 2-42)".

Append Measurement

After the Append measurement, you will see tabs between the tool bar and the graph
plot area. The tabs are used to select the display layer for data display and analysis
operation. The Data Display window can have maximum 10 display layers.

Multi Display Function

In the Multi Display OFF status, the test result data will be always displayed on the
singular Data Display window even if the test setup is changed.

In the Multi Display ON status, the test result data of the same test setup name will
be displayed on the exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display window.

The settings on the Display Setup are applied to the X-Y Graph on the Data Display
window. The X-Y Graph can handle one X dataonthe X axisand up to eight Y data
ontheY axis.

Define the X axis carefully when plotting Multi Channel I/V Sweep measurement
results that may contain data measured by multiple VAR1 channels, as the result
may contain multiple X datathat can be selected for the X axis.

The Display Setup must be set properly to match the X axis data and the X data of
the plot to be displayed.
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Setup Name

X-Y Graph Plot

Parameters

List Display

pin

X

File menu

Main GUI
Data Display

Data Display GUI
Thisfield just displays the name of the test setup used to get this test record.

This area displays the measurement result graph, traces, marker, cursor, and lines.
The Properties button opens “ Graph Properties (page 1-96)".

This area lists the user-defined output parameters if the output parameters are set.

This area displays the measurement result data list. The Properties button opens
“List Display Properties (page 1-97)".

The Data Display window can keep up to 10 display layers. And the earliest layer
over 10 will be automatically deleted. This button is available when the window
keeps at |east two layers. If this button shows the standing pin, thelayer will be kept.
If this button shows the laid pin, the layer can be del eted.

Double clicking the tab gives the same result as this button.
This button closes the selected display layer.

Provides the following functions.

Switch to Append Mode/
Switch to Overwrite Mode  Used to switch the display mode.

Update Test Result Stores the information of the scale and the analysis
toals.

Delete Test Result Deletes the present display data or the selected
display layer.

Close This Display Closes the selected display layer.

Close All Displays Closes all display layers.

Save Image As... Opens the Save Image As... dialog box used to

specify the file name of the graph image to save.
See Figure 1-7. Available data formats are the
BMP, EMF, GIF, and PNG

Page Setup... Opens the Page Setup dialog box used to set the
print page.
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Print Preview

Print...

Close

Main GUI
Data Display

Opens the Print Preview dialog box used to specify
Print Range/Data to print/Scaling of the graph
image to display. Clicking the Preview button
opens the Print preview window. See Figure 1-8.

» Print Range sets Whole Data Display window

or Graph Only.

» Datato print sets Current Data Display window
only or All Data Display windows now opened.

» Scaling sets Adjust To the specified percent of
the normal size or Fit To Page (automatic

adjustment).

Opens the Print dialog box used to specify Print
Range/Data to print/Scaling (see Print Preview) of
the graph image to print. See Figure 1-7. Clicking
the Next button opens another Print dial og box used
to select the printer, print range, and number of

copies, and start print.

Closes the Data Display window.

Save Image As... and Print...

€ BUT GummelPlot [() ; 9/3/2005 12:37:25 PM] - Agilent EasyEXPERT 2E
File Edit View Marker Cursor Line Window Help
B == mom [ T
Update Test Result zv E o B | T ?5
Save Image As...  Ctrl+S
(2005 12:37:25 P
Page Setup.
Print Preview N |Befsmotmns ‘
rint.... i1+ . oo [
Close 100 m
vl A
Ibase S Save Image As... B3]
’,/'/' Savein: [ My Documer ] «e@mckEy
o =Y EN eBool
D &
Print Recert |y prares
o s
Print Range
" Whole DataDisplay
@ Graph Only
Data to print
# Current Data Display
¢ All opened Data Display
Scaling =l Save
¢ AdjustTe: |80 8% Normal Size = Cercel_|

@ Fit To Page
¥ Keep Aspect Ratio

Next Cancel

bmp, emf, gif, or png format
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Figure 1-8

Edit menu

Main GUI
Data Display

Print Preview Example

|‘lL:‘ Print preview -
SO~ D6 EE B | cos| Page =

Print Preview

[~ Print Range
= Whole DataDisplay
" Graph Only

—Data to print

 Current Data Display
" All opened Data Display

~Scaling
i« Adjust To: M% Normal Size
" Fit To Page
¥ (Keep Aspect Rati

Preview Cancel l

Provides the following functions.

Copy

Copy Graph

Copy List

Copy Parameters
Graph Properties...

List Display Properties...

When the X-Y Graph Plot areais active, this
function copies the graph image as BMP and EMF
into the clipboard.

When the line cursor in the List Display areais
active, this function copies the datalist as CSV.

When the Parameters area is active, this function
copies the parameter dataas CSV.

Copies the graph image as BMP and EMF into the
clipboard.

Copiesthelist dataas CSV.

Copies the parameter data as CSV.

Opens “ Graph Properties (page 1-96)”.
Opens “List Display Properties (page 1-97)".
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Figure 1-9

Figure 1-10

Main GUI
Data Display

Figure 1-9 shows the graph copy and paste example. Click the X-Y Graph Plot area
on the Data Display window, select Edit > Copy menu, and paste it to WordPad. You

will see the result as shown in this example.

Graph Copy and Paste

€ BUT GummelPlot [(4) ; 9/3/2005 12:37:25 PM] - Agilent EasyEXPERT

File Edit View Marker Cursor Line Window Help

e one )& 3- @ 9 65|15 - BA~

This is an example of the graph copy and paste

Setup Name: [BJT Gummello! 005 12:37: B
) Document - WordPad == %]
[X-¥ Graph Piot File Edit View Inset Format Help
¥ Agilent - -
Ded SR A =B &
» Copy to Clipboard i i
100 m [l ~| i [l
K 7 T 7 T 3 B ' 7
Ibase -
(A)
» 100 m
decade
A Ibase
O |5 |
200m Vbase (V)
decade
[t Display L
Index Vbase Ibase Icollector
i 200, IA17 DA, 24,33 pA
2 210 mv -6. A 35.943 pA
3 220 my 49.149 pA R |~
200m Vbase (V) 100 m /div 1

Paste to WordPad

For Help, pressFi

HOM

Figure 1-10 shows the list copy and paste example. Click aline of the List Display
area on the Data Display window, select Edit > Copy menu, and paste it to Notepad.
You will seetheresult as shown in this example. The datain Notepad isa CSV data
(separated by acomma). Save it as atext file and open it by using a spreadsheet
software. Each data (comma separated value) will be entered to a separate cell.

List Copy and Paste
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View menu

Main GUI
Data Display

Provides the following functions.

X-Y Graph

List Displays
Parameters

Graph Legend ON/OFF

Line Information ON/OFF

Open Preview Window

Auto Scale

Run Time Auto Scale

Zoom In

Zoom Out

Cancel Scaling

Choose ActiveY Axis

Display Setup...

Displays or hides the X-Y Graph Plot area.
Displays or hidesthe List Display area.
Displays or hides the Parameters area.

Displays or hides the graph legend below the plot
area.

Displays or hides the line information (X-intercept,
Y-intercept, gradient) in the plot area.

Opens “ Preview (page 1-108)” and “Preview
Settings (page 1-110)".

Changes graph scale to fit the trace in the graph
automatically.

Enables or disables the run time auto scaling. This
function is set to independently for the X and Y
axes.

If this function is enabled, the graph scale will be
changed automatically to fit the trace in the graph
during the measurement.

Zooms the data graph in the cursor. If the cursor is
not displayed, zooms the data graph in the last
cursor position or the graph center. This enlarges
the trace in the graph.

Zoomsthe data graph out the cursor. If the cursor is
not displayed, zooms the data graph out the last
cursor position or the graph center. Thisreducesthe
tracein the graph.

Returnsto the initial graph scale. This Display
works only for the selected layer. All Displays
works for the all display layers.

Selects the Y-axis that is effective for the marker
control and the auto scale.

Opens “Display Setup (page 1-95)".

If multiple layers are opened on the Data Display window, the scale change is
applied to all layers. This means that the X-Y graph scale will be shared by all
display layers. The auto scaling is performed as follows.
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Marker menu

Cursor menu

Line menu

Main GUI
Data Display

1. Graph scaleis optimized for the data on the selected layer (top layer).

2. Thegraph scaleis applied to the graph in al layers.

Note that auto scaling is performed independently for the left and right Y axes.
Marker can move on the measurement data curve. The Marker menu provides the
following six functions.

Marker ON/OFF Enables or disables the marker.

I nter polation ON/OFF Enables or disables the interpolation function of
measurement data. You can read the interpolation
data between two actual measurement points.

Skip Moves the marker to the next measurement curve
that is added by the VAR2 variable.

Go ToMaximum Moves the marker to the maximum value point.

Go ToMinimum Moves the marker to the minimum value point.

GoTo.. Opensthe Direct Marker/Cursor dialog box used to

specify the coordinate values to move the marker.

Cursor can move anywhere on the graph. The Cursor menu provides the following
three functions.

Cursor ON/OFF Enables or disablesthe cursor.
GotoMarker Moves the cursor to the marker position.
Goto... Opensthe Direct Marker/Cursor dialog box used to

specify the coordinate values to move the cursor.

Provides the following five functions. When aline is enabled, gradient, X-intercept,
and Y-intercept are displayed in the graph. See Figure 1-11.

Line 1 ON/OFF Enables or disablesline 1.
Line 2 ON/OFF Enables or disablesline 2.
LineMode Selects the line mode: normal, gradient, tangent,

regression, or fix.

Adjust Gradient Available when agradient line is active. Checking
this function enables the rotary knob and the mouse
wheel to increase/decrease the gradient of the line.
Unchecking this function, clicking the rotary knob,
or clicking the mouse wheel disables this function.
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Figure1-11

Main GUI
Data Display

Gradient...

Opens the Gradient Value dialog box used to
specify the gradient value of the gradient line.

You can draw aline as shown below:

1. SetLinelorLine?2on.
2. Select aLine Mode.

Normal

Gradient

Tangent

Regression

Fix
Line Mode

Normal line

A line and two cursors appear. Move cursors to the points
where the line passes through.

A line and a cursor appear. Move cursor to the point where
the line passes through. Enable Adjust Gradient function,
then increase/decrease the gradient of the line by using the
rotary knob or the mouse wheel.

A line appears. Set the marker on. The tangent line appears
on the marker point.

A line and two cursors appear. Move cursors for specifying
the measurement data used for the regression calculation.
The calculation is executed by using the dataincluded in the
square drawn by the extended cross cursor lines. For the
subordinate sweep measurement data, specify the datacurve
by using the marker.

Fixesthe line on the graph.

Gradient line Tangent line Regression line

1 cursor marker 2 cursors
qradient data curve measured data

e
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Text menu

Main GUI
Data Display

Up to 20 texts can be added to a graph. The following functions are provided.

New Opens the text editor for adding a new text.
Hide All/ Show Al Hides or shows all texts.
Delete All Deletes dl texts.

Clicking on atext will select the text. To select multiple texts, click the texts while
holding down the Shift key on the keyboard.

The following functions are available for the selected text(s) via the Text menu, the
Text icons, or the right-click menu.

Edit Mode Edits the selected text.

Size Sets the font size of the selected text(s). The
available setting values are Largest, Large,
Medium, Small, Smallest, and Fixed Point (6, 7, 8,
9, 10, 11, 12, 14, 16, 18, or 20). For settings other
than Fixed Point, an appropriate size will
automatically be applied. For Fixed Point, the
specified font size will always be applied.

Font Sets the font of the selected text(s).

Text Color Sets the text color of the selected text(s). Click
Customize to open the color palette.

Background Color Sets the background color of the selected text(s).
Click Customize to open the color palette.

Hide Frame/Show Frame Hides or shows the frame for the selected text(s).
Delete Deletes the selected text(s).
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Main GUI

Data Display
Pointer menu Up to 30 pointers can be added to a graph. The following functions are provided.

New Thisfunction is enabled when the marker is ON.
Adds a new pointer at the position of the active
marker.

Hide All/ Show Al Hides or shows all pointers.

Show All Descriptions Shows all descriptions (pointer ID and X-Y
coordinate values) of the pointers.

Hide All Descriptions Hides all descriptions of the pointers.

Delete All Deletes al pointers.

Clicking on apointer will select the pointer. To select multiple pointers, click the
pointers while holding down the Shift key on the keyboard.

The following functions are available for the selected pointer(s) via the Pointer
menu, the Pointer icons, or the right-click menu.

Shape Sets the shape of the selected pointer(s).
Hide Description/Show
Description Hides or shows the description of the selected
pointer(s).

Delete Deletes the selected pointer(s).

Window menu Provides the three functions below. The functions work for opened windows.
Tiling Tilesall Data Display windows on the screen.
Sacking Stacks all Data Display windows on the screen.
Overlaying Overlays all Data Display windows on the screen.

Then the position, window size, and visibility of the
most front window are applied to all windows on
the screen. The background of the X-Y Graph area
is cleared except for the most back window.

Help menu Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.
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X-Y Graph

List Display,
Parameters

Main GUI
Data Display

Display Setup

This setup screen is displayed by selecting View > Display Setup..., and is used to
select the data displayed in the Data Display window.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8

axes can be set.
Name

Sharing

Scale
Min
Max
Add
Delete
Up

Down

Specifies the parameter for the axis.

Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (no grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale of the axis, Linear or Log

Minimum value of the axis

Maximum value of the axis

Adds a parameter (or axis).

Deletes the parameter selected with the radio button on the lft.
Moves the selected parameter upward.

Moves the selected parameter downward.

Selects the data displayed in the List Display area or the Parameters area. Up to 20
parameters can be set for each area.

parameter
Add
Delete
Up

Down

Specifies the parameter for the data output.

Adds arow for the parameter.

Deletes the parameter selected by the left radio button.
Moves the selected parameter upward.

Moves the selected parameter downward.
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Effective Area

Graph Color

Graph Trace Color

Log Scale

Text Size

Main GUI
Data Display

Graph Properties

This dialog box is opened by clicking the Properties... button in the X-Y Graph Plot
area or by selecting Edit > Graph Properties..., and is used to set the graph plot area.
Click the OK button to apply the setup and close this dialog box.

This area provides the following check box.

Logo ON Displaysthe Agilent logo at the upper |eft of the graph area.
Grid ON Displaysthe grid on the graph.

Setup Summary

ON Thisisvalid only for the I/V Sweep and Multi Channel I/V

Sweep classic tests. Displays the channel setup summary at the
bottom of the graph area. See“ Setup Summary” on page 1-101.

Thisareais used to set the color map for the graph plot area. You can change the
color of the background, text, graph grid, and line/cursor. The color paletteis
opened by clicking the pattern of the item.

Thisareais used to set visibility, color, and thickness of the datatracesY1to Y8
plotted on the graph. The color palette is opened by clicking the pattern of the item.

This areais used to set the maximum number of decades to show the minor ticks on
thelog axis. If the number of graph decadesis lessthan or equal to the entered
value, the minor ticks are displayed. If it is greater than the entered value, the minor
ticks are not displayed.

Thisareais used to set the font size for the graph. The available settings are Largest,
Large, Medium, Small, Smallest, and Fixed. For settings other than Fixed, the
appropriate size is automatically selected. For Fixed, afont size entry field is
provided, and the specified font sizeis always applied.

XIY AxisTitle Font size for the axistitle
Scale Font size for the X and Y coordinate values

Legend Font size for the graph legend
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Display

Number Format

Switch Display
Mode

Close All Displays
Show X-Y Graph
Show List Display

Show Parameters

Main GUI
Data Display

List Display Properties

Thisdialog box is opened by clicking the Properties... button in the List Display
area or by selecting Edit > List Display Properties..., and is used to set the data
display format in the List Display area. Click the OK button to apply the setup and
close this dialog box.

Check the following check box to add the data status or the physical unit to data.
Unchecking the box removesit.
Data Status Adds or removes the status code before data.

Physical Unit Adds or removes the physical unit after data.

Selects the data display format from the following formats.
» Engineering Format (Example: - 1. 2345 mA)
Data display with arithmetic point, SI prefix, and unit.
» Scientific Notation (Example: - 1. 23456789012345E- 003 A)

Data display with arithmetic point, exponential part (E, +/- sign, and three-digit
number), and unit.

Tool Bar

The Data Display window provides the 22 icons on the tool bar. You will seethe
following icons from left to right in the Data Display window.

Thisicon switches the display mode.

In Overwrite mode, the “Display Data (page 1-17)” function opens a new Data
Display window and displays data.

In Append mode, the “Display Data (page 1-17)” function creates a new display
layer on the present Data Display window and displays data.

Thisicon closes al display layers.
Thisicon displays or hides the X-Y Graph Plot area.
Thisicon displays or hides the List Display area.

Thisicon displays or hides the Parameters area.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 1-97



Auto Scale

Zoom In

Zoom Out

Display Setup...

Choose Active
Y-axis

Marker ON/OFF

Interpolation
ON/OFF

Marker Skip

Marker Maximum

Main GUI
Data Display

Thisicon will change the graph scale automatically to fit the trace in the graph.

Theright arrow button opens the menu for enabling or disabling the run time auto
scaling. Thisfunction is set independently for the X and Y axes. If thisfunctionis
enabled, the graph scale will be changed automatically to fit the trace in the graph
during the measurement.

If multiple layers are opened on the Data Display window, the scale change is
applied to all layers. This means that the X-Y graph scale will be shared by all
display layers. The auto scaling is performed as follows.

1. Graph scaleis optimized for the data on the selected layer (top layer).
2. Thegraph scaleis applied to the graph in all layers.

Note that the auto scaling is performed independently for the left and right Y axes
individually.

Thereisalso afunction for resetting the graph scale. Click View > Cancel Scaling >
This Display or All Displays. This Display will reset the selected layer only. All
Displayswill reset for the all display layers.

Thisicon zooms the data graph in the cursor. If the cursor is not displayed, zooms
the data graph in the last cursor position or the graph center. This enlarges the trace
in the graph.

Thisicon zooms the data graph out the cursor. If the cursor is not displayed, zooms
the data graph out the last cursor position or the graph center. This reduces the trace
in the graph.

Thisicon opens “Display Setup (page 1-95)”.

Thisicon selects the Y-axis that is effective for the marker control and the auto
scale.

Thisicon enables or disables the marker.

Thisicon enables or disables the interpolation function of measurement data. You
can read the interpolation data between two actual measurement points.

This icon moves the marker to the next measurement curve that is added by the
VAR2 variable.

This icon moves the marker to the maximum measurement point.
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Marker Minimum

Marker Search...

Line 1 State

Line 2 State

Cursor to Marker

Adjust Gradient

Show Graph
Legend

Show Line
Information

Main GUI
Data Display
This icon moves the marker to the minimum measurement point.

Thisicon opens the Direct Marker/Cursor dialog box used to specify the coordinate
values to move the marker.

Thisicon enables or disablesline 1 and its function: disabled, normal, gradient,
tangent, regression, or fix.

Thisicon enables or disablesline 2 and its function: disabled, normal, gradient,
tangent, regression, or fix.

This icon moves the cursor to the marker position.

Thisiconisavailable when aregression lineis active. Clicking thisicon enables the
rotary knob and the mouse wheel to increase/decrease the gradient of the line.
Clicking thisicon again, pressing the rotary knob, or pressing the mouse wheel
disables this function.

Thisicon displays or hides the graph legend below the plot area.

Thisicon displays or hides the line information (X-intercept, Y-intercept, gradient)
in the plot area.
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Main GUI
Data Display

Data Satus

If measurement module detects any status while measurement, the status codeis
recorded with the measurement data. And the status code will be displayed in the
Data Display window as shown in the following example.
Example e X-Y Graph Plot area
MARKER( 5.9000000 C 1.82520000 XV 3.33249E-3 )

Thislinewill be displayed at the top of the plot area when marker is ON. The
marker is used to read data of the marker point.

e ListDisplay area

| ndex Vi V2 12
123 5.9V C 1.8252 V XV 3.33249 nmA
Status Code SMU status code:

» C: Compliance

» T: Other channel compliance
* X: Oscillation

* V:Overflow

MFCMU status code:

e U: Unbalance

e D:I/V amp saturation

* V: Overflow
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VAR1 Channel

VAR2 Channel

Constant Channel

Main GUI
Data Display

Setup Summary

Thisfunction is effective for the I/V Sweep and Multi Channel I/V Sweep classic
tests. If the Setup Summary ON is set on the Graph Properties dialog box or the
Data Display Properties dialog box, the channel setup summary information shown
below is displayed at the bottom of the graph area.

The setup for one channel is displayed with one line asfollows. Where, theitemsin
{} arethe setting values.

For the voltage output channel:

{V Name}: [{Start}, {Stop}] V / {No of Step}; {I Name}: { Compliance} A; {Pwr Comp} W

For the current output channel:
{I Name}: [{Start}, { Stop}] A / {No of Step}; {V Name}: { Compliance} V; { Pwr Comp} W

Example: VDS: [0, 10] V/ 101; ID. 1 A, 1 W
For the voltage output channel:
{V Name}: [{Start}, {Stop}] V / {Step} V; {I Name}: { Compliance} A; { Pwr Comp} W

For the current output channel:
{I Name}: [{Start}, {Stop}] A / {Step} A; {V Name}: { Compliance} V; { Pwr Comp} W

Example: VGS: [0, 5] V/ 1V, ID 1 mA 1 nW
For the voltage output channel:
{V Name}: { Source} V; {I Name}: { Compliance} A

For the current output channel:
{1 Name}: {Source} A; {V Name}: { Compliance} V

For the common channel:
{V Name}: COMMON

Example: VSUB: -1 V; I1SUB: 1 nA
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Main GUI
Data Display

Miscellaneous Oper ations

The following user interfaces provide several miscellaneous functions when you
operate the Data Display window.

*  “Mouse/Touch Panel”
* “Rotary Knob”

s “Softkeys’

»  “Keyboard’

M ouse/Touch Panel

While the Data Display window is focused, the mouse/touch panel operations
shown in Table 1-11 (p. 1-106) are available.

Rotary Knob
The following miscellaneous functions are available by using the rotary knob.

e Marker movement in the VARL direction

While the Data Display window is focused and the marker is displayed on the
graph, the rotary knob can be used to move the marker. Rotating the knob fast
increases the marker speed.

* Marker movement in the VAR2 direction
Clicking the knob moves the marker in the VAR2 direction.
e Slope adjustment of the gradient line

In the slope adjustment mode (Line > Adjust Gradient) for the gradient line, the
rotary knob can be used to adjust the slope. Clicking the knob quits this mode.

e Pointer movement in the VARL direction
Therotary knob can be used to move the selected pointer. The pointer can not be
moved in the VAR2 direction.

Softkeys

The softkeys can be used for setting the following fields on the Display Setup (p.
1-95) window.

» Name (parameter name)

» Scae(Linear or Log)
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Table 1-6

Keyboard

Main GUI
Data Display

While the Data Display window is focused, the key operations shown in Table 1-6

are available.

Miscellaneous K ey Operations on Data Display Window

Key Description
F1 Displaysthe online help
F2 Shortcut to View > X-Y Graph
F3 Shortcut to View > List Display
F4 Shortcut to View > Parameters
F12 Changes the display mode, Append — Overwrite — Append
Ctrl+W Shortcut to File > Close This Display
Ctrl+Shift+W | Shortcut to File > Close All Displays
Ctrl+S Shortcut to File > Save Image As...
Ctrl+P Shortcut to File > Print...
Ctrl+C Shortcut to Edit > Copy

While the X-Y Graph (graph display area) is focused, the key operations shownin
the following tables are available.

» Table1-7, “Controlling X-Y Graph.”
» Table1-8, “Controlling Marker.”

» Table1-9, “Controlling Cursor.”

e Table1-10, “Controlling Line.”
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Table 1-7

Table 1-8

Main GUI
Data Display

Controlling X-Y Graph

Key Description
S Shortcut to View > Auto Scale
z Shortcut to View > Zoom In
Shift+Z Shortcut to View > Zoom Out
Ctrl+z Shortcut to View > Cancel Scaling
Y Changesthe activedata, Y1 > Y2 —> ... > Y8—> Y1
R Activatestheright Y axis and changes the data set to the axis,
Y2-5Y3—>5..5Y8>Y2
W Shortcut to View > Graph Legend ON/OFF
K Shortcut to View > Line Information ON/OFF

Controlling Marker

Key Description

M Shortcut to Marker > Marker ON/OFF

I Shortcut to Marker > Interpolation ON/OFF

F Moves the marker +1 2in the VAR1 direction
Shift+F Moves the marker +10 2in the VAR1 direction

B Moves the marker - 1 2in the VAR1 direction
Shift+B Moves the marker - 10 2in the VAR1 direction

P Moves the marker +1 2in the VAR direction
Shift+p Moves the marker - 1 2in the VAR2 direction

J Shortcut to Marker > Go To...

X Shortcut to Marker > Go To Maximum

N Shortcut to Marker > Go To Minimum

a. Multiply 1/10if the interpolation is ON.
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Main GUI

Data Display
Table 1-9 Controlling Cursor
Key Description
C Shortcut to Cursor > Cursor ON/OFF
T Shortcut to Cursor > Go To Marker
) Movesthe cursor +1/1000 in the Y axis direction
Shift+ T Moves the cursor +1/100 in the Y axis direction
- Moves the cursor +1/1000 in the X axis direction
Shift+ — Movesthe cursor +1/100 in the X axis direction
\2 Moves the cursor - 1/1000 in the Y axis direction
Shift+ Movesthe cursor - /100 in the Y axis direction
“— Movesthe cursor - 1/1000 in the X axis direction
Shift+ « Moves the cursor - /100 in the X axis direction
Table 1-10 Controlling Line
Key Description
12 Shortcut to Line> Line 1 ON/OFF
oa Shortcut to Line > Line 2 ON/OFF
\% Changesthe activeling, Linel — Line2 — Line 1
(availableif both line 1 and line 2 are ON)
L Changes the line mode of the active line,
Normal — Gradient — Tangent — Regression — Normal
G Shortcut to Line > Adjust Gradient

a. 1 and 2 on the numeric pad cannot be used.
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Main GUI

Data Display
Table 1-11 Mouse/Touch Panel Operations on Data Display Window
L ocation Operation Description
X-Y Graph clickingontheleft | Activatesthe Y1 data

Y axis

clicking on the
right Y axis

Activatesthe data of theright Y axis, or changesthe active data
if itisaready active.

clicking on a plot

Moves the marker to the position of the mouse pointer if the
marker is displayed on the graph.

clicking on a cursor

Specifies the active cursor if multiple cursors are displayed.

dragging a cursor

Moves the cursor.

clicking on aline

Specifies the active line if multiple lines are displayed.

clicking on atext

Selects the text.

Clicking with pressing the Shift key on the keyboard selects
multiple texts.

dragging atext

Moves the text.

clickingon a Selects the pointer.

pointer Clicking with pressing the Shift key on the keyboard selects
multiple pointers.

clickingon a Selects the description of pointer.

description of Clicking with pressing the Shift key on the key board selects

pointer ) o .
multiple descriptions of pointers.

dragging a Moves the description of pointer.

description of

pointer

rotating the mouse
wheel

Moves the marker if the marker is displayed on the graph,
moves the pointer if the pointer is selected, or adjusts the slope
of the gradient lineif it isin the slope adjustment mode (Line >
Adjust Gradient).
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Main GUI
Data Display

L ocation Operation Description

X-Y Graph clicking the mouse | Same as clicking the rotary knob.

wheel Thisiseffective if the mouse properties assign the center button
functions to the wheel button.

List Display dragging acolumn | Moves the column.
heading
dragging boundary | Changes the width of the column.
of the column
clickingonarowin | Movesthe marker to the corresponding position.
the table
moving the scroll Changes the data displayed in the List Display area.
bar Scroll is effective for both portrait and landscape.
rotating the mouse | Changes the data displayed in the List Display area.
wheel

Others Specifies the display layer for the data display and analysis.

clicking on atab?
under the tool bar

double clicking on

Changes the status of the pin marked to the display layer.

ata}bs under the Standing pin must be marked to the display layer to be kept.
tool bar
Laid pin is marked to the display layer under the automatic
delete.
dragging boundary | Adjuststhe size of the display area (X-Y Graph, List Display,
of the display area | Parameters) without changing the window size.

dragging the frame
of the Data Display
window

Changes the window size with adjusting the size of the display
area (X-Y Graph, List Display, Parameters).

a. Tabisdisplayed if the display mode is Append and the test result record contains the append
measurement data
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Setup Name
X-Y Graph Plot
Parameters
List Display

File menu

Main GUI
Preview

Preview

The Preview window and the Preview Settings dialog box are opened by selecting
View > Open Preview Window in the Data Display window. The Preview Settings
dialog box isused to set the graph title, X axistitle, Y axistitle, and line style. And
the Preview window displays a new plot, and is used to output it to the specified
printer.

The Data Display window cannot do the above settings and display the new plot.
* “Preview Window GUI”
*  “Preview Settings’

Preview Window GUI

The Preview window provides the following GUI.

Thisfield just displays the name of the test setup used to get this test record.

This area displays the measurement result graph, traces, marker, cursor, and lines.
This area lists the user-defined output parameters if the output parameters are set.
This area displays the measurement result data list.

Provides the following functions. See also Figure 1-7 and Figure 1-8.
Page Setup... Opens adialog box used to set the print page.

Print Preview Opens a dialog box used to specify the data graphs
to make previews. After selecting the graphs,
previews appear on the Print preview window.

Print... Opens adialog box used to specify the print target.
After selecting the target, the Print dialog box is
opened. The dialog box is used to start print.

Close Preview Window Closes the Preview window.
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Edit menu

View menu

Help menu

Main GUI
Preview

Provides the following functions. See also Figure 1-9 and Figure 1-10.

Copy While the X-Y Graph Plot areaiis active, this
function copies the graph image as BMP and EMF
into the clipboard.

While theline cursor inthe List Display areais
active, this function copies the data list as CSV.

While the Parameters areais active, this function
copies the parameter data as CSV.

Copy Graph Copies the graph image as BMP and EMF into the
clipboard.

Copy List Copiesthelist dataas CSV.

Copy Parameters Copies the parameter data as CSV.

Provides the following functions.

X-Y Graph Displays or hidesthe X-Y Graph Plot area.
List Displays Displays or hides the List Display area.
Parameters Displays or hides the Parameters area.
Preview Settings... Opens “ Preview Settings (page 1-110)".

Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.
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General

X/Y Axis Title

Line Style

Color and
Thickness...

OK
Cancel
Apply

Reset

Main GUI
Preview

Preview Settings
The Preview Settings dialog box provides the following GUI.

Definesthe graph title in the Graph Title field. Thetitle will appear at the bottom of
the plot area.

Definesthe X axistitleinthe X field and the Y axistitleintheY field, Y1to Y8.
Thetitle will appear near the axis.

Selectsthe line style for theline 1, line 2, and trace Y1to Y 8.

Opens the Color and Thickness dialog box that provides the same GUI as “Graph
Properties (page 1-96)".

Applies the setup to the Preview window, and closes this dialog box.
Cancels the setup, and closes this dialog box.
Applies the setup to the Preview window.

Clears the setup and returns to the default setting.
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Reset
OK
Cancel

Miscellaneous,
Save As

Miscellaneous,
Quotation

Identification
section

Table1-12

Main GUI
Text File Export settings

Text File Export settings

This dialog box is opened by clicking Results > Transport Data > Text File Export
Settings... or the Settings button on the Test Results Data Folder Export dialog box
or the Test Results Data Auto Export dialog box. This dialog box is used to define
the style of the test record exported by the Export As Text File function.

Appliesthe default value to the all setup items.
Defines and memorizes the present setting, and closes this dialog box.
Cancels and clears the setting changes, and closes this dialog box.

Specifies the delimiter (data separator) and file extension. CSV (comma separated,
.csv, default), Text (tab separated, .txt), or Formatted Text (space separated, .prn).

Specifies the quotation for the string values. Single (single quotes), Double (double
guotes), or None (no quote, default). Even if None is specified, the string which
contains delimiter and/or new line character will be double quoted.

Record items which are used to identify and characterize the test record. They area
sub set of the meta data, test type, and test name. See Table 1-13 for the definition of
the record items. Check the box for the items you want to record, and uncheck the
box for the items you do not want to record. In the default, all items are checked.

The pull-down menu specifies the action for recording the itemsin the | dentification
section. See Table 1-12 to specify the action.

Actionsfor Identification and Setup Data Items

Action Description

Save with measurement data | The checked items are recorded in the test record
with the measurement data. Default.

Do not save No item isrecorded even if any box is checked.

Save as separate file The checked items are recorded in a separatefile.
The name will be the test record’s file name plus
- s before the extension.
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Table 1-13

Main GUI
Text File Export settings

Identification Section Record Items

Item Description

Setup title | Test setup name

Classictest | Classic test name. I/V Sweep, Multi Channel I/V Sweep, 1/V-t
name Sampling, C-V Sweep, SPGU Control, Switching Matrix Control,
or Direct Control. Thisrecord item is exclusive against the
“Application test name” record item.

Application | Application test name. Thisrecord item is exclusive against the
test name “Classic test name” record item.

Test date Test execution date corresponding to the date part of the
RecordTime meta data.

Test time Test execution time corresponding to the time part of the
RecordTime meta data.

DevicelD Device ID corresponding to the TestTarget meta data.

Count Test count corresponding to the Iterationlndex meta data.
Flags Flags set to the test result data, corresponding to the Flag meta
data.

Remarks Remarks set to the test result data, corresponding to the Remarks
meta data.

Setup data section Record itemswhich describesthe test conditions. They are the test parameters, DUT

parameters, and analysis setup. See Table 1-16 for the definition of the record items.
Check the box for the items you want to record, and uncheck the box for the items
you do not want to record.

Tag information for the setup datais string value; TestParameter, DutParameter, or
AnalysisSetup, which means the type of data put in the same row in the exported
test record. If Tag information box is unchecked (default), the tag information is not
recorded. Then, the setup parameter names, such as Channel.Unit, are recorded in
the first column in the test record and the parameter values are recorded in the
following columns. If the Tag information box is checked, the tag information is
recorded in the first column and the parameter names and values are shifted to the
next columns.

The pull-down menu specifies the action for recording the items in the Setup data
section. See Table 1-12 to specify the action.

1-112 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



Main GUI
Text File Export settings

Measurement data Record items of the measurement data. It may contain the measurement parameter

section

Table1-14

Table 1-15

names, data units, and data size. See Table 1-17 for the definition of the record
items. Check the box for the items you want to record, and uncheck the box for the
items you do not want to record.

Tag information for the measurement data s string value; Dimensionl, Dimension2,
Data Name, Data Unit, or Data Value, which means the type of data put in the same
row (in case of By Row orientation) or column (in case of By Column orientation)
in the exported test record. The tag information will be recorded in the test record if
the Tag information box is checked.

See Table 1-14 for the By Row orientation. All data relative to a measurement
parameter will be put in the same column. The first column (ex. column A) contains
the tag information. For the By Column orientation, see Table 1-15. All datarelative
to a measurement parameter will be put in the same row. And the first row (ex. row
1) contains the tag information. If the Tag information box is unchecked (default),
the tag information is not recorded and the measurement data is shifted.

By Row Orientation Export Example

A B C D E F
1 Dimensionl | 101 101 101 1
2 Dimension2 | 1 1 1 1
3 Data Name Vg Id Gm Vth
4 Data Unit \Y A S \%
5 Data Value 0 4.55E-09 1.24E-10 1.23
6 | DataVaue 0.02 8.59E-09 5.25E-10

By Column Orientation Export Example

A B C D E F
Dimensionl | Dimension2 | DataName Data Unit Data Value Data Value
101 1 Vg \% 0 0.02
101 1 Id A 4.55E-09 8.59E-09
101 1 Gm S 1.24E-10 5.25E-10
1 1 Vth \% 1.23
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Table 1-16

Table1-17

Main GUI

Text File Export settings

Setup Data Section Record Items (ON: checked, OFF: unchecked)

Item Description Default
Test parameters | Test parameters defined by the classic test or the ON
application test.
DUT parameters | DUT parameters defined by the application test. ON
Analysis setup Data Display setup status at and after the OFF
measurement, such as Graph configuration, Graph
format, Graph text, Marker configuration, Cursor
configuration, Line configurations, Pointer
configuration, List configuration, and Scalar list
configuration.
Measurement Data Section Record Items (ON: checked, OFF: unchecked)
Item Description Default
Datanames | Measurement parameter name. ON
Dataunits | Unit of measurement data. OFF
Size Dimensionl (VAR1 size) and Dimension2 (VAR?2 size) OFF
of the measurement data.
Datavalues | Record items can be specified by the following segments.
Segment Default
Data assigned to X-Y Graph ON
Data assigned to List Display ON
Data assigned to Parameter Display ON
User function defined but not displayed OFF
Analysis function defined but not displayed OFF
Any datareferred to by the user function but not OFF
directly displayed
Any datareferred to by the analysis function but not OFF
directly displayed
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Classic Test Definition

This chapter provides the reference information of the classic test setup GUI of
Agilent EasyEXPERT software.

“I/V Sweep”

“Multi Channel I/V Sweep”

“I/V List Sweep”

“1/V-t Sampling”

“C-V Sweep”

“Direct Control”

“Function Setup”

“Auto Analysis Setup”

“Display Setup”

“SMU Range Setup Window”

“ADC and Integration Time Setup Window”
“Pulse Setup Window”

“Advanced Setup Window”

“Range Setup Window”

“Advanced Setup Window for C-V Sweep”
“Switching Matrix Control”

“SPGU Control”

“SPGU Pulse Setup Window”

“Load Z Setup Window”

“Pulse Switch Setup Window”
“SPGU ALWG Setup Window”
“Define ALWG Waveform Window”

2-2
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NOTE

Classic Test Definition

To perform measurement, see “Main Screen” on page 1-11.

To display measurement data and perform dataanalysis, see “ Data Display” on page
1-84.

To perform self-test or diagnosis, see “ Configuration” on page 1-64.
To perform self-calibration, see “ Calibration” on page 1-58.

If You Use GNDU (Ground Unit)

Keep to the following rule to use the ground unit.

1. Set Modeto COMMON.

2. Set Function to CONST.

3. Do not use the | Name assigned to the ground unit.

Missing any one will cause an execution error.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
I/V Sweep

1/V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V
Sweep icon. The main screen displaysthe 1/V sweep test setup screen. For the
measurement mode, see “1/V Sweep Measurement” on page 4-3.

Used to set the name of test setup. The name must be the identification for the test

setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-5.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-6.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “Display Setup” on page 2-46.
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Channel Definition

Miscellaneous
Variables

Classic Test Definition
I/V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit M easurement resource used for the source output or
measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode Output mode. For SMU, V (voltage), | (current), VPULSE

(voltage pulse), IPUL SE (current pulse), or COMMON
(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), VARL' (synchronous sweep), or CONST (constant)

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
left radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the dataindex. Integer above O is returned.
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VAR1

Classic Test Definition

I/V Sweep

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Unit SMU used for the VARL1 output

Name Variable name for the VAR output data

Direction Sweep direction, single (start to stop) or double (start to stop to
start)

Linear/Log Sweep output, LINEAR, LOG10, LOG25, or LOG50. where
the number following LOG means the number of sweep points
in one decade.

Sart Sweep start value

Sop Sweep stop value

Sep Incremental step value of the sweep output

No of Sep Number of steps. The value is automatically calculated by using
the start, stop, and step values.

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF
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VAR2

VARY’

Timing

Classic Test Definition
I/V Sweep

This area defines the secondary sweep source output.

Unit
Name
Sart
Sop

Step
No of Sep

Compliance

Pwr Comp

SMU used for the VAR2 output
Variable name for the VAR2 output data
Sweep start value

Sweep stop value. The value is automatically calculated by
using the start, step, and number of step values.

Incremental step value of the sweep output
Number of sweep steps

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the synchronous sweep source output. The VAR’ output is given
by the following formula.

VARY' output = Offset + Ratio x VARL output

Unit

Name
Offset
Ratio

Compliance

Pwr Comp

SMU used for the VARL' output
Variable name for the VARL' output data
Offset value

Ratio value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 4-67.

Hold

Delay

Hold time. Thisisthe time from beginning of channel output to
beginning of delay time. 0to 655.35 s, 10 ms resolution.

Delay time. Thisisthe time from end of hold time to beginning
of measurement. The measurement channels start measurement
as soon as the wait time elapses. 0t0 65.535 s, 0.1 ms
resolution.
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Constant

SMU Pulse

Sweep status

Range

ADCl/Integ

Advanced

SPGU Pulse/
ALWG Setup

Classic Test Definition
I/V Sweep

This area defines the constant output source.

Unit SMU used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data

Mode Output mode, V (voltage), | (current), VPUL SE (voltage pulse),
or IPULSE (current pulse)

Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

This area defines the SMU pul se setup parameters. See “SMU Pulse” on page 4-62.

Unit SMU used for the pulse output

Period Pulse period. Entering AUTO sets the optimum value
automatically.

Width Pulse width

Base Pulse base value

Thisfield specifies the sweep abort condition. See “ Sweep Abort Function” on page
4-37.

This button opens awindow used to set the measurement ranging operation. See
“SMU Range Setup Window” on page 2-48.

This button opens awindow used to set the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow used to set the other functions of the measurement
channel. See “ Advanced Setup Window” on page 2-53.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 2-63 or “SPGU ALWG Setup Window” on page 2-67.

2-8 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
Multi Channel I/V Sweep

Multi Channel I/V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the Multi
Channel 1/V Sweep icon. The main screen displays the Multi Channel 1/V Sweep
test setup screen. For the measurement mode, see “Multi Channel 1/V Sweep
Measurement” on page 4-12.

Sets the name of the test setup. The nameis used to identify the test setup saved to a
My Favorite group (preset group). Enter a unique name that is distinct from other
setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-10.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-11.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “ Display Setup” on page 2-46.

Setting of the Display Setup is applied to the X-Y Graph on the Data Display
window. And the X-Y Graph can handle one X datafor the X axisand the maximum
eight Y datafor the Y axis.

Definethe X axis carefully to plot the Multi Channel 1/V Sweep measurement result
which may have the data measured by the multiple VAR1 channels. Because the
result may also contain the multiple X data which can be the selections of the X
axis.

The Display Setup must be set properly to match the X axis data and the X data of
the plot you look at.
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Channel Definition

Miscellaneous

Variables

Classic Test Definition
Multi Channel I/V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Measurement resource used for the source output or
measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode Output mode. For SMU, V (voltage), | (current), VPULSE

(voltage pulse), IPUL SE (current pulse), or COMMON
(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), or CONST (constant)

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes selected channel setup. To select achannel, use the
radio button on the left.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the

opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name

Index Name

Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Variable name of the dataindex. Integer above O is returned.
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VAR1

Constants

VAR2

Classic Test Definition
Multi Channel I/V Sweep

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Direction

Linear/Log

No of Sep
Unit
Name
Sart

Sop

Compliance

Pwr Comp

Sweep direction, single (start to stop) or double (start to stop to
start)

Sweep output, LINEAR, LOG10, LOG25, or LOG50 where the
number following LOG indicates the number of sweep pointsin
one decade.

Number of sweep steps

SMU used for the VAR output
Variable name for the VARL1 output data
Sweep start value

Sweep stop value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the constant output source.

Unit

V Name

| Name

Mode
Sour ce

Compliance

SMU used for the constant source

Variable name for the constant voltage output or measurement
data

Variable name for the constant current output or measurement
data

Output mode, V (voltage) or | (current)
Output value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

This area defines the secondary sweep source output.

Unit

SMU used for the VAR2 output
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Timing

Sweep status

Range

ADCl/Integ

Pulse

Advanced

SPGU Pulse/
ALWG Setup

Classic Test Definition
Multi Channel I/V Sweep

Name Variable name for the VAR2 output data

Sart Sweep start value

Sop Sweep stop value. The value is automatically calculated from
the start, step, and number of step values.

Sep Incremental step value for the sweep output

No of Step Number of sweep steps

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 4-67.

Hold Hold time. Thisis the time between the beginning of channel
output and the beginning of delay time. 0 to 655.35 s, 10 ms
resolution.

Delay Delay time. Thisis the time between the end of the hold time

and the beginning of measurement. The measurement channels
start measurement as soon as the wait time elapses. 0 to 65.535
s, 0.1 msresolution.

Thisfield specifies the sweep abort condition. See “ Sweep Abort Function” on page
4-37.

This button opens awindow for setting measurement ranging operation. See “ SMU
Range Setup Window” on page 2-48.

This button opens awindow for setting the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow for setting the SMU pulse output. See * Pulse Setup
Window” on page 2-51.

This button opens awindow for setting other functions of the measurement channel.
See “Advanced Setup Window” on page 2-53.

This button opens awindow used to set the SPGU output. See “SPGU Pulse Setup
Window” on page 2-63 or “SPGU ALWG Setup Window” on page 2-67.

2-12 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
I/V List Sweep

I/V List Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V
Sweep icon. The main screen displaysthe I/V List sweep test setup screen.

I/V List Sweep measurement issimilar to 1/V Sweep measurement described in“1/V
Sweep Measurement” on page 4-3.

Changes from the I/V Sweep are listed bel ow.

*  VARL/VAR2 step output values are set by using a vector data. Vector data from
aspreadsheet software, either tab separated or comma separated can be copied to
the Define vector data dialog box via the Windows clipboard. See “Define
vector data’ on page 2-18.

* All SMU instaled in the B1500 can be set to VARL.
*  VARZY’ isnot supported.
Sets the name of the test setup. The nameis used to identify the test setup saved to a

My Favorite group (preset group). Enter a unique name that is distinct from other
setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-5.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-6.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 2-46.
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Channel Definition

Classic Test Definition

I/V List Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, the measurement data, the time stamp data, and the index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit

V Name
| Name
Mode

Function

Add SMU
Add SPGU
Delete

Up

Down

Measurement resource used for the source output or
measurement

Variable name of voltage output or measurement data
Variable name of current output or measurement data

Output mode. For SMU, V (voltage), | (current), VPULSE
(voltage pulse), IPUL SE (current pulse), or COMMON
(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), or CONST (constant).

If aSMU is set to Mode=VPULSE or IPULSE:

¢ Number of VAR1 channels must be one or two.

* |f aVAR1 channel is set to Mode=VPUL SE, the other
VAR1 channel must be Mode=V.

¢ |f aVAR1 channdl is set to Mode=IPUL SE, the other VAR1
channel must be Mode=I.

Adds arow for the SMU channel setup.
Adds arow for the SPGU channel setup.

Deletes the selected channel setup. To select a channel setup,
use the radio button on the left.

Moves the selected channel setup upward.
Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the

opposite order.
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Miscellaneous
Variables

VAR1

NOTE

Classic Test Definition
I/V List Sweep

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Index Name Variable name of the dataindex. Integer above O is returned.

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Unit SMU used for the VAR1 output

Source Click the grid button to open the Define vector data dialog box.
See “Define vector data’ on page 2-18.

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF

To define VARL/VAR2 step outputs

To define these parameters, create a vector data by using the Define vector data
dialog box which is opened by clicking the grid button in the vector data entry field.
See Figure 2-1.

Available array size for the vector datais as follows (column x row).

*  VARL1 step output value: Nq = 1 x 1001 maximum (initial setting: 1 x 1)
* VAR step output value: N5 = 1 x 1001 maximum (initial setting: 1 x 1)
» Deélay time: N3 =1 x 1001 maximum (initial setting: 1 x 1)

Then, the following formula must be satisfied.

1<NjxN,<128128
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VAR2

Timing

SMU Pulse

Classic Test Definition

I/V List Sweep

This area defines the secondary sweep source output.

Unit
Name

Sour ce

Compliance

Pwr Comp

SMU used for the VAR2 output
Variable name for the VAR2 output data

Click the grid button to open the Define vector data dialog box.
See “Define vector data’ on page 2-18.

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 4-67.

Hold

Delay

Hold time. Thisis the time from the beginning of channel
output to the beginning of delay time. 0to 655.35 s, 10 ms
resolution.

Delay time. Thisis the time between end of step changing and
the beginning of measurement. For thefirst step, thisisthetime
between the end of hold time and the beginning of
measurement. The measurement channels start measurement as
soon as the wait time elapses. 0t0 65.535 s, 0.1 ms
resolution.Click the grid button to open the Define vector data
dialog box. See " Define vector data’ on page 2-18.

This area defines the SMU pulse setup parameters. See “SMU Pulse” on page 4-62.

Unit SMU used for the pulse output

Period Pulse period. Cannot set this value. SMU applies the pul se after
the delay time immediately.

Width Pulse width

Base Pulse base value
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Constant

Sweep status

Range

ADClInteg

Advanced

SPGU Pulse /
ALWG Setup

Classic Test Definition

I/V List Sweep

This area defines the constant output source.

Unit SMU used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data

Mode Output mode, V (voltage), | (current), VPUL SE (voltage pulse),
or IPULSE (current pulse)

Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

Thisfield specifies the sweep abort condition. See “ Sweep Abort Function” on page
4-37.

This button opens awindow for setting the measurement ranging operation. See
“SMU Range Setup Window” on page 2-48.

This button opens awindow for setting the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow for setting other functions of the measurement channel.
See “Advanced Setup Window” on page 2-53.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 2-63 or “SPGU ALWG Setup Window” on page 2-67.
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Figure 2-1

NOTE

Classic Test Definition
I/V List Sweep

Define vector data

Thisdialog box is opened by clicking the grid button in the vector data entry field.
See Figure 2-1. The vector data entry field can be displayed on the followings.

» Application test setup screen which contains the entry field for a vector type test
parameter, on the EasyEXPERT main screen or the Test Definition window

» Test Specification setup screen which contai nsthe definition of avector type test
parameter, on the Test Definition window

» Define symbols dialog box for avector type test parameter

The Define vector data dialog box displays the array defined by using the Define
dimensions dialog box opened from the Test Specification setup screen. Figure 2-1
shows the array created by setting Dim1Min=1, Dim1Max=11, Dim2Min=1, and
Dim2Max=3, where Dim1 is the vertical direction (row) and Dim2 is the horizontal
direction (columns). The array index always starts from 1.

Vector Data Entry Field

B1500A Semiconductor Device Analyzet

=
T

ile  DiataDisplay  Help

Category Q”sample test parameter setup Setup Name: [sample test parameter setup i
[ BT _=||pevice Parameters

7 cMos
[ Discrete

WEeme Vector data entry field

(] Memary

] Miecisignal Grid button
\ /

I NaroTech =]
Library vl Testparar\etgrs / Define vectar data

“
Trng Vth
Ia ]

Paraml:

tost Param2: [0 8
@ Param3: [BMULHP =

sample test

PRt Paramd: [sample =

| Quick Test | lassic Test | Application Test

b—“b—‘ ‘
= e e - AR N

Define vector data

e

Rotary knob and mouse wheel can be used to change the numeric valuein the
highlighted cell.

To delete column/row, highlight the line and press the Delete key.

2-18 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



OK button

Cancel button

File menu

Edit menu

Mouse menu 1

Mouse menu 2

Classic Test Definition
I/V List Sweep
The Define vector data dialog box provides the following GUI.
Saves the vector data displayed on the dialog box and closes the dialog box.
Displays a confirmation message and closes the dial og box. Vector datais not saved.

Provides the following function.

Exit Displays a confirmation message and closes the dialog box.
Vector datais not saved.

Provides the following four functions.

Copy Copies the highlighted item to the clipboard.

Paste Pastes the data in the clipboard to the specified | ocation.
Delete Deletes the highlighted item.

Select All Selects and highlights all cellsin the array.

The following menus are displayed when the right mouse button is clicked on acell.

Cut Moves the highlighted characters to the clipboard.
Copy Copies the highlighted characters to the clipboard.
Paste Pastes the data in the clipboard to the specified | ocation.

The following menus are displayed when the right mouse button is clicked on the
array display area.

Copy Copies the highlighted item to the clipboard.

Paste Pastes the data in the clipboard to the specified | ocation.

Insert Inserts arow before the selected row. Available when the row
header provides the * button and arow header is selected.

Delete Deletes the highlighted item.

Select All Selects and highlights all cellsin the array.
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To import vector
data

To export vector
data

Classic Test Definition
I/V List Sweep

The Define vector datadialog box can import comma separated data (each data must
be separated by acomma, and have a CR/LF or LF at the end of each line) and tab
separated data (each data must be separated by atab, and have aCR/LF or LF at the
end of each line). The procedure for importing vector datais as follows.

1
2.
3.

Open a vector datawith Notepad.
Copy the datain Notepad.

On the Define vector data dialog box, click acell to be used asthe top left corner
of the imported vector data.

Right click on the corner box between the column header and the row header,
and select Paste.

Thus, the Define vector data dialog box can read vector data created on a
spreadsheet software.

The Define vector data dialog box can export vector datain tab separated format.
The procedure for exporting vector datais asfollows.

1.
2.
3.
4.

Highlight a vector data on the Define vector data dialog box.
Select Copy from the Edit menu or the mouse menu 2.
Create anew file in Notepad, and paste the vector data.
Savethe dataas afile.

The data can then be read by opening the file with a spreadsheet software.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
I/V-t Sampling

|/V-t Sampling

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V-t
Sampling icon. The main screen displays the I/V-t sampling test setup screen. For
details of the measurement mode, see “1/V-t Sampling Measurement” on page 4-13.

Used to set the name of test setup. The name must be the identification for the test
setup saved to a My Favorite group (preset group). Enter a unique name that is
digtinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-22.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-23.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “ Display Setup” on page 2-46.

If you set Interval < 0.002 s

Sampling mode must be linear. This setting is not permitted for the log sampling.
Also SPGU is not available.

The following conditions are automatically set to the all measurement channels.
And the all channels start measurement simultaneously. After the measurement,
they are returned to the previous conditions automatically.

e High speed A/D converter (ADC)
e Minimum measurement range that covers compliance value, fixed ranging

If the measurement time is expected to be longer than interval, the measurement
channels automatically adjust the number of averaging samples (ADC settings) to
keep the sampling interval. After the measurement, it is returned to the previous
setting automatically.
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Channel Definition

NOTE

Miscellaneous
Variables

Classic Test Definition
I/V-t Sampling

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

UHCU and HVMCU cannot be used.

Unit Measurement resource used for the source output or
measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode Output mode. For SMU, V (voltage), | (current), or COMMON

(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
|eft radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order. However, if the Output Sequenceis SIMULTANEOUS, the channels
start and stop output simultaneoudly.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the data index. Integer above O is returned.
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Sampling
Parameter

Classic Test Definition
I/V-t Sampling

M easurement Setup

This setup screen is used to set the sampling timing parameters, constant
voltage/current outputs, and so on.

This area defines the sampling timing parameters.

Linear/Log

Interval

No of Samples

Total Sampling
Time

Output Sequence

Hold Time

Sampling mode. LINEAR for linear sampling. LOG10,
LOG25, LOG50, LOG100, LOG250, or LOG500 for
logarithmic sampling.

For the logarithmic sampling, the number after LOG indicates
the number of measurement datain a decade. For example,
LOG10 mode is used to get 10 data/decade.

Interval of the sampling, in seconds. 0.002 to 65.535 s, 0.001 s
resolution.

Interval < 0.002 sin 0.00001 s resolution is aso available for
the linear sampling. It must satisfy the following formula. See
NOTE on page 2-21.

Interval > 0.0001 + 0.00002 x (number of measurement
channels- 1)

Number of samples. Integer. 1 to the following value.
For linear: 100001 / (number of measurement channels)

For logarithmic: 1 + (number of datafor 11 decades)

Thisfield just displays the total sampling time that isthe time
from the measurement start time for the first point to the end of
sampling measurement. It does not include the hold time.

Total Sampling Time = Interval x No of Samples

Source output sequence. SIMULTANEOUS or SEQUENTIAL.
See “ Source Output Sequence and Time Origin” on page 4-18.

Time since the Source value output until the first sampling
point, in seconds. 0 to 655.35 s, resolution 0.01 s.

The following values are also available for Interval < 0.002 s.
[Hold Time] will be the time since the sampling start until the
Source value output.

- 0.09 to - 0.0001 s, resolution 0.0001 s.
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Stop Condition

Constants

Classic Test Definition

I/V-t Sampling

Base Hold Time

Hold time of the Base value output until the Source value
output, in seconds. 0 to 655.35 s, resolution 0.01 s.

This area defines the sampling measurement stop condition. See “ Stop Condition”
on page 4-18 for this function.

Enable/Disable
Enable Delay

Name

Threshold

Event

No. of Events

Enables or disables the stop condition.

Delay time. in second. Thisis the time from starting sampling
measurement to enabling this function.

Name of measurement data or user function to monitor for stop
condition. Val of Event.

Cannot use the user function that uses the following built-in
functions.

at, avg, cond, diml1Size, dim2Size, integ, mavg, max, min,
storeAt

Threshold value at which to stop sampling measurement.
Th of Event.

Event for stop condition.

Val >Th True if Name parameter valueis greater
than Threshold value.

Val <Th True if Name parameter valueisless than
Threshold value.

[Val| > [Th]| Trueif absolute Name parameter valueis

greater than absolute Threshold value.

[Val| < [Th]| Trueif absolute Name parameter valueis
less than absolute Threshold value.

Target value of the count the event occurs (true). When the
count of true is this value, sampling isimmediately stopped.

This area defines the constant voltage/current source.

Unit SMU used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data
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Range

ADCl/Integ

Advanced

SPGU Pulse /
ALWG Setup

Classic Test Definition
I/V-t Sampling

Mode Output mode, V (voltage), or | (current)
Base, Source Base or Sourcevalue, inV or A.

Base valueis available for al output channels for the
SIMULTANEOUS mode and the last source channel for the
SEQUENTIAL mode.

Compliance Compliance value, in A or V.

This button opens awindow used to set the measurement ranging operation. See
“SMU Range Setup Window” on page 2-48.

This button opens awindow used to set the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow used to set the other functions of the measurement
channel. See “ Advanced Setup Window” on page 2-53.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 2-63 or “SPGU ALWG Setup Window” on page 2-67.

SPGU cannot be used for the sampling measurement of Interval < 0.002 s.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
C-V Sweep

C-V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the C-V
Sweep icon. The main screen displays the C-V sweep test setup screen.

For details of the measurement mode, see “C-V Sweep Measurement” on page 4-19.
Used to set the name of test setup. The name must be the identification for the test

setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-27.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-28.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “Display Setup” on page 2-46.

Error Correction

Error correction must be performed before starting measurements. See “CMU
Calibration” on page 1-60 that explains the error correction GUI. There are four
techniques. For the easy way, perform the phase compensation and the open
correction.
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Channel Definition

NOTE

Miscellaneous
Variables

Classic Test Definition
C-V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data.

UHCU and HVYMCU cannot be used.

Unit Measurement resource used for the source output or
measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode SMU output mode, V (voltage), | (current), or COMMON
(ground)

Function Output function, VAR (primary sweep) or CONST (constant)

Add Adds arow for the channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
|eft radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. However the last output
channel is alwaysthe MFCMU. The output stops in the opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the data index. Integer above O is returned.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 2-27



C-V (VAR1)

Signal Source

Classic Test Definition

C-V Sweep

M easurement Setup

This setup screen is used to set the MFCMU measurement mode, source channel
outputs, the sweep abort condition, and the measurement time.

This area defines the MFCM U measurement mode and DC bias output.

V Name
M odel

paral Name
para2 Name

Direction

Linear/Log

Sart

Sop

Sep
Compliance

No of Sep

Variable name of the DC bias output data

MFCMU measurement mode. Primary and secondary
measurement parameters. See Table 4-2 on page 4-21. Select
one from the pull-down menu.

Variable name of the primary measurement parameter
Variable name of the secondary measurement parameter

Sweep direction, single (start to stop) or double (start to stop to
start)

Sweep output, LINEAR, LOG10, LOG25, or LOG50. where
the number following LOG means the number of sweep points
in one decade.

Sweep start value
Sweep stop value
Incremental step value of the sweep output

Only for SMU. Compliance value. Enter the current limit value
for the voltage source, or the voltage limit value for the current
source.

Number of steps. The value is automatically calculated by using
the start, stop, and step values.

This area defines the measurement signal.

Frequency List  Fregquency of the measurement signal

F Name Variable name of the frequency data

AC Leve Oscillator level of the measurement signal, 10 mV to 250 mV, 1
mV resolution

Add Adds a measurement frequency.

Delete Deletes the selected frequency. To select the frequency, use the
left radio button.
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Integration Time

Timing

Constant

Sweep status

Range

ADCl/Integ

Advanced

Classic Test Definition

C-V Sweep
Up Moves the selected frequency upward.
Down Moves the selected frequency downward.
This area sets the A/D converter of MFCMU.
Mode A/D converter operation mode, AUTO or PLC
Factor Factor for the initial value. See “Mode, Factor” on page 4-20.

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 4-67.

Hold Hold time. Thisisthe time from beginning of channel output to
beginning of delay time. 0to 655.35 s, 10 ms resolution.

Delay Hold time. Thisisthe time from end of hold time to beginning
of measurement. The MFCMU starts measurement as soon as
the wait time elapses. 0 to 655.35 s, 0.1 ms resolution.

This area defines the constant voltage/current source.

Unit SMU used for the constant source

V Name Variable name for constant voltage output or measurement data
| Name Variable name for constant current output or measurement data
Mode Output mode, V (voltage), | (current), or COMMON (ground).

Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

Thisfield specifies the sweep abort condition. See “ Sweep Abort Function” on page
4-37.

This button opens awindow used to set the measurement ranging operation. See
“Range Setup Window” on page 2-55.

This button opens awindow used to set the A/D converter of the SMU measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow used to set the other functions of the measurement
channel. See “ Advanced Setup Window for C-V Sweep” on page 2-57.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
Direct Control

Direct Control

On the EasyEXPERT main screen, click the Classic Test tab and select the Direct
Control icon. The main screen displays the Direct Control test setup screen.

Direct Control test mode performs measurement by controlling measurement
resources, SMU, CMU, and SPGU directly. The instrument can be controlled by
using GPIB commands. For the GPIB commands, see Agilent B1500 Programming
Guide.

Available GPIB commands are listed in the Command pull-down menu on the
Measurement Setup screen. Other commands are not supported by the Direct
Control test.

Sets the name of the test setup. The nameis used to identify the test setup saved to a
My Favorite group (preset group). Enter a unique name that is distinct from other
setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-31.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-33.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

If Agilent B2200A/B2201A/E5250A switching matrix is used, the CMU
measurement data should be compensated. To perform the compensation, define a
user function by using the “compenReZ” and “compenimZ” functions or the
“compenReY” and “compenimY” functions.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 2-46.
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Channel Definition

Additional Data
Variables

Miscellaneous
Variables

Classic Test Definition
Direct Control

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Measurement resource used for the source output or
measurement

V Name Variable name of DC voltage output or measurement data

| Name Variable name of DC current output or measurement data

Add SMU Adds arow for the SMU channel setup.

Add CMU Adds arow for the CMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the selected channel setup. To select a channel setup,
use the radio button on the | ft.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

This area defines the variables for the measurement data other than DC voltage and
DC current which can be defined in Channel Definition.

Unit Unit (SMU or CMU) used for the measurement

Type Type of measurement data. See Table 2-1.

Name Variable name of the measurement data

Add Adds arow for the measurement variable.

Delete Del etes the selected measurement variable. To select avariable,

use the radio button on the | eft.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Index Name Variable name of the dataindex. Integer above O is returned.
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Direct Control

Table 2-1 Available Type Valuesfor Measurement Data Variables
Type Description

SMU Quasi-Static C SMU capacitance measurement data (F)
CMU Re(2) CMU resistance measurement data (Q2)
CMU Im(2) CMU reactance measurement data (Q2)
CMU Re(Y) CMU conductance measurement data (S)
CMU IM(Y) CMU susceptance measurement data (S)
CMU Frequency CMU output signal frequency data (Hz)
CMU AC Level Output Data | CMU oscillator level output data (Vac)
CMU DC BiasMonitor Data | CMU DC bias monitor data (Vdc)
CMU AC Level Monitor Data | CMU oscillator level monitor data (Vac)
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Advanced

Command Setup

Classic Test Definition
Direct Control

M easurement Setup

This setup screen is used to define GPIB commands for controlling the SMU and
CMU directly, and is used to set the SMU seriesresistor, the SMU filter, and the bias
hold function.

This button opens awindow for setting the SMU series resistor, the SMU filter, and
the bias hold function. See “Advanced Setup” on page 2-34.

This area defines GPIB commands for controlling the SMU and CMU directly.

Command Select the command or function from the pull-down menu. See
“Command Setup” on page 2-36.

Arguments Enter the command parameter. To enter multiple parameters,
insert acomma (,) between parameters. Multiple spaces can be
inserted before and after the comma.

All parameters should be entered. If an optional parameter is
abbreviated, theinitial value may be set, the last used value may
be reused, or no value may be set. The result is unique and
depends on the command. For a description of each command,
see Agilent B1500 Programming Guide.

The parameter can be anumeric variable or a numeric
expression with fundamental arithmetic operations.

In an application test definition, the parameter can be anumeric
type test parameters, device parameters, or Symbol.

If theinternal variable is used, it must be used as a string
variable. For example, the variables must be entered as follows.

“%I17, “%R1", “%R2”

Ignore Check this box to comment out this command line.

Add Adds arow for the command setup.

Delete Deletes the selected command setup. To select acommand
setup, use the radio button on the left.

Up Moves the selected command setup upward.

Down Moves the selected command setup downward.
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Options

Channel Settings

After Measurement
Setting

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Direct Control

Advanced Setup

Thiswindow is opened by clicking the Advanced button on the Direct Control
Measurement Setup screen, and is used to set the SMU series resistor, the SMU
filter, and the bias hold function.

The following setup is available.

Primary Setup Primary setup ON or OFF.

If Primary Setup=ON, the primary setup is applied to the instrument when the
Direct Control test is started. For the setup condition, see “Primary Setup” on page
2-35.

If Primary Setup=OFF, the primary setup is not applied. Set the Primary Setup to
OFF if asetup exists and is proven to problem-free for running atest with. The test
execution time can be reduced by this setting.

This area sets the series resistor and the filter.

Unit SMU used for the measurement

VName Variable name of voltage output or measurement data

IName Variable name of current output or measurement data

SeriesR Seriesresistor NONE or IMOHM. See“SMU Series Resistor”
on page 4-71.

SMU Filter SMU filter ON or OFF. See“SMU Filter” on page 4-70.

This area sets the bias hold function for maintaining the source output after
measurement. The source applies the specified bias between two consecutive
measurements of a repeated measurement or quick test. See “Bias Hold Function”
on page 4-41.

Bias Hold after M easurement Bias hold function ON or OFF

Effective only for the instrument installed with SPGU or PGU. Agilent 16445A
selector adapter is needed for connecting Agilent 16440A SMU/PGU selector
(B1500A-A04).

This area sets the selector CH1/CH3 status (DEFAULT or PGU OPEN). To use this
function, set the DEFAULT setting to Always SMU or Normally PGU (AUX) by
using the SMU/PG Selector tab screen on the Configuration window before starting
the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
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CH3 CH3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 4-49 for details on the selector.

Primary Setup

Primary setup istheinitial setting set for when the Direct Control test is started. This
setting is different from the initial setting set by the device clear or the *RST
command. The differences are listed below.

« Dataoutput format

FMT 13, Ois set.
* Program memory

Setup is not changed. The last used setting is retained.
* Internal variables

Setup is not changed. The last used setting is retained.
e Measurement condition setup commands

Setup is not changed for the following commands. The last used setting is
retained.

MM

WV, WI, WSV, WSI, WNX

PV, Pl, PWV, PWI

BDV

Qsv, QSO

LGI, LGV, LS, LSV, LSS, LSSV
BGI, BGV, BSl, BSV, BSSI, BSSV
FC, WDCV

PDCV, PWDCV

WFC

WACV

MDCV
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Table 2-2

Classic Test Definition

Direct Control

Command Setup

To define the Command Setup, set acommand or a function to the Command field,
and enter the command parameters to the Argument field. Also, be aware of the

following note.

FMT command'sfirst parameter must be 13.

» Usethe Unit value of Channel Setup to specify the channel.

» Usethe ReadDataBuffer function to read measurement data.

» Program memory number must be within the range of 1 to 1000.

» SCR command parameter cannot be abbreviated.

* VAR command'’s second parameter must be within the range of 1 to 40. Hence,
internal variables %l 1 to %140 and %R1 to %R40 are available.

A setup exampleis shown in Table 2-2. This example uses SMU1 to performs
voltage output and current spot measurement.

Command Setup Example

Command Arguments Description
FMT 13,0 Sets the data output format.
MM 1, SMUL:HP Sets the measurement mode.
TSC 1 Enables the time data output.
AV 10,1 Sets the number of averaging.
DV SMUZLHR 0, 1.5, Forces the DC voltage.

0.1
CMM SMUZLHP 0 Sets the SMU operation mode.
RI SMU1:HP, 0 Sets the current measurement range.
TSR Resets the timer.
XE Starts the measurement.
ReadDataBuffer | 1 Reads the measurement data
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Parameters

Example

Classic Test Definition
Direct Control

ReadDataBuffer

This function reads the measurement data. The number of data blocksto beread is
specified by the count parameter. If count is abbreviated, this function reads one
data block.

ReadDat aBuf f er [ count]

count Number of data blocks or the number of terminatorsto be read.
A datablock is agroup of datathat ends with aterminator. For
the data output format, see Agilent B1500 Programming Guide.

The following example performs three high speed spot measurements and then
reads three measurement data blocks.

Command Arguments Description

TI 1,0 Measurement channel 1 performs the high
speed spot measurement.

TI 2,0 Measurement channel 2 performs the high
speed spot measurement.

TI 3,0 Measurement channel 3 performs the high
speed spot measurement.

ReadDataBuffer | 3 Reads three measurement data blocks.

NOTE

NOTE

The data output buffer is cleared when the Direct Control test is started.

If aSMU performs the force side measurement operation and the source data output
isenabled (by the FMT command), the SMU’s source datais deleted and the SMU’s
measurement datais stored instead of the source data. The force side measurement
operation is the SMU operation which performs the voltage force and voltage
measurement or the current force and current measurement.
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compenReZ

This built-in function performs compensation on the specified impedance data and
returns the real data for the compensation results.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReZ and compenimZ functions as the user functions on the
Function Setup screen, so that the compensation is performed while the Direct
Contral test is being executed. Also enter the formula to cal culate the measurement
parameters. An example definition is shown in Figure 2-2. For the equations, see

“ About Impedance Measurements” on page 4-22.

Syntax conpenReZ(frequency, Real , | magi nary)

Parameters frequency Measurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Z) measurement result data. Q2. Numeric vector data.

Real should be a vector variable that stores the impedance real
data before compensation.

Imaginary CMU Im(Z) measurement result data. Q2. Numeric vector data.
Imaginary should be avector variable that stores the impedance
imaginary data before compensation.
Example Name Rconpen
Definition conmpenReZ( Freq, ReZ, | n¥)

Rcompen returns the impedance real data for the compensation results.
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Parameters

Example

Classic Test Definition
Direct Control

compenimZ

This built-in function performs compensation on the specified impedance data and
returns the imaginary data for the compensation results.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReZ and compenimZ functions as the user functions on the
Function Setup screen, so that the compensation is performed while the Direct
Controal test is being executed. Also enter the formula to cal culate the measurement
parameters. An example definition is shown in Figure 2-2. For the equations, see

“ About Impedance Measurements” on page 4-22.

conpenl nZ(frequency, Real , | magi nary)

frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Z) measurement result data. Q2. Numeric vector data.

Real should be a vector variable that stores the impedance real
data before compensation.

Imaginary CMU Im(Z) measurement result data. Q2. Numeric vector data.
Imaginary should be avector variable that stores the impedance
imaginary data before compensation.

Name Xcompen

Definition compenl nZ( Freq, ReZ, | n¥)

Xcompen returns the impedance imaginary data for the compensation results.
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Example

Figure 2-2

Classic Test Definition
Direct Control

compenReY

This built-in function performs compensation on the specified admittance data and
returns the real data for the compensation results.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReY and compenimY functions as the user functions on the
Function Setup screen as shown in Figure 2-2, so that the compensation is
performed while the Direct Control test is being executed. Also enter the formulato
calculate the measurement parameters. For the equations, see “ About Impedance
Measurements” on page 4-22. Figure 2-2 defines the following formulato calculate
capacitance.

C=ImY/(2xPlIxFreq)

conpenReY(frequency, Real , | magi nary)

frequency Measurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Y) measurement result data. S. Numeric vector data.

Real should be a vector variable that stores the admittance real
data before compensation.

Imaginary CMU Im(Y) measurement result data. S. Numeric vector data.
Imaginary should be avector variable that stores the admittance
imaginary data before compensation.

Name Gconpen

Definition compenReY( Fr eq, ReY, | nY)

Gcompen returns the admittance real data for the compensation results.

Function Setup Example

R [
Name: Unit: Definition:

ol [T = x|[3.1415 ]

& ]Im‘r‘ glohm j |compenln".‘r'[Fl'eq,G,B] E]

r IRe‘r‘ §|0hm _vJ|CD|11|JEI1RE‘T'I:FI'EE|,G,B] E

= | IR x| [t (2*PI*Freq) E]
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Classic Test Definition
Direct Control

compenlmY

This built-in function performs compensation on the specified admittance data and
returns the imaginary data for the compensation results.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReY and compenimY functions as the user functions on the
Function Setup screen as shown in Figure 2-2, so that the compensation is
performed while the Direct Control test is being executed. Also enter the formulato
calculate the measurement parameters. For the equations, see “ About Impedance
Measurements” on page 4-22. Figure 2-2 defines the following formulato calculate
capacitance.

C=ImY/(2xPlIxFreq)

conpenl n¥( frequency, Real , | magi nary)

frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Y) measurement result data. S. Numeric vector data.

Real should be a vector variable that stores the admittance real
data before compensation.

Imaginary CMU Im(Y) measurement result data. S. Numeric vector data.
Imaginary should be avector variable that stores the admittance
imaginary data before compensation.

Name Bconpen

Definition compenl mY( Fr eq, ReY, | nY)

Bcompen returns the admittance imaginary data for the compensation results.
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User Function,
Analysis Function

Classic Test Definition
Function Setup

Function Setup

This setup screen is displayed by clicking the Function Setup tab of the I/V Sweep /
Multi Channel 1/V Sweep / 1/V List Sweep / I/V-t Sampling / C-V Sweep / Direct
Control test setup screen, and is used to set the user function and the analysis
function.

Calculation of the function is automatically performed after measurement. And the
functions defined in the Display Setup screen will be displayed on the Data Display
window. The user functions are available for the X-Y Graph Plot, List Display, and
Parameters area. The analysis functions are available for the Parameters area.

This button performs calculation of the definition in this screen. If this buttonis
clicked when the Data Display window associated with this test has been opened,
the display is also updated.

The associated Data Display window will be the Data Display window that displays
the last measurement data or that isrecalled at |ast.

The User/Analysis Function area sets the user/analysis functions effective for the
test. Up to 20 functions can be set. The user function result is referable from the
other user function defined in the following lines. The analysis function result is
referable from the other analysis function defined in the following lines.

Name Function name
Unit Unit of the function
Definition Definition of the function. The following identifiers can be used.

» Variables for the measurement/output data used in this test
» Functions defined in the above lines

» Local variables passed from the application test that calls this
test as a component

» Built-in functions and global variables
» Read-out functions (not available for the user functions)
Also see Chapter 5, “Built-in Programming Tool.”

Add, Delete  Addsafunction, or deletes the selected function. To select the
function, use the left radio button.

Up, Down Moves the selected function upward or downward.
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Interpolation Mode

Line 1, Line 2

Classic Test Definition
Auto Analysis Setup

Auto Analysis Setup

This setup screen is displayed by clicking the Auto Analysis Setup tab of the I/V
Sweep / Multi Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling / C-V Sweep /
Direct Control test setup screen, and is used to set the automatic analysis function.
When a measurement finishes, the function automatically draws lines, a marker, or
both on the X-Y Graph of the Data Display window.

You can set up two lines and one marker for the automatic analysis function.
IntheLine 1 and Line 2 areas, you can set up the lines to be drawn.

In the Marker area, you can set up the marker.

This button performs calculation of the definition in this screen. If this buttonis

clicked when the Data Display window associated with this test has been opened,
the display is also updated.

The associated Data Display window will be the Data Display window that displays
the last measurement data or that isrecalled at |ast.

Check this box to enable the interpolation mode. You can position marker between
measurement points.

Thisareasetstheline 1 or line 2 automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the line.

Fix Check this box to fix the line on the graph after the auto
analysisis performed. Remove the check to make the line free.

Type Select one of the available line types listed below.

Axis Axis effective for the line. Specify onefrom Y1to Y8.

First Point See the following description for the line you selected.

Second Point See the following description for the line you selected.
Available line types:

*  “Normal ling": For drawing a line between any two points.

o “Gradient line": For drawing aline through any point with a specified gradient.

» “Tangent line": For drawing atangent line to a measurement point.
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Normal line

Gradient line

Classic Test Definition
Auto Analysis Setup

e “Regressionline’: For drawing aregression line by using the measurement data
included in the area specified by any two points.

This area sets the marker automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the marker.

Condition Enter a variable name and a condition expression to specify
where you want the marker to appear.

After Check this box to enable the additional condition.

Enter a second variable and condition expression. Thissetsup a
search start condition for finding specified point.

For example, you can specify the following expressionsto search for a measurement
point that satisfies the first condition after the second condition is satisfied.

Condition:] DGM]=[MAX(DGM)*0.01] [x] After [DGM]=[MAX(DGM)]

The First Point area and the Second Point area are used to specify the pointsthe line
passes through. The following two ways are available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition
Enter a variable name and condition expression to specify the point. Thisisthe

same method as specifying the Marker point.

The First Point areais used to specify the point the line passes through. The
following two ways are available to specify the point.

» X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisisthe
same method as specifying the Marker point.

In the Gradient field, enter agradient value or expression.
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Tangent line The First Point areais used to specify the measurement point the tangent line passes
through.

Enter avariable name and condition expression to specify the point. Thisisthe same
method as specifying the Marker point.

Regression line The First Point area and the Second Point area are used to specify the range of the
measurement data used for the regression cal culation. The following two ways are
available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisisthe
same method as specifying the Marker point.
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X-Y Graph

List Display,
Parameters

Classic Test Definition
Display Setup

Display Setup

This setup screen is displayed by clicking the Display Setup tab of the I/V Sweep /
Multi Channel 1/V Sweep / 1/V List Sweep / I/V-t Sampling / C-V Sweep / Direct
Control test setup screen or by checking the Define own Output Parameters box on
the Test Definition window, and is used to set the test result output.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8
axes can be set.

Name Specifies the parameter for the axis.

Sharing Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (nho grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale Scale of the axis, Linear or Log

Min Minimum value of the axis

Max Maximum value of the axis

Add Adds a parameter (or axis).

Delete Deletes the parameter selected with the radio button on the left.
Up Moves the selected parameter upward.

Down Moves the selected parameter downward.

Selectsthe datadisplayed in the List Display areaor the Parameters area of the Data
Display window. Up to 20 parameters can be set for each area.

parameter Specifies the parameter for the data output.
Add Adds arow for the parameter.
Delete Deletes the selected parameter. To select the parameter, use the

|eft radio button.
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Up Moves the selected parameter upward.

Down Moves the selected parameter downward.
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Classic Test Definition
SMU Range Setup Window

SMU Range Setup Window

Thiswindow is opened by clicking the Range button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling M easurement Setup screen,
and is used to set the measurement ranging operation.

For the measurement ranging function, see “ SMU Ranging Mode” on page 4-55.

Unit SMU used for the measurement
Name Variable name for the measurement data
Mode Ranging mode, AUTO (auto ranging), LIMITED (limited auto

ranging), or FIXED (fixed range)

Range Range value. For auto ranging, ignore this field. For limited
auto ranging, the measurement channel never uses ranges less
than the specified range.

Range Change

Ruleand Rate Not available for voltage measurement or fixed ranging. See
also “Enhanced Auto Ranging for Current Measurement” on
page 4-58.

Available Range Change Rulevaluesare BY FULL RANGE,
GO UP AHEAD, and UP AND DOWN AHEAD.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules,
specify the Rate value, 11 to 100, which fixes the boundary of
the ranging. The ranging occurs when the measurement data
goes across the boundary values shown bel ow.

go up boundary = present measurement range x Rate/ 100
go down boundary = present measurement range x Rate/ 1000

The go down boundary is available only for the UP AND
DOWN AHEAD rule.

Up Moves the selected measurement channel setup upward.
Down Moves the selected measurement channel setup downward.

If multiple measurement channels are defined, the channels perform measurement
sequentially. The order istop to bottom of the channels defined in this screen. For
exceptions and details, see “Multiple Measurement Channels’ on page 4-69.
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NOTE To use 1 pA range, only for B1500A

The measurement channel connected to the ASU (Atto Sense and Switch Unit)
supportsthe 1 pA range. To usethe 1 pA range, set the 1 pA fixed range or the 1 pA
limited auto ranging.

The B1500A automatically performs the compensation of the data measured by the
1 pA range and returns the compensated data. You can use either the pre-stored
offset data or the pre-measured offset data.

To measure the offset data, perform the self-calibration before starting the
measurement for a DUT. This offset data is temporarily memorized until the
B1500A isturned off.
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A/D Converter

Integration Time

Pulse Averaging
Count

Classic Test Definition
ADC and Integration Time Setup Window

ADC and Integration Time Setup Window

Thiswindow is opened by clicking the ADC/Integ button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling / C-V Sweep Measurement
Setup screen, and is used to set the A/D converter of the SMU measurement
channels.

This area selects the ADC type and enables/disabl es the auto zero function. See
“Integration Time”’ on page 4-65.

Unit SMU used for the measurement

Name Variable name for the measurement data

ADC ADC type, HR ADC (high resolution ADC) or HS ADC (high
speed ADC)

HR ADC isnot available for MCSMU, HCSMU, and HVSMU.
Also it ishot available for the measurements using SMU pulse.

M easurement Compliance Side only, or both Force and Compliance Sides
Force and Compliance Sdesis not available for HRSMU,
MPSMU, and HPSMU.

This area sets the ADC mode and its factor for each ADC type.

Mode ADC operation mode
AUTO, MANUAL, or PLC for High Resolution ADC
AUTO, MANUAL, PLC, or TIME for High Speed ADC
TIME or PLC for the measurements using SMU pulse.

Factor Factor value. Factor value of “Integration Time” on page 4-65.

Auto Zero Auto zero function ON or OFF. Only for the high resolution
ADC. See“ADC Zero Function” on page 4-66.

This area sets the averaging of the pulsed measurement. Not effective for HRSMU,
MPSMU, and HPSMU. The Count value is automatically set to the same value as
the Count value on the Pulse Setup window for using multiple SMU pulse output
channels.

Count Number of pulsed measurements for averaging to get one
measurement data.
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Integration Time

Pulse Averaging
Count

Pulse Channels

Classic Test Definition
Pulse Setup Window

Pulse Setup Window

Thiswindow is opened by clicking the Pulse button on the Multi Channel 1/V
Sweep Measurement Setup screen, and is used to set the SMU pul se setup
parameters. For the SMU pulse setup parameters, see “SMU Pulse”’ on page 4-62.

The followings are the setup parameters for pulse output.

The following parameters are common to the al pulse output channels.

Period Pulse period. Entering AUTO sets the optimum value
automatically.

M easurement

Delay Time Delay time from the beginning of the pulse period to the

beginning of the measurement. Entering AUTO setsthe
optimum value automatically so that the measurement is
completed when the transition from peak to base is started by
the pulse output channel which starts the transition at first.

The following entry fields are available for setting the high speed ADC. High

resolution ADC is not available for this measurement.

Mode ADC operation mode, TIME or PLC

Factor Factor value. Factor value of “Integration Time” on page 4-65.

The following parameter sets the averaging of the pul sed measurement. The Count

value works with the Count value on the ADC and Integration Time Setup window.

The Count value is not effective for HRSMU, MPSMU, and HPSMU.

Count Number of pulsed measurements for averaging to get one
measurement data.

The followings are the pulse setup parameters set to the pulse output channels

individually.

Unit SMU used for the pulse output

Name Variable name for the pulse voltage output data or the pulse
current output data
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Pulse Delay Time Delay time from the beginning of the pulse period to the
beginning of the transition from base to peak. This value must
be 0 for HRSMU, MPSMU, and HPSM U.

Width Pulse width. This value must be the same for HRSMU,
MPSMU, and HPSMU.

Base Pulse base value
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Channel Settings

Wait Time Control

Classic Test Definition
Advanced Setup Window

Advanced Setup Window

Thiswindow is opened by clicking the Advanced button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling M easurement Setup screen,
and is used to set the following functions of the measurement channel.

This area sets the series resistor and the filter.

Unit
VName
IName

SeriesR

SMU Filter

V Compliance

SMU used for the measurement
Variable name of voltage output or measurement data
Variable name of current output or measurement data

Seriesresistor NONE or IMOHM. See“SMU Series Resistor”
on page 4-71.

SMU seriesresistor isnot availablefor MCSMU, HCSMU, and
HVSMU.

SMU filter ON or OFF. See“SMU Filter” on page 4-70.

Only for UHCU, UHV U, or HYVMCU. Limit value for the
voltage sweep output. The output voltage of the measurement
resource isautomatically measured, and the measured voltageis
compared with thislimit value. And then, if it exceeds the limit,
the measurement status is set to the compliance status, and the
sweep measurement stops according to the setting in the Sweep
[xxxx] status field on the M easurement Setup screen. Voltage
range and setting resol ution depend on the measurement
resource.

This area setsthe source output wait time and the measurement wait time. See “Wait
Time” on page 4-68. The Output Wait sets the source output wait time. The
Measurement Wait sets the measurement wait time.

Factor

Factor value. 0 to 10, 0.1 resolution. Thisis the N value shown
in“Wait Time” on page 4-68.
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After Measurement
Settings

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Advanced Setup Window

This area sets the bias hold function used to keep the source output after
measurement. The source applies the specified bias between a measurement and the
next measurement performed in the repeat measurement or quick test. See “Bias
Hold Function” on page 4-41.

Bias Hold after

M easurement Bias hold function ON or OFF
Output Valueafter

M easurement Source output value after measurement

START (sweep start value), STOP (sweep stop value),
SOURCE (sampling output source value), or BASE (sampling
output base value)

Effective only for the instrument installed with SPGU or PGU. Agilent 16445A
selector adapter is needed for connecting Agilent 16440A SMU/PGU selector
(B1500A-A04).

This area sets the selector CH1/CH3 status (DEFAULT or PGU OPEN). To use this
function, set the DEFAULT setting to Always SMU or Normally PGU (AUX) by
using the SMU/PG Selector tab screen on the Configuration window before starting
the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CHS3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See“ SMU/PG Selector” on page 4-49 for details on the selector.
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CMU Measurement
Range

Table 2-3

SMU Measurement
Range

Classic Test Definition
Range Setup Window

Range Setup Window

Thiswindow is opened by clicking the Range button on the C-V Sweep
M easurement Setup screen, and is used to set the measurement ranging operation.

This area sets the CMU measurement ranging operation.

Unit
Mode

Range

CMU used for the measurement

Ranging mode, AUTO (auto ranging) or FIXED (fixed range).
If Mode=AUTO, the MFCMU automatically searches for and
measures at the range that provides the best resolution.

If Mode=FIXED, the MFCMU measures at the range specified
by the Range field.

Measurement range. Thisfieldis effective when Mode=FIXED.
Available measurement ranges depend on the measurement
frequency setting. See Table 2-3.

Available M easurement Ranges

Frequency Available measurement ranges

< 200kHz | 509, 100 2, 300 Q, 1 kQ, 3kQ, 10 k2, 30 k2, 100 k2, 300 kQ
< 2MHz | 500,100 Q, 300 Q, 1 kQ, 3k, 10 kQ, 30 kQ

< 5MHz | 500, 100 Q, 300 Q, 1 kQ, 3k

This area sets the SMU measurement ranging operation.

For the measurement ranging function, see “SMU Ranging Mode’ on page 4-55.

Unit
Name
Mode

Range

SMU used for the measurement
Variable name for the measurement data

Ranging mode, AUTO (auto ranging), LIMITED (limited auto
ranging), or FIXED (fixed range)

Range value. For auto ranging, ignore this field. For limited
auto ranging, the measurement channel never uses ranges less
than the specified range.
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NOTE

Classic Test Definition
Range Setup Window

Range Change

Ruleand Rate Not available for voltage measurement or fixed ranging. See
also “Enhanced Auto Ranging for Current Measurement” on
page 4-58.

Available Range Change Rule values are BY FULL RANGE,
GO UP AHEAD, and UP AND DOWN AHEAD.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules,
specify the Rate value, 11 to 100, which fixes the boundary of
the ranging. The ranging occurs when the measurement data
goes across the boundary values shown bel ow.

go up boundary = present measurement range x Rate/ 100
go down boundary = present measurement range x Rate/ 1000

The go down boundary is available only for the UP AND
DOWN AHEAD rule.

Up Moves the selected measurement channel setup upward.
Down Moves the selected measurement channel setup downward.

If multiple measurement channels are defined, the channels perform measurement
sequentially. The order istop to bottom of the channels defined in SMU

M easurement Range. For exceptions and details, see “Multiple Measurement
Channels’ on page 4-69.

To use 1 pA range, only for B1500A

The measurement channel connected to the ASU (Atto Sense and Switch Unit)
supportsthe 1 pA range. To usethe 1 pA range, set the 1 pA fixed range or the 1 pA
limited auto ranging.

The B1500A automatically performs the compensation of the data measured by the
1 pA range and returns the compensated data. You can use either the pre-stored
offset data or the pre-measured offset data.

To measure the offset data, perform the self-calibration before starting the
measurement for a DUT. This offset datais temporarily memorized until the
B1500A isturned off.
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AC Level/DC Bias
Monitor Settings

Channel Settings

Wait Time Control

Classic Test Definition
Advanced Setup Window for C-V Sweep

Advanced Setup Window for C-V Sweep

Thiswindow is opened by clicking the Advanced button on the C-V Sweep
M easurement Setup screen, and is used to set the following functions.

This areadefines the variables for the AC level data and the DC bias data monitored
by the CMU while the capacitance measurement is performed.

Unit CMU used for the measurement

AC Level Monitor

Name Variable name of the AC level monitor data
DC Bias Monitor

Name Variable name of the DC bias monitor data

This area sets the SMU series resistor and the SMU filter.

Unit SMU used for the measurement

VName Variable name of voltage output or measurement data

IName Variable name of current output or measurement data

SeriesR Seriesresistor NONE or IMOHM. See “SMU Series Resistor”
on page 4-71.
SMU seriesresistor is not available for MCSMU, HCSMU, and
HVSMU.

SMU Filter SMU filter ON or OFF. See“SMU Filter” on page 4-70.

This area sets the source output wait time and the measurement wait time of SMU.
See “Wait Time” on page 4-68. The Output Wait sets the source output wait time.
The Measurement Wait sets the measurement wait time.

Factor Factor value. 0 to 10, 0.1 resolution. Thisis the N value shown
in“Wait Time” on page 4-68.
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After Measurement
Settings

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Advanced Setup Window for C-V Sweep

This area sets the bias hold function used to keep the source output after
measurement. The source applies the specified bias between a measurement and the
next measurement performed in the repeat measurement or quick test. See “Bias
Hold Function” on page 4-41.

Bias Hold after

M easurement Bias hold function ON or OFF
Output Valueafter

M easurement Source output value after measurement

START (sweep start value) or STOP (sweep stop value)

Effective only for the instrument installed with SPGU or PGU. Agilent 16445A
selector adapter is needed for connecting Agilent 16440A SMU/PGU selector
(B1500A-A04).

This area sets the selector CH1/CH3 status (DEFAULT or PGU OPEN). To use this
function, set the DEFAULT setting to Always SMU or Normally PGU (AUX) by
using the SMU/PG Selector tab screen on the Configuration window before starting
the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CHS3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See“ SMU/PG Selector” on page 4-49 for details on the selector.
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Setup Name

Connection

Classic Test Definition
Switching Matrix Control

Switching Matrix Control

On the EasyEXPERT main screen, click the Classic Test tab and select the
Switching Matrix Control icon. The main screen displays the Switching Matrix
Control setup screen. This setup screen is used to create the relay control setup for
Agilent B2200A/B2201A/E5250A Switching Matrix.

To apply the relay control setup, click the Single button. Before doing this, you have
to establish the GPIB connection to the switching matrix by using the Switching
Matrix tab screen of the Configuration window. See “ Switching Matrix” on page
1-67.

Used to set the name of the relay control setup. The name must be the identification
for the setup saved to a My Favorite group (preset group). Enter a unique name that
isdistinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

Thisareais used to create the relay control setup for the switching matrix.

Add Adds arow for the relay connection setup.

Delete Deletes the setup row. To select the setup row, use the left radio
button.

Up Moves the selected setup row upward.

Down Moves the selected setup row downward.

The setup row provides the following entry fields.
Operation Relay control operation

Open All, Switch Setup, Close Range, Open Output,
Open Range, or Open Input. See Table 2-4.

Input Switching matrix input port number or label

Available for the Switch Setup, Close Range, and Open Input
operations.
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Classic Test Definition
Switching Matrix Control

Outputs

Rule

Switching matrix output channel number or label

Four entry fields are available for the Switch Setup and
Open Output operations to specify the output channels.

Two entry fields are available for the Close Range and
Open Range operations to specify the range of output channels.

Relay connection rule

BBM: Breaks the previous connection and then makes the new
connection for the specified outputs.

MBBR: Makes the new connection and then breaks the
previous connection for the specified outputs.

Table 2-4 Relay Control Operations

Operation

Description

Open All

Opens all relays.

Switch Setup

Makes the connection from the specified input port to the
specified output channels. Up to four output channels can be
specified at once.

Close Range

Makes the connection from the specified input port to the
specified output channels. They are between two channels given
by the Outputs fields.

Open Output

Opens the relays connected to the specified output channels. Up
to four output channels can be specified at once.

Open Range

Opens the relays connected to the specified output channels.
They are between two channels given by the Outputs fields.

Open Input

Opens the relays connected to the specified input port.
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Setup Name

Channel Definition

SPGU Setup

Classic Test Definition
SPGU Control

SPGU Control

On the EasyEXPERT main screen, click the Classic Test tab and select the SPGU
Control icon. The main screen displays the SPGU control screen. See “ SPGU
Module” on page 4-27 for the function of the SPGU.

Used to set the name of the SPGU control setup. The name must be able to identify
a setup saved in a My Favorite group (preset group). Enter aunique name that is
digtinct from other setup.

The nameis recorded in the execution result data and is used to differentiate the data
in the test record list area.

Defines the SPGU channel setups.

Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output or the arbitrary linear waveform voltage
output

VName Name of voltage output data

Mode Output mode VPUL SE (voltage pulse output) or ALWG

(arbitrary linear waveform voltage output).

All SPGU channels must have the same output mode.

Add Adds arow for the channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
|eft radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

Provides the following buttons used to open the following setup window.

Pulse/ ALWG Opens “SPGU Pulse Setup Window” if Mode=VPULSE.
Opens “SPGU ALWG Setup Window” if Mode=ALWG.

Advanced Opens “ Advanced Setup Window for SPGU Control”.
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Progress Monitor

After Measurement
Setting

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
SPGU Control

Provides the following check boxes used to set the Data Display window displayed
while the SPGU channel output is applied.

Graph: % of
Progress Check this box to display the Percent of Progress vs. Time plot.

List: TimeData Check thisbox to display the Time datalist.

No data may be displayed on the Data Display window if the SPGU output timeis
too short. The progress monitor will be used for long duration outputs, for example
when the duration is longer than 30 seconds.

Advanced Setup Window for SPGU Control

Thiswindow is opened by clicking the Advanced button on the SPGU Control
screen, and is used to set the following functions of the SPGU channel.

Sets the bias hold function used to decide the channel output after the SPGU output
operation.

BiasHold after
M easurement Bias hold function ON or OFF

If the bias hold function is OFF, the channel stops the output immediately after the
SPGU output operation.

If the function is ON, the channel maintains the base voltage output (in the VPULSE
mode) or theinitial voltage output (in the ALWG mode) between a SPGU output
operation and the next operation performed in the repeat execution or quick test.
Channel initialization occurs at the beginning of the next operation.

Setsthe CH1/CH3 status (DEFAULT or PGU OPEN) of Agilent 16440A SMU/PGU
selector (B1500A-A04). To use this function, set the DEFAULT setting to Always
SMIU or Normally PGU (AUX) by using the SMU/PG Selector tab screen on the
Configuration window before starting the SPGU outpui.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CHS3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See“ SMU/PG Selector” on page 4-49 for details on the selector.

Agilent 16445A selector adapter is needed for connecting the SMU/PGU selector.
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Global Settings

Operation

Pulse Settings

Classic Test Definition
SPGU Pulse Setup Window

SPGU Pulse Setup Window

Thiswindow is opened by clicking the Pulse/ALWG button on the SPGU Control
screen when Mode=VPUL SE, or by clicking the SPGU Pulse Setup button on the
I/V Sweep / Multi Channel I/V Sweep / 1/V List Sweep / 1/V-t Sampling
Measurement Setup screen. It is used to set the SPGU pulse output. See Figure 2-3
for the pulse setup parameters.

Provides the following entry field. The setting is effective for al channels.
Period Pulse period. 20 nsto 10 s, 10 ns resolution.
Provides the following radio buttons used to set the SPGU channel output operation

mode, free run, pulse count, or duration. Select one of the following buttons to set
the operation mode. The setting is effective for all channels.

FREE RUN In this mode, the SPGU continues the pulse output until the
measurement is completed or stopped.

This mode is not available for the SPGU Control classic test.

PULSE COUNT Inthis mode, the SPGU outputs the specified number of pulses.
Specify a number within the range of 1 to 12000000.

DURATION In this mode, the SPGU continues the output until the specified
time elapses. Specify atime within the range of 1 usto
31556926 s (1 year).

Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output

VName Name of voltage output data

Type 2-Level Pulse or 3-Level Pulse. If you choose 3-Level Pulse,
the Additional Pulse fields become effective.

Base, Peak Pulse base and peak voltage. 0to+ 40 V, 1 mV resolution.

Delay Delay time. 0 sto Period- 20 ns, resolution 2.5 nsor 10 ns
(pulse transition time > 8 us).

Width Pulse width. 10 nsto Period- 10 ns, resolution 2.5 nsor 10 ns

(pulse transition time > 8 us).

Leading, Trailing Pulsetransition time. 8 nsto 400 ms, resolution 2 nsor 8 ns
(pulse transition time > 8 us).
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SPGU setup view
order

Load Z

Pulse Switch

Figure 2-3

Classic Test Definition
SPGU Pulse Setup Window

Up Moves the selected channel setup upward.
Down Moves the selected channel setup downward.

Changes are effective only for the display on the SPGU Pulse Setup window and not
memorized. They are not applied to the Channel Setup.

This button opensthe“Load Z Setup Window” used to set the load impedance of the
DUT (device under test) connected to the SPGU channel. The SPGU wiill
automatically adjust the output voltage by using this value, and output the voltage
close to the specified pulse base and peak values.

This button opens the “ Pulse Switch Setup Window” used to set the pulse switch
operation. The pulse switch is used to set the open condition of the SPGU output
channel. The pulse switch is more durable than mechanical relays, and is better
suited for frequent switching applications.

SPGU Pulse Setup Parameters

V/10 4

Normally open  Close ‘Open
Pulse switch 1 ; ! ‘ !
Delay-sw Width-sw Delay-sw
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Classic Test Definition
Load Z Setup Window

Load Z Setup Window

Thiswindow is opened by clicking the Load Z button on the SPGU Pulse Setup
window or the SPGU ALWG Setup window, and is used to set the load impedance
of the DUT (device under test) connected to the specified SPGU channel.

Set the correct impedance value. The SPGU will automatically adjust the output
voltage by using this value, and output the voltage close to the specified pulse base

and peak values.

Load Z Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output or the arbitrary linear waveform voltage
output

VName Name of voltage output data
Load Z Load impedance of the DUT (device under test) connected to

this channdl in Q.
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Pulse Switch

Classic Test Definition
Pulse Switch Setup Window

Pulse Switch Setup Window

Thiswindow is opened by clicking the Pulse Switch button on the SPGU Pulse
Setup window, and is used to set the pulse switch operation. The pulse switch is
used to set the open condition of the SPGU output channel. The pulse switch ismore
durable than mechanical relays, and is better suited for frequent switching

applications.

Unit

VName

SW Sync

Delay

Width

Normal

Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output

Name of voltage output data

ENABLE (enables the pulse switch) or DISABLE (disablesthe
pulse switch).

Switching of the pulse switch status (open and close) will be
controlled automatically and synchronized with the output
pulse, as shown in Figure 2-3.

Delay time from start of pulse output to changeover of pulse
switch. 0 sto Period- 100 ns, 10 nsresolution.

Duration to hold the switched state of the pulse switch. 100 ns
to Period- Delay ns, 10 ns resolution.

CLOSE (normally closes the pulse switch) or OPEN (normally
opensthe pulse switch). The pulse switch will change the status
after the Delay-sw time and keep the status until the Width-sw
time elapses as shown in Figure 2-3. This operation is repeated
every pulse period.
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Operation

ALWG Setting

Load Z

Figure2-4

Classic Test Definition
SPGU ALWG Setup Window

SPGU ALWG Setup Window

Thiswindow is opened by clicking the Pulse/ALWG button on the SPGU Control
screen when Mode=ALWG, or by clicking the SPGU ALWG Setup button on the
I/V Sweep / Multi Channel I/V Sweep / 1/V List Sweep / 1/V-t Sampling
Measurement Setup screen. It is used to set the arbitrary linear waveform output.

Provides the following radio buttons used to set the SPGU channel output operation
mode, free run, sequence count, or duration. Select one of the following buttonsto
set the operation mode. The setting is effective for all channels.

FREE RUN In this mode, the SPGU continues the ALWG sequence output
until the measurement is completed or stopped.

This mode is not available for the SPGU Control classic test.

SEQUENCE

COUNT In this mode, the SPGU outputs the specified number of
sequences. Specify a number within the range of 1 to 1000000.

DURATION In this mode, the SPGU continues the output until the specified
time elapses. Specify atime within the range of 1 usto
31556926 s (1 year).

Provides the following field.

ALWG Source  Click the start button in this field to open the Define ALWG
Waveform window which is used to define the arbitrary linear
waveform and its output sequence. See “Define ALWG
Waveform Window” on page 2-68.

Thisbutton opensthe“Load Z Setup Window” used to set the load impedance of the
DUT (device under test) connected to the SPGU channel. The SPGU wiill
automatically adjust the output voltage by using this value, and output the voltage
close to the specified pulse base and peak values.

SPGU ALWG Setup Window

[Operation |

* FREERUN * PULSE COUNT 10000 2]

" DURATION B

[ALWG Setting |

ALWG Source: [m]... B

start button = |
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File menu

Pattern menu

Column menu

Classic Test Definition
Define ALWG Waveform Window

Define ALWG Waveform Window

Thiswindow is opened by clicking the start button in the waveform data entry field
or the ALWG Source field on the SPGU ALWG Setup window, and is used to create
the arbitrary linear waveform data which is defined by the pattern data and the
sequence data.

Provides the following five functions.

Export ALWaveform... Exports the waveform data.

Import ALWaveform... Imports the specified waveform data.

Export Pattern... Exports the pattern highlighted in the Patterns display
area.

Import Patterns... Imports the specified pattern data.

Close Closes the Define ALWG Waveform window.

Provides the following six functions.

New Thisisfor creating anew pattern. Opens the New Pattern
dialog box. Entering a new name opens Waveform
Pattern Editor (p. 2-71).

Edit Opens the Waveform Pattern Editor with the pattern
highlighted in the Pattern display area.

Cut Cuts the pattern highlighted in the Pattern display area
and storesit on the Clipboard.

Copy Copies the pattern highlighted in the Pattern display area
to the Clipboard.

Paste Pastes the pattern stored on the Clipboard.

Rename Renames the pattern highlighted in the Pattern display
area.

Provides the following five functions.

Edit Opensthe Waveform Pattern Editor with the column data
highlighted in the Sequence Editor area.

Insert Adds a column.
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Sequence Editor

Delete

Move

Repeat Count

Classic Test Definition
Define ALWG Waveform Window

Deletes the column data highlighted in the Sequence
Editor area.

Moves the highlighted column to the left or the right.

Opens the Repeat Count dialog box used to set the repeat
count.

Specifies the output channel, the output pattern, the repeat count of the pattern, and
the output sequence of patterns. These setup information create the arbitrary linear

waveform data.

Column No.

Repeat Count

channel
(eg SPGU1:HV)

Number for specifying the output sequence. The pattern will be
output in the order of this number.

Output repeat count for the pattern specified by the channel
field (e.gright field of the label “SPGU1:HV"). The repeat
count must be entered in thisfield.

Output channel and its output pattern. The channel is specified
by the header (e.g SPGU1:HV) of thisrow. The pattern data
must be specified by this entry field. A pre-defined pattern can
be selected from the drop down menu in thisfield. The right
button opens the Waveform Pattern Editor.

This area provides the following buttons.

Insert Column
Delete Column
To L eft
ToRight

Adds a column.

Deletes the highlighted column.

Move the highlighted column to the left.
Move the highlighted column to the right.

This area also provides the following functions in the menu displayed by
right-clicking this area.

Cancel

Insert Column
Delete Column
Move Column
Repeat Count

Edit

Closes the menu.

Adds a column.

Deletes the highlighted column.

Moves the highlighted column to the left or the right.

Opens the Repeat Count dialog box used to set the repeat count.

Opens the Waveform Pattern Editor with the specified pattern
data (Pattern) or the specified column data (Column).
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Patterns

Classic Test Definition
Define ALWG Waveform Window

The Repeat Count field provides the following functionsin the menu displayed by
right-clicking the field.

Cut Cuts the highlighted value and stores it on the Clipboard.
Copy Copies the highlighted value to the Clipboard.
Paste Pastes the value stored on the Clipboard.

When acolumn is highlighted (light blue), the highlighted area provides the
following functions in the menu displayed by right-clicking the field.

Cancel Closes the menu.
Edit Column Opens the Waveform Pattern Editor with the specified column
data.

When achannel field is highlighted (light blue), the highlighted field provides the
following functionsin the menu displayed by right-clicking the field.

Cancel Closes the menu.
Edit Pattern Opens the Waveform Pattern Editor with the specified pattern
data.

Displaysiconsfor all pre-defined waveform patterns and provides the following
functionsin the menu displayed by right-clicking this area.

Cancel Closes the menu.

New Pattern Thisisfor creating anew pattern. Opensthe New Pattern dialog
box. Entering a new name opens Waveform Pattern Editor (p.
2-71).

Edit Opens the Waveform Pattern Editor with the highlighted
pattern.

Cut Cuts the highlighted pattern and stores it on the Clipboard.

Copy Copies the highlighted pattern to the Clipboard.

Paste Pastes the pattern stored on the Clipboard.

Rename Renames the highlighted pattern.

Export Pattern... Exportsthe highlighted pattern data.
Import Pattern... Importsthe specified pattern data.

Double-clicking a pattern icon will open the Waveform Pattern Editor with the
clicked pattern.
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File menu

Edit menu

Display menu

Classic Test Definition
Define ALWG Waveform Window

Waveform Pattern Editor

Thiswindow is opened by severa actions, for example by selecting New from the
Pattern menu, and is used to create or edit the pattern data.

Provides the following three functions.

Save Saves the pattern data.

SaveAs... Opens adialog box used to specify a pattern name
and save the pattern data.

Close Closes the Waveform Pattern Editor without saving
the data.

Provides the following seven functions.

Undo Undoes the last action.

Redo Cancels the Undo operation.

Add a New Point Adds apoint.

Delete a Point Deletes the highlighted point.

Same Level AsLeft Point Sets the highlighted point to the same level asthe
left point.

Copy Pattern to Clipboard  Copiesthe highlighted pattern data to the Clipboard
in the tab-separated spreadsheet format.

Paste Pattern from Clipboar d Pastes the tab-separated spreadsheet format data
stored on the Clipboard.

Provides the following function.

Channe Opens the Display Channels dialog box used to
select the SPGU channels displayed on the
Waveform Pattern Editor. Thisfunctionisavailable
if the Waveform Pattern Editor was opened with the
column data.
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Pattern Editor

Classic Test Definition
Define ALWG Waveform Window

Defines the pattern data. The Pattern Editor provides two methods, graphic mode
and tabular mode, for defining the pattern data.

In the graphic mode, you can define the pattern data by using the mouse pointer and
GUIs on the graph (on the left side of the Pattern Editor).

In the tabular mode, you can define the pattern data by entering Time in seconds,
Level inV, and Switch O (pulse switch open) or 1 (pulse switch close) into the table
(on the right side of the Pattern Editor).

The Delta Time check box and the Delta L evel check box are used to switch the data
expression in thetable. If the box isnot checked, the value will be an absolute value;
if the box is checked, the value will be the difference from the previous point.

The Pattern Editor provides the following buttons.
Undo Undoes the last action.

Redo Cancels the Undo operation.
Add a New Point Addsa point.

Delete a Point Deletes the highlighted point.

The Pattern Editor also provides the following functions in the menu displayed by
right-clicking the area.

Cancel Closes the menu.

Save Saves the pattern data.

Edit Displays the Edit menu.
Display Displays the Display menu.

If the Pattern Editor is opened with the column data, the following GUI will be
available.

Ref Ch. Specifies the channel or the pattern which contains the
reference point.

Ref Pt. Specifies the reference point by the index number (No. column
of table).

DeltaT Displays the difference from the reference point. For time data.

DeltaV Displays the difference from the reference point. For level data.
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Application Test Definition

This chapter provides the reference information of the application test definition
setup GUI of Agilent EasyEXPERT software.

* “Test Definition Window”
» “Test Specification”

e “Test Output”

* “Test Contents’

* *“Loca Variable Definition”
* “Program Component”

* “Auto Anaysis’

» “DataDisplay Control”

» “Display Data Setup”

e “GPIBI/O"

s “Message’

» “Data Store Control”

* “Command Execution”

» “Using Command Execution”
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Application Test Definition
Test Definition Window

Test Definition Window

The Test Definition window is opened by selecting the Define New Test... function
or the Open Definition of This Test... function of the Library menu, and is used to
create atest definition used in the application test mode.

The test definition consists of the elements shown in Figure 3-1. And the Test
Definition window provides the following three tabs for creating atest definition.

* “Test Specification”

The test specification contains test name, description, device parameters, and
test parameters. The parameters will be the variables used to pass the test
conditions to the test execution flow or test setup defined in the test contents.

 “Test Contents’

The test contents are the core of the test definition, and defines the local
variables, test execution flow, and test setup. You can define the test setup by
selecting application tests, classic tests, or My Favorite setup, and entering the
test conditions.

e “Test Output”

The test output setup is optional. If you need the test result output (test result
display and record) of the test definition, declare the variables (analysis
parameters) and define the display setup.

Figure 3-1 Test Definition

Test Specification

*Test name *Variables
*Test description *Analysis parameters
Variables *Test result display
*Device parameters *X-Y graph
*Test parameters *Data list

«Entry fields Tesl ne'inilinn +Parameter display

Local variables
*Test execution flow
*Test setup

+Classic test
*Application test
*My Favorite setup
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Application Test Definition
Test Definition Window

The Test Definition window provides the following menus.

File menu Provides the following two functions.

Save Saves the test definition. The sample application
tests furnished with the EasyEXPERT and the
application tests created by other users cannot be
saved without changing the Test Name value. The
Test Name must be your original.

Close Opens adialog box that asksif you want to save
before closing the window. Selecting Yes savesthe
test definition and closes the Test Definition
window. Selecting No closes the Test Definition
window without saving the test definition.

Help menu Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.
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Test Information

Device Parameters
Definition

Application Test Definition
Test Specification

Test Specification

This setup screen is used to define the test definition information and the input
parameters for the test definition.

The test information is defined in this area.

Category

Test Name

lcon

Description

Displays the category of the test definition.

The button opens a dialog box used to set the category. It must
be 1 to 30 characters. Multiple categories can be set to atest
definition.

Specifies the test definition name. It must be 1 to 30 characters.

Specifies a bitmap file used for the test definition icon listed in
the Library area of the main screen.

Browse...: Opens adialog box used to select abitmap file.
Cancel: Returnsto the default setting.
Enters the description of the test definition.

The device parameters are defined in this area. Type of the device parameter is

Numeric.
Name
Default
Description
Add

Delete

Up

Down

Device parameter name

Default value of the parameter
Description of the parameter

Adds arow for the device parameter.

Deletes the selected device parameter. To select the parameter,
use the left radio button.

Moves the selected device parameter upward.

Moves the selected device parameter downward.
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Test Parameters
Definition

Application Test Definition

Test Specification

The test parameters are defined in this area.

Background

Name

Type

Default

Description

Align

Width
Ext

Layout...

Specifies a bitmap file used for the background in the Test
Parameters area of the main screen.

Browse...: Opens adialog box used to select a bitmap file.
Cancel: Returnsto the default setting.
Test parameter name

Type of the test parameter, Numeric, Module, String, Vector, or
ALWaveform (SPGU ALWG output data)

Default value of the parameter

For the Numeric, Vector, or ALWaveform type parameter, this
field provides the button to open Numeric KeyPad at the right
side.

For the Vector type parameter, this field provides the button to
open the “Define vector data (page 2-18)” dialog box at the left
side.

For the ALWaveform type parameter, this field provides the

button to open the “ Define ALWG Waveform Window (page
2-68)" at the left side.

Description of the parameter

Specifiesthe X origin of the entry field in the main screen Test
Parameters area. Check this box to set it to the |eft edge of the
entry field. Uncheck this box to set it to the left edge of the
parameter name placed to the left of the entry field.

Specifies the entry field position. (X, Y)=(0, 0) specifiesthe
upper left corner of the main screen Test Parameters area.
Downward and rightward are positive. See “Layout...”.
Specifies the width of the entry field.

Do not check usually. The entry field for the parameter is put on
the main screen.

If the parameter is minor and do not need changes frequently,
check the Ext check box. The entry field will be put on the
dialog box displayed by clicking the “ Extended Setup (page
1-30)" button.

Opens the “ Define Layout (page 3-10)” dialog box.

3-6
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Properties

Add
Delete

Up
Down

Copy
Paste

Application Test Definition
Test Specification

Adds arow for the test parameter.

Deletes the selected test parameter. To select the parameter, use
the left radio button.

Moves the selected test parameter upward.

Moves the selected test parameter downward.
Copies the selected test parameter to the Clipboard.
Pastes the test parameter stored on the Clipboard.

The Properties areais used to define the following values for the specified device
parameter or test parameter. See “ Device Parameters Definition” on page 3-5 and
“Test Parameters Definition” on page 3-6.

To specify the parameter, select the radio button to the left of the parameter name.

Min

Max

Digits
Resolution

Unit

Typical Values...

Resource Type

For Numeric or Vector parameters. Allowable minimum value.
For Numeric or Vector parameters. Allowable maximum value.
For Numeric or Vector parameters. Number of effective digits.
For Numeric or Vector parameters. Allowable setup resolution.
For Numeric or Vector parameters. Unit of the parameter.

For Numeric or String parameters.

Opens the Define typical values dialog box used to define the
selections (typical values) for the specified parameter.

The values defined here are the selections for the parameter
entry field displayed on the main screen in the application test
mode. The selections for the active entry field are displayed on
the softkey. And one of the selections can be set by using the
softkey. Also, it can be set by using the Select sub menu
displayed by right-clicking the entry field.

The selections are effective for the specified parameter only.
For Module parameters.

Opens the Define Resource Types dialog box used to specify
the type of measurement resource. Multiple resources can be
Set.
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Application Test Definition

Test Specification

Dimension...

Assign Output
Channels...

SMU, HPSMU, HCSMU, DHCSMU (dual HCSMU),
HVSMU, HRSMU, MPSMU, MCSMU, HRSMU/ASU,
GNDU, SPGU, HVSPGU, WGFMU, RSWGFMU, MFCMU,
MFCMU/SCUU, SWM IN, SWM AUX IN, SWM SMU IN,
UHCU500, UHCU1500, UHVU, or HYMCU

For Vector parameters.

Opens the Define dimensions dialog box for defining the
dimension of vector data

Use Dim1Min and Dim1Max to specify the primary dimension
of vector data. This direction can be for the primary sweep data.

Use Dim2Min and Dim2Max to specify the secondary
dimension of vector data. This direction can be for the
secondary sweep data.

The following conditions must be satisfied.
¢ 1 < DimIMin < DimiMax (ex. Dim1Min=1,
Dim1Max=11)

¢ 1 < Dim2Min < Dim2Max (ex. Dim2Min=1,
Dim2Max=3)

For ALWaveform parameters.

This button opens the Assign ALWaveform Output Channels
dialog box which specifies the variablesif they are used to
identify the SPGU channels. The variables must be the Module
type test parameter.

For example, when the parameters are defined as shown bel ow,
PG1 should be set to the Assign ALWaveform Output Channels
dialog box for the WAV E1 parameter.

PG1: Module parameter to identify the SPGU channel
WAVEL1L: ALWaveform parameter for the PG1 setup data

Use “Define ALWG Waveform Window (page 2-68)” to create
the SPGU ALWG setup data. For the above example, the PGlis
the SPGU channel identifier when creating the WAV E1 data.
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NOTE

Symbols...

Application Test Definition
Test Specification

For Numeric or Vector parameters.

Opensthe Define dimensions dialog box for assigning a symbol
(string value) to a numeric value for the specified numeric
parameter.

By defining the numeric-symbol assignment, the symbol value,
instead of the numeric value, is set to the parameter entry field
displayed on the main screen in the application test mode.

In the test definition, the parameter works as a numeric value.
However, the numeric-to-string trandation result will not be the
string value simply trandated from the numeric value but the
symbol assigned to the numeric value.

For example, if Symbol=ON is assigned to Value=1 of the
Param1 parameter, the string ON will be set to the Param1 entry
field when numeric value 1 is entered into the Param1 field.
Also, while the Param1 field shows ON, the Param1 value will
be 1 in the test definition. And when the numeric value of
Paraml is 1, the numeric-to-string translation result will not be
the string 1 but the string ON.

The numeric-symbol assignment is effective for the specified
parameter only.

Value and symbol must be in a one-to-one relationship.

The value must satisfy the Min, Max, Digits, and Resolution
settings. The symbol must be between 1 and 30 characters.

Symbols... numeric-symbol assignment

For parameters defined with a numeric-string assignment, the numeric-to-string
translation result will be the symbol gned to the numeric value. Be careful when
using the string built-in function that is used to translate a numeric expression to a

string value.

For the following example setup of a numeric-symbol assignment,
st ri ng( Mode) execution result at Mode=0 is the string OFF, not the string O.

Name=Mode, Value=0, Symbol=0OFF
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Figure 3-2

Application Test Definition
Test Specification

Define L ayout

This dialog box is opened by clicking the Layout... button on the Test Specification
screen of the Test Definition window, and is used to define the layout of the test
parameter entry fields displayed on the application test setup screen. See Figure 3-2.

To define the layout of the entry field, follow the procedures bel ow.
1. Select the entry fields to move. See“To Select Entry Fields’ on page 3-13.
2. Move the selected entry fields. See “To Move Entry Fields’ on page 3-13.

Define Layout dialog box

EEE - S— —
File Edit View Align Distribute Centralize Tab Order

IntegTime: [MEDIUM =[5~ -2 R

:::F'.rir.n:ag:g\n.iee.p:: s de e e

: VsubsStep: |-200 my S :

e PrlmaryEntryFleld ndrE e S e e e e e e e
OK Cancel

Define Layout GUI
This section describes the Graphical User Interface of the Define Layout dialog box.
The Define Layout dialog box provides the following buttons.

OK Saves the layout definitions and closes the Define Layout
dialog box.

Cancel Closes the Define Layout dialog box without saving the layout
definitions.
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File menu

Edit menu

View menu

Aligh menu

Distribute menu

Centralize menu

Application Test Definition
Test Specification

The Define Layout dialog box provides the following menus.

Exit

Undo
Redo
Select All

Property...

L eft

Center

Right

Top

Middle

Bottom

To Grid

Horizontally

Vertically

Horizontally

Vertically

Closes the Define Layout dialog box without saving the layout
definitions.

Cancels an operation. Up to ten operations can be cancelled.
Performs the canceled operation again.

Selects all entry fields.

Opens the “ Properties (page 3-12)" window.

Alignsthe left ends of other selected entry fieldsto the left end
of the primary entry field.

Alignsthehorizontal centers of other selected entry fieldsto the
horizontal center of the primary entry field.

Alignsthe right ends of other selected entry fields to the right
end of the primary entry field.

Alignsthe upper ends of other entry fields to the upper end of
the primary entry field.

Alignsthe vertical centers of other selected entry fields to the
vertical center of the primary entry field.

Alignsthe lower ends of other selected entry fieldsto the lower
end of the primary entry field.

Alignsthe upper left corner of the entry field to the nearest grid.

Distributes the selected entry fields (3 or more) with even
horizontal intervals. The leftmost entry field is used as the base
point.

Distributes the selected entry fields (3 or more) with even
vertical intervals. The leftmost entry field is used as the base
point.

Moves the horizontal center of all selected entry fields to the
horizontal center of the entry field area.

Moves the vertical center of all selected entry fieldsto the
vertical center of the entry field area.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 3-11



Tab Order menu

Design

Layout

Behavior

Layout

Application Test Definition

Test Specification

Top to Bottom

L eft to Right

Properties

Sets the Tablndex in ascending order of the X of the entry
fields, starting at the upper l€eft entry field. If the X of the entry
fields are equal, the Tablndex is set in ascending order of the Y
of the entry fields. For more information on X/Y, see
“Properties’ on page 3-12.

Sets the Tablndex in ascending order of the Y of the entry
fields, starting at the upper left entry field. If the Y of the entry
fields are equal, the Tablndex is set in ascending order of the X
of entry fields.For more information on X/Y, see “Properties’
on page 3-12.

Thiswindow is opened by clicking the Property... button in the View menu of the
Define Layout dialog box, and specifies characteristics of the entry field area or the

entry fields.

When the entry field areais selected, the following characteristics can be specified.

DrawGrid
GridSize
SnapToGrid

Size

Sets whether to display the grid.
Sets the width and the height of the grid.
Sets whether to snap to the grid.

Sets the width and the height of the entry field area.

When entry fields are selected, following characteristics can be specified.

Tablndex

Align

Width
X, Y

Setsthe tab traversing order for the test parameter entry fields
of the application test.

Specifiesthe X origin of the entry field.

True: Left edge of the entry field

False: Left edge of the parameter name placed to the left of the
entry field

Specifies the width of the entry field.

Specifiesthe entry field position. The Y origin isthe upper edge

of theentry field.(X, Y)=(0, 0) specifiesthe upper |eft corner of
the entry field area. Values increase downward and rightward.

3-12
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Application Test Definition
Test Specification

To Select Entry Fields
The following methods are available for selecting the entry fields.

» Click ontheentry field. Multiple entry fields can be selected by clicking on the
entry field while holding down the Ctrl key on the keyboard.

» Drag the mouse to draw arectangle around multiple entry fields.
» Select Select All from the EDIT menu to select all entry fields.

The selected entry fields are outlined by the blue rectangles. The primary entry field,
which is the base for layout operations, is surrounded by a highlighted blue
rectangle, as shown in Figure 5-5. Only one primary entry field can be selected. To
change the primary entry field, click on a selected entry field. The selected entry
field that was most recently clicked will be the primary entry field.

The following methods are available for releasing (unselecting) the selected entry
fields.

e Click the selected entry field while holding down the Shift key on the keyboard.
» Click outside of the selected entry fieldsto release all selected entry fields.

ToMoveEntry Fields

The following methods are available for defining the layout of the selected entry
fields.

» Drag & drop with the mouse to move the selected entry field(s).

» Changethe X/Y valuesin the property window to move the selected entry
field(s).
» Pressthe arrow keys on the keyboard to move the selected entry field(s).

» Using the functions in the Align menu, the selected single or multiple entry
fields can be aligned to the primary entry field.

» Usethe functions in the Distribute menu to evenly distribute the selected entry
horizontally or vertically.

» Usethe functions in the Centralize menu to move the horizontal or vertical
center of all selected entry fields to the horizontal or vertical center of the entry
field area
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Define Own Output
Parameters

Allocate Data
Display for each
test

Define Analysis
Parameters...

X-Y Graph,
List Display,
Parameters

Application Test Definition
Test Output

Test Output

This setup screen is used to set the test result output (test result display and record)
that isthe output of the test definition.

The test output setup is optional. If you have the following requirements, define the
analysis parameters and set the display parameters.

» To send thetest result data to the subsequent tests in an application test
» To make the program branching depends on the test result

» To make the calculation using the test datain the Test Contents

» Todisplay/record the test result of this application test

To read the analysis parameters defined in the application test used in atest
definition, use the “ External Variable Setup (page 3-23)” dialog box.

Check this check box to set the test result outputs of the test definition. While this
box is checked, the X-Y Graph, List Display, and Parameters areas are available.
The test result output will be obtained every execution of the test definition.

Thisfield setsthe Multi Display function to Enable, Disable, or Comply with above
level.

If Enable is selected, the test result data of the same test setup name will be
displayed on the exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display window.

If Disable is selected, the test result data will be always displayed on the singular
Data Display window even if it isthe test result data of the different test setup name.

Select Comply with above level for complying with the Multi Display ON/OFF
status or the setting of the application test which uses this application test internally.

This button opens the window. This “ Analysis Parameter Definition (page 3-15)"
window is used to define the vector data and the scalar data used in the test result
output. The defined variable is called as the analysis parameter.

The areas are used to set the test result output (test result display and record) that is
the output of the test definition. See “Display Setup” on page 2-46.
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NOTE

Vector Parameters

Scalar Parameters

Application Test Definition
Test Output

Analysis Parameter Definition

Thiswindow is opened by clicking the Define Analysis Parameters button, and is
used to define the vector variables and the scalar variables used in the test result
output. The variables are called as the analysis parameters. This window is closed
by the Close button.

Analysis parameters can be referred from atest definition which uses this
application test. To read the value, make a mapping table between the analysis
parameters and the local variables, device parameters, test parameters, or analysis
parameters defined in the test definition by using the “ External Variable Setup (page
3-23)” dialog box.

This area sets the analysis parametersfor the vector data. The vector dataisan array
datathat contains numeric data more than one.

Name Name of the analysis parameter

Unit Unit of the analysis parameter

Description Description of the analysis parameter

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the
|eft radio button.

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.

This area sets the analysis parameters for the scalar data. The scalar dataisa
numeric data.

Name Name of the analysis parameter

Unit Unit of the analysis parameter

Description Description of the analysis parameter

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the
left radio button.

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.
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Figure 3-3

Application Test Definition
Test Contents

Test Contents

Test contents are the core of the test definition, and consists of the local variables,
test setups, and test execution flow. In the test contents, the following elements can
be defined. See Figure 3-3.

Local variables

Program components

Application tests

Classic tests

My Favorite setup

Analysis components

Miscel laneous components

Device parameters defined in Test Specification
Test parameters defined in Test Specification
Analysis parameters defined in Test Output

The device parameters, test parameters, and analysis parameters can be used in the
Test Contents without defining as the local variables.

For the available components, see Figure 3-4.

Test Contents
Test Specification Test Output
Variables Variables

Local variables

*Device parameters
Test parameters

Test Contents

Miscellaneous

*Analysis parameters

Program Component

Application Test My Favorite setup
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Application Test Definition
Test Contents

Defining/Editing Test Contents

The Test Contents setup screen is used to define the test execution flow that is the
core of the test definition. To define the test execution flow, use the test flow list
area at the lower left of the window, and do following. Also see Figure 3-5.

1. Definelocal variables by using the Local Variables Definition statement.

2. Select acomponent from the component selection area. See Figure 3-4 for the
available components.

Insert it between the BLOCK and END BLOCK statements.
4. Repeat thisuntil your test execution flow is completed.

Figure 3-4 Available Components
Program Component
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BLOCK ON ERROR  FIMALLY F LOOP FOR ASSIGN COMMENT END ERROR

Application Test

= -
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Analysis
[ ] = = [~
= = :
Auto Display Data Data Display
Analysis Setup Control
[
Classic Test
] ) = = ~
T | [ e
B | 2 . et i [
IV Sweep Multi IV List vt C-V Sweep SPGU Switching Direct 1
Channel L..  Sweep Sampling Control Matrix ... Control =
Miscellaneous
0w
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GFIB /O Message Command Data Store
Execution Control =
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Program
Component

Application Test

Analysis

Classic Test

My Favorite Setup

Application Test Definition
Test Contents

This component selection menu lists the program components available for the test
flow. See “Program Component” on page 3-26.

This menu lists the application test setups available for the user. Inserting an
application test setup to the test flow displays the test setup screen almost same as
the “Application Test” on page 1-29. You set the test condition on this screen.

Variables can be used for setting the test condition. To use a Numeric or Module
variable, enter the variable name to the entry field. To use a String variable, type an
equal sign (=) and enter the variable name (for example, =VAR).

Clicking the Assign to external variables... button opens the External Variable Setup
dialog box. See “External Variable Setup” on page 3-23.

This component selection menu lists the analysis functions available for the test
flow, and provides the following components.

» “Auto Anaysis’ on page 3-27
» “Display Data Setup” on page 3-31
» “DataDisplay Control” on page 3-30

This component selection menu lists the classic test objects, 1/V Sweep, Multi
Channel 1/V Sweep, I/V List Sweep, I/V-t Sampling, C-V Sweep, SPGU Control
Switching Matrix Control, and Direct Control.

Inserting a classic test component to the test flow displays the test setup screen
almost same asthe “1/V Sweep” on page 2-4, “Multi Channel 1/ Sweep” on page
2-9, “I/V List Sweep” on page 2-13, “I/V-t Sampling” on page 2-21, “C-V Sweep”
on page 2-26, “ SPGU Control” on page 2-61, “ Switching Matrix Control” on page
2-59, or “Direct Control” on page 2-30. You set the test condition on the screen.

Clicking the Assign to external variables... button opens the External Variable Setup
dialog box. See “External Variable Setup” on page 3-23.

This component selection menu is used to select the My Favorite setup inserted to
the test flow. Specify the preset group, then select the setup.

If atracer test setup is selected, it is converted to and inserted asaMulti Channel I/V
Sweep test setup. In this conversion process, the VAR1 dual polarity sweep setup
(Dua Polarity) isignored. The setup of the positive sweep from start to stop is
converted, but the setup of the negative sweep from - start to - stop is not converted.
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Miscellaneous

Edit / Debug

Block Selection /
Line Selection

Application Test Definition
Test Contents

This component selection menu lists the miscellaneous functions available for the
test flow, and provides the following components.

e “GPIB I/O" on page 3-33

* “Message’ on page 3-38

» “Command Execution” on page 3-40
» “Data Store Control” on page 3-39

To add a component to the test flow, select the destination line for the component
and drag the component from the component selection areato the test flow list area.
Instead, you can select aline and a component, then click the Insert button. The
component will be put on the line after the selected line, and the following lineswill
shift downward.

After adding a component to the test flow, selecting the new line might display an
editor at the center to lower right of the window. The editor is used to define the
setup. Some components provide the editor, and some components do not. For
example, the Local Variables Definition provides the editor used to define the local
variables. See “Local Variable Definition” on page 3-24.

You can edit the test flow by using the Block Selection/Line Selection, Insert,
Delete, Copy, Cut, and Paste buttons. Also you can debug the test flow by using the
Run/Pause, Abort, Step, Break, and Inspect buttons. See “ Debugging Test Contents’
on page 3-21.

The Edit tab displays the buttons Block Selection/Line Selection, Insert, Delete,
Copy, Cut, and Paste.

The Debug tab displays the buttons Run, Abort, Step, Break, and Inspect.

Only the buttons effective for the selected linein the list area are active.

The Line Selection button changes the list area sel ection mode to the line selection

mode. The Block Selection button changes the sel ection mode to the block
selection.

In the line selection mode, the line cursor selects every line.

In the block selection mode, the line cursor selects every block. For example, the
lines from the |F statement to END |F statement can be a block.
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Application Test Definition
Test Contents

Insert This button puts the selected component on the next line of the selected line. The
following lines will shift downward.

Delete This button deletes the selected line. The following lines will shift upward.

Copy This button copies the selected line to the clipboard.

Cut This button moves the selected line to the clipboard. The following lines will shift
upward.

Paste This button puts the components in the clipboard on the next line of the selected

line. The following lines will shift downward.

Figure 3-5 Test Contents Screen
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Figure 3-6

Run/Pause

Abort

Step

Break

Inspect

Application Test Definition
Test Contents

Debugging Test Contents

On the Test Contents tab screen, click the Debug tab. The following buttons will
appear. They are useful for debug of your test contents.

Set the break point, and click the Run button. And check the operation of the test
contents, the value of variables by using the Variable Inspector, and so on.

Debugging Test Contents
©

Test Specfication  Test Contents } Test Output |

E n m»m & 0 ® M [ © A

BLOCK i ELSETF ELSE LooP FOR ASSIGN  COMMENT  END ERROR

Program Component | Application Test | Analysis| Classic Test | Miscelaneous
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Add Module
Variable

Run Abort: Step
Add Vector | Add String
Variable Variable

Break Inspect Nus
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Brocs Vector Dat SERROR i ]
Variable: [D¢Rf Indext: [1 8] Index2: [1 |
Value: [-0.50000 8|
it it [

Vector Data Variable |
Variable: [1D | Indexi: [T B Index2: [1 8|
Value: [1.027402-005 |
Vector Data Variable |
Variable: [G1 B et 1 H] Indexa: [1 il

- iTa
Break point @ VEE = getNumeric Value: [fi525 05 |
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= END IF Vector Data Variable |

END IF
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Paused point - | value: [0.0005254 H v

This button starts the debug (executes the test flow). During execution, the label
changesto Pause. Clicking Pause pauses the execution, and changes the label to Run
that is used to continue the debug (execution).

This button aborts the debug (execution).

This button executes the selected line of the test flow. Clicking the button repeatedly
continues the execution by aline.

This button sets/rel eases the break point. For the break point, this button releasesthe
break point from the selected line. Program execution will break at the break point
automatically.

Thisbutton is avail able when the debug (execution) is paused or broken. This button
opens the Variable Inspector used to monitor value of device parameters, test
parameters, analysis parameters, local variables, or system variables. See “Variable
Inspector” on page 3-22.
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Numeric Variable

Vector Variable

String Variable

Module Variable

Application Test Definition
Test Contents

Variable | nspector

This Variable Inspector is displayed by clicking the “Inspect (page 3-21)" button on
the Test Contents screen, and is used to monitor or change the value of the local
variables, device parameters, test parameters, and analysis parameters. For the
vector variables, only datamonitor isavailable. The Variable Inspector providesthe
following buttons to add the variable monitor area.

Add Numeric Variable Adds the numeric variable monitor area.
Add Vector Variable Adds the vector variable monitor area.
Add String Variable Adds the string variable monitor area.
Add Module Variable  Addsthe module variable monitor area

The following functions are available for the menu displayed by clicking the banner
of the variable monitor area.

Up This button shifts the variable monitor area upward.
Down This button shifts the variable monitor area downward.

Remove This button deletes the variable monitor area.

You can monitor or change the following information.
Variable Numeric variable name

Value Value of the variable

You can monitor the following information.

Name Vector variable name. Two dimensional array.
Index1/2 Index for the primary/secondary plane of the two-dimensional array
Value Value of the variable

You can monitor or change the following information.
Variable String variable name

Value Value of the variable

You can monitor or change the following information.
Variable Module variable name

Value Value of the variable
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External variable

Measurement data

Example

Application Test Definition
Test Contents

External Variable Setup

Thisdialog box is displayed by clicking the Assign to external variable... button on
an Application Test setup screen or a Classic Test setup screen, and is used to make
amapping table between the test setup internal variables and the local variables,
device parameters, test parameters, or analysis parameters defined in the test
definition which uses this test setup. After making the mapping table, you can read
the value by using the external variables.

This dialog box provides the following buttons.

Add Adds the variable entry fields.

Delete Deletes the variable entry fields selected by the radio button.
Up Shifts the selected variable entry fields upward.

Down Shifts the selected variable entry fields downward.

This dialog box provides the following entry fields.

Name of local variable, device parameter, test parameter, or analysis parameter
connected with the variable set to the Measurement data field

Name of internal variable used in atest setup and to be read. For the Application
Test, only the analysis parameters are available.

The following example connects the internal vector variable Vdata with the local
variable VDATA.

1. Define VDATA asalocal variable by using the Local Variables Definition
statement.

Click the Assign to external variable... button on atest setup screen.
Click the Add button on the External Variable Setup dialog box.
Set VDATA to the External variable field.

Set Vdata to the Measurement data field.

o g~ WD

Click the Close button.
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Numeric Variable

Application Test Definition
Local Variable Definition

Local Variabl

e Definition

This setup editor is displayed while the Local Variable Definition is selected in the
test execution flow list area, and is used to define the variables used in the test
definition. The setup editor provides the following buttons to add the variables.

Add Numeric Variable Addsthe numeric variable.

Add Vector Variable
Add String Variable
Add Module Variable

Adds the vector variable.
Adds the string variable.
Adds the module variable.

The following functions are available for the menu appeared by clicking the banner

of the variable area.

Up This button shifts the variable area upward.

Down This button shifts the variable area downward.

Remove This button deletes the variable.

This area provides the following entry fields.

Name Numeric

variable name

Value Initial value of the variable

Description Additional information for the variable
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Vector Variable

String Variable

Module Variable

Application Test Definition
Local Variable Definition

This area provides the following entry fields.

Name Vector variable name. Two dimensional array.
Count Number of elements, or array size
Description Additional information for the variable

This area also provides the following radio button used to specify how to set the
initial value of the array data automatically.

* Assign Linear Values FROM [value of first element] TO [value of last element]

If Count > 1, thissetsfirst value + (N- 1) x (last value- first value)/(Count- 1) to
the N-th element. If Count = 1, this setsfirst value (=last value) to the element.

* Assign Linear Values FROM [value of first element] STEP [step value]
This setsfirst value + (N- 1) x step to the N-th element.

This area provides the following entry fields.
Name String variable name
Value Initial value of the variable

Description Additional information for the variable

This area provides the following entry fields.
Name Module variable name

Description Additional information for the variable
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ASSIGN

COMMENT

IF

ELSE IF

FOR

Application Test Definition
Program Component

Program Component

The Program Component selection menu provides the components described in
“Script Program Statements’ on page 5-20. Especially, the following components
provide the setup editor.

. “ASSIGN”
« “COMMENT’
. P

. “ELSEIF

.« “FOR’

This component provides the setup editor that contains the following entry fields
used to define the value of the variable.

Variable Variable name
Expression Definition of the variable

This component provides the setup editor used to enter the comment for the line.

This component provides the setup editor used to enter the condition for the IF
Statement.

This component provides the setup editor used to enter the condition for the
EL SE IF statement.

This component provides the setup editor that contains the following entry fields
used to define the FOR NEXT loop condition.

Variable Variable name

Initial Value Count to start the FOR NEXT loop

Terminate Value Count to terminate the FOR NEXT loop

Sep Value Loop count incremental step value
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Interpolation Mode

Line 1, Line 2

Application Test Definition
Auto Analysis

Auto Analysis

This component provides the setup editor used to set up the automatic analysis
function. When a measurement finishes, the function automatically drawslines, a
marker, or both on the X-Y Graph of the Data Display window.

You can set up two lines and one marker for the automatic analysis function by
using the setup editor.

IntheLine 1 and Line 2 areas, you can set up the lines to be drawn.
In the Marker area, you can set up the marker.

Check this box to enable the interpolation mode. You can position marker between
measurement points.

Thisareasetstheline 1 or line 2 automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the line.

Fix Check this box to fix the line on the graph after the auto
analysisis performed. Remove the check to make the line free.

Type Select one of the available line types listed below.

Axis Axis effective for the line. Specify onefromY1to Y8.

First Point See the following description for the line you selected.

Second Point See the following description for the line you selected.
Available line types:

*  “Normal ling": For drawing a line between any two points.
o “Gradient line": For drawing aline through any point with a specified gradient.
» “Tangent line": For drawing atangent line to a measurement point.

» “Regressionline’: For drawing aregression line by using the measurement data
included in the area specified by any two points.
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Marker

Normal line

Gradient line

Application Test Definition
Auto Analysis

This area sets the marker automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the marker.

Condition Enter avariable name and a condition expression to specify
where you want the marker to appear.

After Check this box to enable the additional condition.

Enter a second variable and condition expression. Thissetsup a
search start condition for finding specified point.

For example, you can specify the following expressionsto search for a measurement
point that satisfies the first condition after the second condition is satisfied.

Condition:[ DGM]=[MAX(DGM)*0.01] [x] After [DGM]=[MAX(DGM)]
The First Point area and the Second Point area are used to specify the pointsthe line
passes through. The following two ways are available to specify the point.
* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition
Enter a variable name and condition expression to specify the point. Thisisthe

same method as specifying the Marker point.

The First Point areais used to specify the point the line passes through. The
following two ways are available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisisthe
same method as specifying the Marker point.

In the Gradient field, enter agradient value or expression.
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Tangent line The First Point areais used to specify the measurement point the tangent line passes
through.

Enter avariable name and condition expression to specify the point. Thisisthe same
method as specifying the Marker point.

Regression line The First Point area and the Second Point area are used to specify the range of the
measurement data used for the regression cal culation. The following two ways are
available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisisthe
same method as specifying the Marker point.
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Application Test Definition
Data Display Control

Data Display Control

This component enables or disables the test result display of the application test or
the classic test used in the test definition.

Enable Data Display = Checking this box enables the test result display.

If you do not use this component, the test result display is enabled.

This component cannot control the test result display of the test definition. The test
result display is always enabled for the test definition. For the test result output of
the test definition, see “ Test Output” on page 3-14.
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X-Y Graph

Application Test Definition
Display Data Setup

Display Data Setup

This component is used to set the data output of the local variables defined in the
test execution flow. The values can be displayed on the Data Display window.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8

axes can be set.
Name

Sharing

Scale
Min
Max
Add
Delete
Up

Down

Specifies the parameter for the axis.

Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (nho grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale of the axis, Linear or Log

Minimum value of the axis

Maximum value of the axis

Adds a parameter (or axis).

Deletes the parameter selected with the radio button on the left.
Moves the selected parameter upward.

Moves the selected parameter downward.
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Application Test Definition
Display Data Setup

List Display, The List Display area sets the output for the List Display area of the Data Display
Parameters window. The Parameters area sets the output for the Parameters area of the Data

Display window. Up to 20 parameters can be set for each area.

parameter Specifies the parameter for the data output.

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the

left radio button.
Up Moves the selected parameter upward.
Down Moves the selected parameter downward.
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CAUTION

Write String

Write Value

Application Test Definition
GPIB I/O

GPIB1/O

This component provides the setup editor that contains the following entry fields.
This component is used to control the GPIB interface. For the fieldsto enter a
variable name, only the variable name defined in the test definition can be entered.

Do not set the GPIB address of the B1500 to the Address parameter of this
component even if thisis on the Desktop EasyEXPERT software. Operation of the
B1500 is not guaranteed.

Sends the specified string data to the specified GPIB device.

Address
Sring

Terminator

GPIB address of the target device
String value to send

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified)

Translates the specified numeric data to the string data, and sendsiit to the specified

GPIB device.
Address
Format

ValueO
Valuel
Value2
Value3

Terminator

GPIB address of the target device

Format of Write Value. Follow Agilent T& M Programmers
Toolkit.

Numeric value or string value to send
Numeric value or string value to send
Numeric value or string value to send
Numeric value or string value to send

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified).
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Read String

Read Value

Application Test Definition

GPIB 1/O

Reads a string value from the specified GPIB device.

Address
Sring
Length To Read

Length Actually
Read

Ter minator

Terminated

Timeout

GPIB address of the target device
String variable name. Used to store the returned value.
Byte length of the string value to read

Numeric variable name. Used to store the byte length of the
returned value. If the Length To Read is large enough and the
terminator is sent with the returned string value, the value of
this numeric variable is smaller than the specified Length To
Read.

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified)

Numeric variable name. Used to store the execution result. If
reading is completed by the terminator, 1 is entered. Otherwise,

0 is entered.
Timeout. The value must be less than 231
0 does not set timeout.

s, 1 msresolution.

Reads a numeric value from the specified GPIB device.

Address GPIB address of the target device

Value Numeric variable name. Used to store the returned value.

Preamble String variable name. Used to store preamble of the returned
value. The preamble is a part considered as non-numeric value.
If thisfield is not set, the preamble is del eted.

Postamble String variable name. Used to store postamble of the returned
value. The postambleisapart considered as non-numeric value.
If thisfield is not set, the postambl e is del eted.

Success Numeric variable name. Used to store the execution result. For
the successful result, 1 is entered. Otherwise, O is entered.

Ter minator Terminator, DEFAULT, EOI, CR/LF+EOI, LF+EOQOI, CR/LF,
LF, or NONE (not specified)

Timeout Timeout. The value must be less than 231 s, 1 ms resolution.
0 does not set timeout.

3-34 Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1



Read List

Read STB

GP-IB Control

Application Test Definition

GPIB I/O
Reads a vector data from the specified GPIB device.
Address GPIB address of the target device
Values Vector variable name. Used to store the returned value.
Delimiter Delimiter. 1 character. 0t0 9, E, g, +, - , and . (comma) cannot
be specified.
Length Actually
Read Numeric variable name. Used to store the number of data stored
in the vector variable.
Ter minator Terminator, DEFAULT, EOI, CR/LF+EOI, LF+EOQOI, CR/LF,
LF, or NONE (not specified)
Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.
Reads the status byte of the specified GPIB device.
Address GPIB address of the target device
Satus Byte Numeric variable name. Used to store the status byte to read.
Timeout Timeout. The value must be less than 231 s, 1 msresolution.

0 does not set timeout.

This area selects one from the following GPIB statements to execute.

» Group Execution Trigger
Sends atrigger to the specified GPIB device.
Address GPIB address of the target device

231

Timeout Timeout. The value must be less than s, 1 msresolution.

0 does not set timeout.
» DeviceClear
Sends a device clear to the specified GPIB device.
Address GPIB address of the target device

Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.
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Example 1

Application Test Definition

GPIB 1/O

e GoTolLocd

Returns the specified GPIB device to the local state.

Address

Timeout

» Loca LockOut

GPIB address of the target device

231

Timeout. The value must be less than s, 1 msresolution.

0 does not set timeout.

Locks the specified GPIB device.

Address

Timeout

GPIB address of the target device

Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.

To send the following command to Agilent B2200A switching matrix (GPIB
address 22), use Write Value function and enter the parameters as shown bel ow.

‘ROUT:SYMB:CHAN 0, 1, “Gate”

This command assigns the string Gate to the output 1 of the B2200A in the auto
configuration mode.

*  Write Vaue
Address
Format
ValueO
Valuel
Value2
Value3

Ter minator

22

:ROUT:SYMB:CHAN {0}, {1}, “{2}"
0

1

Gate

(blank)

LF+EOQI

where, {0}, {1}, {2}, and { 3} are the variablesthat can be used in the Format field,
and corresponds to the Value0, Valuel, Value?, and Value3 respectively.
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Application Test Definition
GPIB I/O

Example 2 After performing Example 1, enter the following query command and read the
response by using Write String and Read String functions as shown below. Use
Write String to send the command, after that use Read String to read the response.

‘ROUT:SYMB:CHAN?O, 1

This command returns the string assigned to the output 1 of the B2200A in the auto
configuration mode.

»  Write String:
Address 22
Sring ‘ROUT:SYMB:CHAN?0, 1
Terminator LF+EOI

* Read String:
Address 22
Sring ReturnedVvalue
Length To Read 10
Length Actually Read Lengthl
Terminator LF+EOI
Terminated Term
Timeout 1.00s

where, ReturnedValue is a string variable to store the response of the
:ROUT:SYMB:CHAN? 0, 1 command, Lengthl is a numeric variable to store the
byte length of the ReturnedValue value, and Term is a numeric variable to store the
execution result. They must be defined in the Local Variables Definition statement.
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Message
User Response

Button 1

Button 2

Button 3

Button 4

Application Test Definition
Message

Message

This component provides the setup editor that contains the following entry fields.
These are used to set up the message box that pauses program execution, appears on
the screen, and waits for the response of the user.

Enter the message displayed on the message box.
This area provides the Button 1, Button 2, Button 3, and Button 4 areas.

This area provides the following entry fields.
L abel Label or name of the button placed at the left side

Selected Variable name used in the test definition. The variableis used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

L abel Label or name of the button placed at the second from the left

Selected Variable name used in the test definition. The variableis used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

L abel Label or name of the button placed at the second from the right

Selected Variable name used in the test definition. The variableis used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

L abel Label or name of the button placed at the right side

Selected Variable name used in the test definition. The variableis used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.
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Application Test Definition
Data Store Control

Data Sore Control

This component enables or disables the test record of the application test or the
classic test used in the test definition.

Enable Creating Test Result Record
Checking this box enables the test record.

If you do not use this component, the test record is enabled.

This component cannot control the test record of the test definition. The test record
isaways enabled for the test definition. For the test result output of the test
definition, see “ Test Output” on page 3-14.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 3-39



Application Test Definition
Command Execution

Command Execution

This component provides the setup editor that contains the following entry fields.
This component is used to execute the specified execution file (EXE file) and obtain
the execution results. For the fields to enter a variable name, only the variable name
defined in the test definition can be entered. See “Using Command Execution” on

page 3-42.
Command File name of the Windows execution file (EXE file) to execute.
Filename
Argument Argument or parameter to passto the EXE file.
Write Type Type of datato write. String (string data) or List (vector data).
e String

Displays the Write String area used to specify the string data to write. Up to 20
string data can be defined.

+ List
Displaysthe Write List areathat provides the following entry fields.
Values Variable name of the List data to be passed to the EXE file.

Format
If you do not specify Format, this function passesthe List datato
the EXE file. To pass adatain the List data, enter the keyword to
specify the element. See “Defining Format Field” on page 3-45.
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Command Execution

Read Type Type of datato read. String (string data), Value (numeric data), List (vector data), or
None (no response).
String
Displays the Read String area that provides the following entry fields.
Result Numeric variable name. Used to store the execution result.
Sring String variable name. Used to store the returned value.
Length
Actually Read Numeric variable name. Used to store the byte length of the
returned value.
Value

Displays the Read Value area that provides the following entry fields.

Result Numeric variable name. Used to store the execution result.
Value Numeric variable name. Used to store the returned value.
List

Displaysthe Read List areathat provides the following entry fields.

Result Numeric variable name. Used to store the execution result.
Values Vector variable name. Used to store the returned value.
None

Thistypeisfor the EXE file without response or datato read.
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NOTE

Application Test Definition
Using Command Execution

Using Command Execution

Windows execution file (.exe file) can be executed by using the Command
Execution component. Most execution files will need parameters to be sent or
returned. The parameters will be variables that can be defined on the Test
Specification tab screen or the Local Variable Definition component on the Test
Contents tab screen.

This section describes how to enter the windows execution file.

* “Command Parameters’

» “Defining Numeric/Vector Input Parameter”
» “Defining String/Numeric Input Parameters”
» “Defining Numeric Output Parameter”

» “Defining Vector Output Parameter”

» “Defining String Output Parameter”

» “Defining Format Field”

Command Parameters

The Windows Command Execution component supports one input variable and one
output variable. To use multiple string input parameters or multiple numeric input
parameters, set the variable as shown below. Multiple vector input parameters and
multiple output parameters are not supported.

» If the command requires multiple string input parameters, use string variables.
In the Windows Command Execution component, set the Write Type to String.
Up to 20 string data can be defined.

» If the command requires multiple numeric input parameters, use numeric
variables and set the Write Type to String. To enter the numeric variable name,
use the string built-in function. For example, enter st ri ng( Rz) to setthe Rz
numeric variable.

» If the command requires both numeric and string input parameters, use numeric
and string variables respectively, and set the Write Type to String.

Before calling the command, enter the value to the input variable by using the
ASSIGN statement.
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Application Test Definition
Using Command Execution

string built-in function

The string built-in function is used to translate a numeric expression to a string
value. Be careful about the argument for this function. If it isanumeric variable
defined with the numeric-symbol assignment, the string function execution result
will be the symbol assigned to the numeric value, not the string value just trand ated
from the numeric value. The numeric-symbol assignment is defined in the “ Test
Specification” on page 3-5.

For the following example setup of the numeric-symbol assignment,
st ri ng( Mode) execution result at Mode=0 is the string OFF, not the string O.

Parameter Mode, Value=0, Symbol=OFF

Defining Numeric/Vector I nput Parameter

1. Define avector variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Write Type to List in the Windows Command Execution component.
3. Enter the variable name in the Values field of the Write List area.

For the numeric parameter, a data element of vector variableis used to store the
data for the parameter. Specify the data by using the Format field. For example,
enter { 0} to specify the datain the first element of the vector variable. For the

Format field, see “Defining Format Field” on page 3-45.

For the vector parameter, ignore the Format field.

Defining Sring/Numeric I nput Parameters

1. Define string or numeric variables in the Test Specification tab screen or the
Local Variable Definition component in the Test Contents tab screen.

2. Set the Write Type to String in the Windows Command Execution component.
3. Add alinein the Write String area.
4. Enter the variable name for the first input parameter in the first line.

If the command needs multiple input parameters, add a line and enter the
variable name for the variable in the added line. Then observe the order of
parameters.

To enter anumeric variable name, use the string built-in function. For example,
enter st ri ng( Rz) to set the Rz numeric variable.
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Defining Numeric Output Parameter

1. Define anumeric variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Read Type to Vaue in the Windows Command Execution component.
3. Enter the variable namein the Value field of the Read Value area.

The Result field can be blank or the name of another numeric variable defined in the
Test Specification or Local Variable Definition. The variable will be used to receive
the command execution result.

Defining Vector Output Parameter

1. Define avector variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Read Typeto List in the Windows Command Execution component.

3. Enter the variable namein the Values field of the Read List area

The Result field can be blank or the name of a numeric variable defined in the Test
Specification or Local Variable Definition. The variable will be used to receive the
command execution result.

Defining Sring Output Parameter

1. Defineastring variablein the Test Specification tab screen or the Local Variable
Definition component of the Test Contents tab screen.

2. Set the Read Type to String in the Windows Command Execution component.

3. Enter the variable name in the String field of the Read String area.

The Result field and the Length Actually Read field can be blank or the name of a
numeric variable defined in the Test Specification or Local Variable Definition. The
variable will be used to receive the command execution result or the length of the
returned string data.
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Application Test Definition
Using Command Execution

Defining Format Field

The Format field requires a keyword to specify adatain vector variable. The
keyword must have the style such as {I,A:F}. where,

I Index used to specify the element. Integer, O or positive number.
Mandatory. 0 specifies the first element.

A Character length of the specified data element. Positive integer for
right-aligned, or negative integer for left-aligned. If thisvalueisnot set,
the length is not specified (no limit).

F Style of the data. See Table 3-1. If thisvalueisnot set, G is selected..

Followings are the example formats.

» {0,5:E} First element, five characters, exponential notation

* {1,10} Second element, 10 characters, genera

o {2:x} Third element, no limit for length, hexadecimal numeric
» {3} Fourth element, no limit for length, general

Available F values

F M eaning F M eaning
Corc | Circulation Norn | Numeric
Dord | Decima numeric Porp | Percent
Eore | Exponential notation Rorr | Roundtrip
Forf Fixed point X orx | Hexadecimal numeric
Gorg | Genera
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Setup Example

The following example setup is used to execute a PlsdivM easureld command that
has two numeric inputs and four numeric outputs.

ranging and id_range are numeric variables used for the input parameters,

read data isavector variable used for the output parameters, and PassFail isa
numeric variable used to store the command execution result. They must be defined
in the Test Specification tab screen or the Loca Variable Definition component on
the Test Contents tab screen. Input parameter values must be set to the variables
before executing the command. Four datawill be assigned to read _data in sequence.

Figure 3-7 Windows Command Execution Setup Example

Windows Command Execution |
Ccommand Filename: I!Program Files¥aqilent¥PLSDIVEPLSDIVE e¥ TISExe¥PlsdivMeasurald. exe g Browse. .. |
Argument: I ﬁ
Write Type: & Siring  List
Read Type: " String " Yalue & List " None

Write String |

Add Delete | Up | D |

© [string(ranging) =
IS |string(id_range) =

Read List

Result: IPassFaiI 'I values: Iread_data vl
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Function Details

This chapter explains the following measurement functions of Agilent B1500 and

EasyEXPERT.

* “I/V Sweep Measurement”

o “Multi Channel I/V Sweep Measurement”
o “1/V-t Sampling Measurement”
e “C-V Sweep Measurement”

* "“SPGU Module’

* “Sweep Abort Function”

e “Standby Function”

» “BiasHold Function”

* “Current Offset Cancel”

e “SMU CMU Unify Unit”

* "Atto Sense and Switch Unit”

e “SMU/PG Selector”

*  “Module Selector”

e “UltraHigh Current Expander/Fixture”
e “HVSMU Current Expander”

e “UltraHigh Voltage Expander”
» “SMU Ranging Mode”

e “SMU Compliance”

e “SMU Pulse’

* “SMU Measurement Time"

e “SMU Filter

e “SMU Series Resistor”

* “Interlock Function”

* “Auto Power Off Function”

» “Initial Settings’
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Figure4-1

Function Details
I/V Sweep Measurement

|/V Sweep M easurement

For the 1/V sweep measurements, sweep source channels (SMU) perform staircase
sweep output of voltage or current, while monitor channels (SMU) measure voltage
or current for each sweep step. According to the output function, the following
measurements are available. See Figure 4-1 for the SMU output function.

» “Basic Sweep Measurement” by using VAR function
» “Subordinate Sweep Measurement” by using VAR1 and VAR2 functions

» “Synchronous Sweep Measurement” by using VAR and VARY’ functions,
VAR2 function is also available

»  “Pulsed Sweep Measurement”

Thisisthe basic, subordinate, or synchronous sweep measurement using a pulse
output SMU. Only one pulse output SMU is available.

SMU Output Function and Sweep Output

VAR1

VAR2 j—,—,i

VART’

Available M easurement Resour ces

SMUs and SPGUs can be used. SMU can be constant voltage/current source or
pul se voltage/current source and perform voltage/current measurement. SPGU can
be pulse voltage source. See“ SPGU Modul€e” on page 4-27 for using the SPGU.

If multiple measurement channels are used, the channels perform measurement in
order. See “Multiple Measurement Channels’ on page 4-69.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 4-3



Figure4-2

Function Details
I/V Sweep Measurement

Output Range

Output range of the sweep source channel is automatically set to the following
range.

e minimum range covers al sweep output valuesin Linear sweep.
e minimum range covers al sweep output valuesin Log voltage sweep.

» optimum range for output value every sweep step in Log current sweep.

Basic Sweep M easurement

Basic sweep measurement uses the primary sweep source (VAR1L). You can select
any combination of Direction and Linear/Log as shown in Figure 4-2.

» Direction

« Single source channel sweeps the output from user specified start value to
stop value.

« Double source channel sweeps the output from user specified start value to
stop value, then from stop value to start value.

» Linear/Log

¢ Linear staircase

* Logarithmic staircase
Saircase Sweep Outputs

Single Sweep Double Sweep

Linear Sweep JJI ﬁ
Log Sweep J J_H_HL

See “1/V Sweep” on page 2-4 for the GUI.
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I/V Sweep Measurement

The following setup is required to perform the basic sweep measurements.

1. Select the following on the Channel Setup tab screen.

* Sdect VARL for the Function of the SMU used for VARL.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPUL SE for voltage monitor SMU. Pulseis available only for one SMU.

2. Specify the following parameters for VAR on the Measurement Setup tab

screen.
Direction

Linear/Log

Sart

Sop

Sep, No of Sep

Compliance

Pwr Comp

Hold

Delay

Single or double sweep.

Linear or logarithmic sweep. For logarithmic sweep, the
number steps in one decade is 10, 25, or 50.

Start value of sweep. Allowable range of start depends on
output range of sweep source. For logarithmic sweep, start
must not be zero.

Stop value of single sweep or turning back value of double
sweep. Allowable range of stop depends on output range of
sweep source. For logarithmic sweep, stop must have same
polarity as start, and must not be zero.

For linear sweep, step is step increment of sweep. No of Sep
is calculated from start, stop, and step.

For logarithmic sweep, step isinvalid. Number of sweep
stepsis calculated from start, stop, and number of stepsin
one decade.

Calculated number of steps must bein range: 1 to 10001.

Compliance value of sweep source. Allowable range of
compliance depends on the compliance range of sweep
source.

(Optional) Power compliance value of sweep source.
Allowable range depends on power compliance range of
Sweep source.

Time required for DUT to settle after forcing start value.
0 to 655.35 swith 10 msresolution.

Time required for DUT to settle after stepping the output.
0 to 65.535 swith 100 usresolution.
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I/V Sweep Measurement

Figure4-3 Basic Sweep M easurement
Qutput Voltage Th : hold time
or Current Td : defay time
N : #umber of steps
Stop Value T N
Th+Td . . Td

Single Sweep e 3

8]

Start Value + ¢

Time

} X

Trigger Completion
Th: hold time
Output Voltage Td : delay time
or Current Nt number of steps
Td
Stop N > N4
Value T
Double Sweep s % Td
LTt o T4
0 1 2N
Start T
Yalue
Time
X f
Trigger Completion

Subordinate Sweep M easurement

For subordinate sweep measurement, you set up a secondary sweep source (VAR?2)
in addition to aprimary sweep source (VARL). After VAR1 sweep is completed, the
output of VAR2 sweep source isincreased or decreased by the specified step value,
then the VAR1 sweep sourceis swept again.

Only the linear single sweep is available for the VAR2.

The following setup is required to perform the subordinate sweep measurements.
See “1/V Sweep” on page 2-4 for the GUI.

1. Select the following on the Channel Setup tab screen.
* Sdect VARL for the Function of the SMU used for VARL.
* Seect VAR2 for the Function of the SMU used for VAR2.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPULSE for voltage monitor SMU. Pulseis available only for one SMU.
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Function Details
I/V Sweep Measurement

2. Set the VAR1 channel as shown in “Basic Sweep Measurement”.
3. Specify the following parameters for VAR2 on the Measurement Setup tab

screen.

Sart Start value of secondary sweep. Allowable range of start
depends on the output range of secondary sweep source.

Sop Stop value of secondary sweep iscalculated from start, step,
and number of steps. Allowable range of stop depends on
the output range of secondary sweep source.

Sep Step increment of secondary sweep.

No of Step Number of secondary sweep steps (N,). 1 to 1001.

Then, the following formula must be satisfied.
1 <Nj x N, <128128 (N4: number of primary sweep steps)

Compliance Compliance value of secondary sweep source. Allowable
range of compliance depends on the compliance range of
secondary sweep source.

Pwr Comp (Optional) Power compliance value of secondary sweep
source. Allowable range of power compliance depends on
the power compliance range of sweep source.

Figure4-4 Subordinate Sweep M easurement
Stop value |...
Primary

Sweep Source 0 (———
Start value |-
Stop value |---

Secondary

Sweep Source 0

Start value |... Step value
f

Time

T T

Sweep Start Completion
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Function Details
I/V Sweep Measurement

Synchronous Sweep M easurement

For synchronous sweep measurement, you set up a synchronous sweep source
(VARLY) in addition to a primary sweep source (VARL).

The relationship between the output of primary and synchronous sweep sourcesis
determined by the following equation:

synchronous output = primary output x ratio + offset

The synchronous output determined by above equation must not exceed the output
range of synchronous sweep source.

The following parameter settings are effective for the VARL' sweep source.

» Direction (Single or Doubl€)
» Linear/Log

The following setup is required to perform the synchronous sweep measurements.
See “1/V Sweep” on page 2-4 for the GUI.

1. Select the following on the Channel Setup tab screen.

* Sdect VARL for the Function of the SMU used for VARL.
* Seect VARYT’ for the Function of the SMU used for VARY'.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPULSE for voltage monitor SMU. Pulseis available only for one SMU.

Mode of VAR1 and VAR must be the same, voltage or current.
2. Set the VAR1 channel as shown in “Basic Sweep Measurement”.

3. Specify the following parameters for VAR1' on the Measurement Setup tab
screen.

Offset Offset between outputs of primary and synchronous sweep
sources.

Ratio Ratio between outputs of primary and synchronous sweep
sources.

Compliance Compliance value of synchronous sweep source. Allowable

range of compliance depends on the compliance range of
synchronous sweep source.

Pwr Comp (Optional) Power compliance value of synchronous sweep
source. Allowable range of power compliance depends on
the power compliance range of synchronous sweep source.
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Figure 4-5 Synchronous Sweep M easurement

Output Voltage
ar Cyrrent

Synchronous Source
Stop Value i

Primary Source
Stop Value

Synchronous Source
Start Value h

Primary Source
Start Value

(S —

Time

Pulsed Sweep M easurement

For a sweep measurement, a sweep or constant source SMU can be a pulse source.
But only one SMU can be a pulse source.

Figure 4-6 shows the relationship between pul se source and other sources. Each step
of the primary sweep source is synchronized with output of the SMU pulse source.
M easurements are made during the pulse output. For the pulsed sweep
measurement, the delay time cannot be set.

The following setup is required to perform the pulsed sweep measurements. See
“1/V Sweep” on page 2-4 for the GUI.

1. Select the following on the Channel Setup tab screen.

* Sdect VARL for the Function of the SMU used for VARL.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPULSE for voltage monitor SMU. Pulseis available only for one SMU.

2. Set the VAR1 channel as shown in “Basic Sweep Measurement”.

3. Specify the following parameters for the SMU Pulse on the Measurement Setup
tab screen.
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Function Details
I/V Sweep Measurement

Period SMU forces the next pulse after specified pulse period.

Width Time from when SMU output starts to change from base
value to time when SMU starts to return from peak value.
M easurements are made while the peak value is output.

Base The base output value of the SMU pulse.

Pulse peak value  Pulse peak value depends on the Function setting of the pulse source SMU. See

Table 4-1.
Table 4-1 Pulse Peak and Function
Function Pulse peak
CONST Source value in the Constants area
VARL Calculated from the Start, Stop, Step values of the VAR1.
VAR2 Calculated from the Start, Stop, No of Step values of the
VAR2.
VARL’ Calculated from the Start, Stop, Step values of the VAR1L
and the Offset and Ratio values of the VARL'.
Measurement Only one SMU can be used for the measurement channel.

channel . .
The measurement channel always uses the compliance range which coversthe

setting compliance value. The Range button in the Measurement Setup is not
available.
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Figure 4-6 Pulse Source and Other Sources

Pulsed on Primary Source Unit (VART)

Primary

Synchronous

Function Details
I/V Sweep Measurement

Pulsed on Synchronous Source Unit (VART)

m m Primary —,—,—|—,—,—|—
AAAJAAAAFAAAL444444444T444F444L7 Synchronous 4JATAJAWAJAWAAAAAAAJATAJAALA(AL,

Secondary

Secondary

Constant

Pulsed on Secondary Source Unit VAR

Primary 444J444J444l44444444j444J44417

‘ Constant \ \

Pulsed on Constant Source Unit

Primary —‘ \—‘ L

Synchronous Synchronous

Secondary

Secondary

Constant

Figure4-7 SMU Pulse
sten value of
Pulse Sweep Source

Sweep Source \_ B

base valye |-

| constart [ LTI JTLTTTL

hotd time, oulse period

aulse width

-—

outout value of
Pulse
Constant Source

bhase valve |.

constant source |
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Figure 4-8

Function Details
Multi Channel I/V Sweep Measurement

Multi Channel I/V Sweep M easurement

Multi Channel 1/V Sweep measurement is similar to I/V Sweep measurement.
Changes from I/V Sweep are listed bel ow.

* All SMU can be set to the VAR1 sweep source (up to 10 channels)

e All SMU can be set to the pulse source (up to 10 channels)
e Thereisno restriction for the VAR1 output mode, voltage or current
*  VAR1' sweep modeisnot available

The timing of the sweep output and measurements are shown in Figure 4-8. The DC
output channels start to output in the order in which they are listed on the Channel
Setup screen. If multiple measurement channels are used, the channels perform the
measurements in order. See “Multiple Measurement Channels” on page 4-69.

If multiple pulse output channels are used, the DC output channels start to output in

the or

der in which they are listed on the Channel Setup screen, and then the pulse

output channels start to output simultaneously. And the all measurement channels
perform measurements simultaneously.

Multi Channel I/V Sweep M easurements using High-Resolution A/D Converter
Voltage or current = Measurement
Stop value Start measurement
0 1 —\/ L"‘ Primary sweep source
Start value | - Delay time
Hold time
Voltage or current
Stop value Delay time
04— Second sweep source
Start value =
Voltage or current
Stop value -
04— Tenth swelep source
Start value - -
Time
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NOTE

Figure 4-9

Function Details
I/V-t Sampling Measurement

|/V-t Sampling M easurement

For the 1/V-t sampling measurements, source channels (SMU) force constant current
or voltage, and monitor channels (SMU) measure current or voltage changes at a
device under test (DUT) with a specified sampling interval.

Available M easurement Resour ces

SMUs and SPGUs can be used. SMU can be constant voltage source or constant
current source and perform voltage measurement or current measurement. SPGU
can be pulse voltage source. See “ SPGU Module” on page 4-27 for using the SPGU.

To use the SPGU, the sampling interval must be > 2 ms.

Operation Summary

[/V-t sampling measurement is executed as explained below. See Figure 4-9. In this
example, the Output Sequenceis set to SEQUENTIAL. And the bias hold function
sets the bias to the Base value.

Operation Summary

Voltage or current

Source value

Voltage or current

Source value

Base value

Starts sampling ] ) ] ]
Time=Hold time + a Time=Hold time + Interval + b

L

= |Vleasurement

l Channel 1 output il P»l

|

~

-

. A

Interval
Time=0 (origin)

Hold time

Measurement time

Base hold time ‘—'| )

(R
, Channel 2 output \

Time
In thisfigure, a and b in the formula of Time indicate the time from the start of one
point measurement to the start of integration by the A/D converter.
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Function Details
I/V-t Sampling Measurement

. When the Output Sequenceis SEQUENTIAL, source channels start the Source

value output in order, and the last source channel starts the Base value output
(Starts sampling). See “Source Output Sequence and Time Origin” on page
4-18.

When the Output Sequenceis SIMULTANEOQUS, source channels start the Base
value output simultaneously (Starts sampling).

Base valueis available for al output channels for the SIMULTANEOUS mode
and the last source channel for the SEQUENTIAL mode.

Base Hold Timelater, the source channels change the output to the Source value.
The channels keep the value until the end of the sampling measurement.

. Another Hold Time later, the measurement channel starts measurement for the

first sampling point. If multiple channels are used, the channels perform
measurement in order. See “Multiple Measurement Channels’ on page 4-69.

. After that, the following operation is repeated with the specified time Interval.

This operation is repeated until the number of measurement result data reaches
the specified No of Samples of measurement data.

* Measurement channels start measurement if they are ready to measure.
* Measurement channels keep the condition if they are busy.

For the log sampling, the B1500 holds only the data that can be plotted on the
log scale in the same distance as close as possible. Only the held datais counted
in the number of measurement result data.

For the linear sampling with Interval < 2 ms, if the total measurement time runs
over the specified time Interval x No of Samples, the sampling measurement will
be stopped even if the number of measurement result dataisless than the
specified No of Samples.

. The source channels stop the output, and the 1/V-t sampling measurement is

completed.

If the bias hold function is enabled, the source channels force the Base or Source
value.

Time data and index

For the log sampling, the recorded datawill be only the data that can be plotted on
the log scale in the same distance as close as possible. Theindex of the first datais
1. And the index of the following data will increase by 1. For the linear sampling,
see “Time Dataand Index” on page 4-17.
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Function Details
I/V-t Sampling Measurement

Setup Parameters

The following setup is required to perform the 1/V-t sampling measurements. See
“1/V-t Sampling” on page 2-21 for the GUI.

If you set Interval < 0.002 s

Sampling mode must be linear. This setting is not permitted for the log sampling.
Also SPGU isnot available.

All measurement channels must use the high speed A/D converter (ADC). This
setting is not permitted if a measurement channel uses the high resolution ADC.

If the multiple measurement channels are used, all channels perform measurement
inparallel.

If the measurement ranging mode is not the fixed mode, the measurement channels
automatically select the minimum range that covers compliance value set to the
channel.

If the measurement time is expected to be longer than Interval, the measurement
channels automatically adjust the number of averaging samples (ADC settings) to
keep the sampling interval.

1. Select the following on the Channel Setup screen.

« Select SMUs used for constant voltage sources or constant current sources.

e Select V. or COMMON for Mode of current monitor SMU, or | for voltage
monitor SMU.

2. Specify the following parameters for the SMU in the Sampling Parameter area
on the Measurement Setup screen.

Linear/Log Sampling mode. LINEAR for linear sampling. LOG10,
LOG25, LOG50, LOG100, LOG250, or LOG500 for
logarithmic sampling.

For the logarithmic sampling, the number after LOG
indicates the number of measurement datain a decade. For
example, LOG10 mode is used to get 10 data/decade.

I nterval Interval of the sampling, in seconds. 0.002 to 65.535 s,
0.001 sresolution.

Interval < 0.002 sin 0.00001 sresolution is also available
for the linear sampling. It must satisfy the following
formula. See NOTE above.
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I/V-t Sampling Measurement

No of Samples

Total Sampling
Time

Output
Sequence

Hold Time

Base Hold
Time

Interval > 0.0001 + 0.00002 x (number of measurement
channels- 1)

Number of samples. Integer. 1 to the following value.
For linear; 100001 / (number of measurement channels)

For logarithmic: 1 + (number of datafor 11 decades)

Thisfield just displays the total sampling time that is the

time from the measurement start time for the first point to
the end of sampling measurement. It does not include the
hold time.

Total Sampling Time = Interval x No of Samples

Source output sequence. SIMULTANEOUS or
SEQUENTIAL. See* Source Output Sequence and Time
Origin” on page 4-18.

Time since the Source value output until the first sampling
point, in seconds. 0to 655.35 s, resolution 0.01 s.

The following values are also available for Interval < 0.002
s. |Hold Time| will be the time since the sampling start until
the Source value output.

- 0.09to - 0.0001 s, resolution 0.0001 s.

Hold time of the Base value output until the Source value
output, in seconds. 0 to 655.35 s, resolution 0.01 s.

3. Specify the following parameters for the SMU in the Constants area on the
M easurement Setup screen.

Base, Source Base or Sourcevalue, inV or A.
Base value is available for all output channels for the
SIMULTANEOUS mode and the last source channel for the
SEQUENTIAL mode.
Compliance Compliance value, in A or V.
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Figure 4-10

Function Details
I/V-t Sampling Measurement

Time Data and I ndex

To obtain the time data, enter avariable name (e.g. Time) into the Time Stamp
Name field of the Channel Setup screen. The time data can be obtained after the
linear sampling measurement is executed, and can be expressed by the following
formula

Time=Hold Time + Interval x [(Index — 1) + N] +

Time: Variable name set to the Time Stamp Name field of the Measurement
Setup screen. Time datais returned.

Index : Variable name set to the Index Name field of the Measurement Setup
screen. Dataindex is returned. Maximum value is 2147483647.

Interval : Sampling interval. Defined in the Measurement Setup screen.
Hold Time: Hold time. Defined in the Measurement Setup screen.

N : Number of samplings performed while one point measurement was
executed. Thisvalueis 0 if the sampling interval islonger than the
measurement time.

o Time from the start of one point measurement to the start of
integration by the A/D converter.

If the sampling interval is longer than the actual measurement time, measurement
channels repeat measurement with the specified sampling interval. However, if the
sampling interval is shorter than the measurement time, the measurement interval
will beintegral multiples of the specified sampling interval. Example for Hold Time
=10 ms, Interval=5 ms, and the following Time values is shown in Figure 4-10. In
this case, N=3.

e Time (for Index=1) =10ms=10+5x [(1 - 1) + O] ms
» Time (for Index=2) =30ms=10+5x [(2—- 1) + 3] ms

Sampling and M easurement Timing

Interval

pasehoimed 4 4 4 b b4

and Hold time Measurement time

>

d d

Time (at Index=1) Time (at Index=2)

Time

a, b: Time from the start of measurement to the start of integration
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I/V-t Sampling Measurement

Source Output Sequence and Time Origin

When the Output Sequence is SEQUENTIAL, source channels start output in order.
The order istop to bottom of the channels defined in the Channel Setup screen. The
order of bias stop is bottom to top.

When the Output Sequenceis SIMULTANEQUS, source channels start output
simultaneously. And the source channels stop output at the same time.

The time origin is when the source output value is changed from Base to Source.

Sampling Completion

The sampling measurement compl etes when one of the following conditionsis
satisfied:

» Theevent of the stop condition occurs. See “ Stop Condition” on page 4-18.

» The measurement channels obtain the specified number (No of Samples) of
measurement data

» Thetotal measurement time runs over the time Interval x No of Samples for the
linear sampling with Interval <2 ms.

» The Stop button is clicked.
* Anemergency condition occurs on the B1500.

* Interlock terminal is opened when a channel isin the high voltage output status.

Sop Condition

The stop condition is defined by using the Stop Condition fields on the
Measurement Setup screen. This function stops the measurement as shown below.

1. Comparesthe value of parameter set to the Name field and the value defined in
the Threshold field.

2. Counts how many times the selected Event occurs.

3. When the count reaches the value defined in the No. of Eventsfield, samplingis
stopped immediately.

For the setup parameters of the stop condition, see “1/V-t Sampling” on page 2-21.
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C-V Sweep M easurement

For the C-V sweep measurements, the multi frequency capacitance measurement
unit (MFCMU) forces AC signal, performs staircase sweep output of DC bias
voltage, and measures impedance for each sweep step.

Available M easurement Resour ces

MFCMU can be used for the C-V sweep measurements. For the DC bias output over
+ 25V, usethe SMU CMU Unify Unit (SCUU) and SMUs. This expands the
voltage range up to + 100 V. Or use the high voltage bias- T and HV SMU to expand
the voltage range up to + 3000 V.

Setup Parameters

The following setup is required to perform the C-V sweep measurements.See “ C-V
Sweep” on page 2-26 for the GUI.

1. Set the following on the Channel Setup tab screen.
e SetV Name of the CMU.

« If you use a constant current or voltage source, set Mode (1, V, or
COMMON) and V Name or | Name of the SMU.

2. Specify the following parameters for the CMU on the M easurement Setup tab
screen.

Model, x Name  Measurement parameters. See Table 4-2.
Direction Single or double sweep.

Linear/Log Linear or logarithmic sweep. For logarithmic sweep, the
number steps in one decade is 10, 25, or 50.

Sart, Stop Sart isthe DC bias sweep start value. Sop is the stop value
of single sweep or turning back value of double sweep. The
CMU canforceupto+ 25 V.

If the SCUU (SMU CMU Unify Unit) is used, up to + 100
V output is available.

If the high voltage bias-T and HVSMU are used, up to
+ 3000 V output is available.
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Function Details

C-V Sweep Measurement

Sep, No of Sep

FrequencyList

F Name
AC Level
Mode, Factor

Hold

Delay

Sep is step increment of sweep. No of Sep valueis
calculated from start, stop, and step. Calculated number of
steps must be in range: 2 to 1001.

AC signal frequency. 1 kHz to 5 MHz. Resolution: 6 digits.
Variable name of frequency list.
AC signa level. 10 mV to 250 mV, 1 mV resolution.

One of the following is used for setting the measurement
time.

For Mode=AUTO, you set the number of samples used for
averaging of the measurement data. The initial valueisthe
predefined constant, and you set the multiple number to
Factor. Available Factor values are 1 to 1023, integer.

For Mode=PL C, you set the integration time of the A/D
converter. Theinitial valueis 1 power line cycle (20 msfor
50 Hz, 16.7 msfor 60 Hz), and you set the multiple number
to Factor. Available Factor values are 1 to 100, integer.

Hold time. Thetimerequired for DUT to settle after forcing
start value. 0 to 655.35 swith 10 ms resolution.

Time required for DUT to settle after stepping the DC bias
output value. 0 to 65.535 swith 100 us resolution.

For a more accurate measurement, perform correction data measurement at the
measurement frequency before starting the capacitance measurement.

If the measurement frequency is not included in thelist of default frequencies below,
click the Advanced Options... button and set the measurement frequency on the
Frequency area of the Advanced Options for CMU Calibration window.

Default frequencies:

1k, 2k, 5k, 10k, 20k, 50k, 100k, 200k, 500k, 1 M, 1.2 M, 1.5M,2 M, 25 M,
27M,3M,32M,35M,3.7M,4M,42M,45M, 5MHz

4-20
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Table 4-2

MFCMU M easurement Parameters

Function Details
C-V Sweep Measurement

Primary Parameter

Secondary Parameter

R (resistance, Q)

X (reactance, Q)

G (conductance, S)

B (susceptance, S)

Z (impedance, Q)

0 (phase, radian)

Z (impedance, Q)

0 (phase, degree)

Y (admittance, S)

0 (phase, radian)

Y (admittance, S)

0 (phase, degree)

Cp (parallel capacitance, F)

G (conductance, S)

Cp (parallel capacitance, F)

D (dissipation factor)

Cp (parallel capacitance, F)

Q (quality factor)

Cp (parallel capacitance, F)

Rp (parallel resistance, Q)

Cs (series capacitance, F)

Rs (series resistance, Q)

Cs (series capacitance, F)

D (dissipation factor)

Cs (series capacitance, F)

Q (quality factor)

Lp (paraléel inductance, H)

G (conductance, S)

Lp (paraléel inductance, H)

D (dissipation factor)

Lp (pardlel inductance, H)

Q (quality factor)

Lp (paraléel inductance, H)

Rp (parallel resistance, Q)

Ls (seriesinductance, H)

Rs (series resistance, Q)

Ls (seriesinductance, H)

D (dissipation factor)

Ls (seriesinductance, H)

Q (quality factor)
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Function Details
C-V Sweep Measurement

M easurement Parameters

MFCMU performs impedance measurement, calcul ates parameters shown in Table
4-2, and returns the calculated data. A combination can be selected for the return
data. For example and for your reference, select the parallel measurement mode
(Cp-G or Cp-D) for the low capacitance measurements (100 Q or more of
impedance), and sel ect the series measurement mode (Cs-Rs) for the high
capacitance measurements (100 Q or less of impedance). Because the low
capacitance yields high reactance, which implies that the effect of the parallel
resistance has relatively more significance than that of series resistance.

About | mpedance M easurements

All circuit components, resistors, capacitors, or inductors, have parasitic
components, for example unwanted resistance in capacitors, unwanted resistance in
inductors, and unwanted inductance in resistors. Thus simple components should be
model ed as complex impedances.

Impedance definitions and vector representation of impedance are shown in Figure
4-11. Impedance Z isthe total opposition that acircuit or device offersto the flow of
alternating current at agiven frequency. Z containsareal and an imaginary part, and
it isexpressed in rectangular form asresistance R and reactance X, or in polar form
as magnitude of impedance |Z| and phase 6.

In addition to these parameters, the quality factor Q and dissipation factor D are
used to describe the quality of components.

Impedance and Parameter Calculation
I Imaginary part

— 7} =t
N— ( I current (A) 7
v V: voltage (V) iX 12|
Z=R+X = |Z| L6
Z: impedance (Q) 0
|Z]=/(R®+X") R: resistance (Q) R Real part
IX| X: reactance (Q)
o=tan™' &) 0. phase (degree or radian)
5 Rs: series resistance (Q)
R=Rs f. frequency (Hz)
X=2mfL L: inductance (H)
1] Q: quality factor
=5 =% D: dissipation factor
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Function Details
C-V Sweep Measurement

For your reference, select the parallel measurement mode (Lp-G, Lp-D, or anything)
for the high inductance measurements (100 Q or more of impedance), and select the
series measurement mode (Ls-Rs, or anything) for the low inductance
measurements (100 Q or less of impedance). Because the reactance of high
inductance at a given frequency isrelatively high (compared with that of alow
inductance), so the parallel resistance becomes more significant than the series
component.

Admittance and Parameter Calculation

Y=—-=G+B = Y|4

z
[Y|= /—(G2+Bz) G Real part
Y: admitance (S) ¢
p=tar (IBly=_9 | G: conductance (S) ,
G B: susceptance (S) iB
B= 2 fC ¢: phase (degree or radian) [Y]
f.  frequency (Hz)
0=1_=@ C: capacitance (F)
D G Q: quality factor Imaginary part
1 D: dissipation factor
G_R_p Rp: parallel resistance (L)

In some case, the reciprocal of impedance (admittance) Y isused. Figure 4-12
shows the vector representation of admittance. Asimpedance Z, Y containsareal
and an imaginary part, and is expressed in rectangular form as conductance G and
susceptance B, or in polar form as magnitude of admittance |Y | and phase ¢.
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Function Details
C-V Sweep Measurement

Four-Terminal Pair Configuration

Generally, any mutual inductance, interference of the measurement signals, and
unwanted residual factorsin the connection method incidental to ordinary
termination methods will have significant effects on the measurements, especially at
a high frequency. The MFCMU employs the four-terminal pair (4TP) measurement
configuration which permits easy, stable, and accurate measurements and avoids the
measurement limitations inherent to such factors.

Figure 4-13 shows the four-terminal pair measurement principle. The measurement
terminals consist of the following four coaxial connectors.

* Hcur: High current

» Hpot: High potential

* Lpot: Low potential

* Lcur: Low current

Four-Terminal Pair M easurement Principle
Multi frequency CMU

[ [ Outer shield or Guard
Hecur

»ﬁ @ O X— =
Hpot /H( o

System ground | Ve W J

Vx_
DuUT

Auto balance bridge< LPOtW

l—%‘\ANL@ Lcur . Ix Virtual ground
\/

-

The four-terminal pair measurement method has the advantage in both low and high
impedance measurements. The outer shield conductors work as the return path for
the measurement signal current (they are not grounded). The same current flows
through both the center conductors and outer shield conductors (in opposite
directions), but no external magnetic fields are generated around the conductors (the
magnetic fields produced by the inner and outer current completely cancel each
other). Because the measurement signal current does not develop an inductive
magnetic field, test leads do not contribute additional errors due to self or mutual
inductance between the individual leads.
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To realize accurate measurements using the four-terminal pair measurement
method, the following connection tips are important. See Figure 4-13 and Figure
4-14.

The signal path from MFCMU to DUT must be as short as possible.

Thefour-terminal pair configuration must be extended as close as possible to the
DUT.

The outer shield conductors must be connected together at the extended cable
ends. Then take care of contacts. They must be electrically isolated.

Thisisthe same as connecting the CMU return terminal s of the atto sense/switch
unit (ASU) or the guard switch unit (GSWU).

The signal path from the shield ends to the DUT must be as short as possible.

If it is possible, make protective guard (plate, shield, or anything) around the
DUT, and connect it to the outer shield conductor of the four-terminal pair
configuration. This minimizes the effects of stray capacitance and electrical
noise. Then take care of contacts. The guard must be electrically isolated.

The Low (Lcur, Lpot) terminal must be prevented from stray capacitance and
guard capacitance. If the measurement terminal has to be connected to the wafer
chuck, use the High (Hcur, Hpot) terminal to connect to the wafer chuck.

Error Correction

The MFCMU is equipped with the error correction function used to realize accurate
impedance measurements. The correction function minimizes the effects of the error
elementsin the extension cables and the DUT interface such as manipulator and
probe card.

Phase compensation

Corrects phase error caused by extending measurement cabl es.

Open correction

Corrects for stray admittance. Effective for high impedance measurements.
Short correction

Corrects for residual impedance. Effective for low impedance measurements.
Load correction

Corrects any error by using the working standard.
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Function Details
C-V Sweep Measurement

The MFCMU will internally perform the error correction for the CMU cables and
CMU accessories that keep the four-terminal pair configuration.

For the measurements for evaluating DUT against a working standard, perform the
open/short/load correction.

However, you have to consider that some parasitic remain in measurement path
even after performing corrections. To minimize the influence of parasitic, make the
signal path from the shield endsto the DUT as short as possible.

To perform the phase compensation and error correction, see“CMU Calibration” on

page 1-60.

Error Correction

Multi frequency CMU

o

Hecur

Outer shield

\
)

\/

Hpot W

System ground ‘

WV

Auto balance bridge "t
T —
I

Lpot /™
\./

A

Virtual ground |
Leur / ﬂ

\/

%7 Connection

4-terminal pairs

2-terminal

Error correction internal

external (Open/Short/Load)
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Function Details
SPGU Module

SPGU Module

Only for the B1500A. High voltage SPGU is a pul se generator modul e designed for
semiconductor parametric test applications and provides the following key
functions. The SPGU can be controlled by using the SPGU Control classic test or
the SPGU setup function in the I/V Sweep, Multi Channel I/V Sweep, I/V List
Sweep, and 1/V-t Sampling classic tests.

Number of output channels: 2 channels per module

Output impedance: 50 O

Output level: 0to + 40 V (open load), + 20 V (50 Q load)

SPGU operation mode (effective for al channelsinstalled in B1500A):

PG (pulse generator) or ALWG (arbitrary linear waveform generator)
Channel output operation mode:

Free run, duration, or pulse count (PG mode)/sequence count (ALWG mode)
Free run modeis not available for the SPGU Control classic test.

PG output mode:

2-level pulse or 3-level pulse, for each channel

Pulse switch, which is more durable than mechanical relays, and better suited for
frequent switching applications.

Automatic voltage level adjustment by specifying load impedance of DUT

SPGU Simplified Circuit Diagram

50 O Pulse switch 50 O Pulse switch

\o—> Output 1 \O—> Output 2
PG 2-level PG 2-level
or 3-level or 3-level
or or
/\/\ ALWG /\/\ ALWG

To use the SPGU for I/V-t Sampling tests, the sampling interval must be> 2 ms.
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PG Operation Mode

In the PG mode (pul se generator operation mode), the SPGU outputs 2-level or
3-level pulse voltage as shown in Figure 4-16.

The SPGU channels simultaneously start the pulse output and repeat the output
every pulse period. The channels continue the pulse output until the specified time
elapses or the repeat count reaches the specified number of pulses.

For the SPGU pulse setup, see “ SPGU Pulse Setup Parameters’ on page 4-29.

For asummary of source output operation in sweep or sampling measurement mode,
see “Pulse Output Operation Summary” on page 4-31.

Figure 4-16 3-L evel Pulse Output Examples
1V Output of
Primary Pulse
Pulse period
0V/  width
Delay1 _l
Pulse period —— @——
Delay2 J
0V Width2
3-Level pulse output
Output of
Additional Pulse RRY
Output of

Primary Pulse

3V
Pulse period
2V

Width1 4v

~—— Pulse period —— @—— 3V

Output of
Additional Pulse 2V

1V
0V 3-Level pulse output

Delay? Width2
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SPGU Pulse Setup Parameters
The following setup is required to apply the SPGU pulse. See “SPGU Control” on

page 2-61 for the GUI.

1. Set thefollowing for the SPGU channel on the Channel Setup tab screen.

¢ Set theV Name of the SPGU.
¢ Set the Modeto VPULSE. This sets the PG mode. Do not set to ALWG.

2. Onthe SPGU Pulse Setup window, specify the following parameters for the
SPGU. See Figure 4-17 for the pulse setup parameters.

Period

Operation

Type

Base, Peak

Delay

Width

Leading,
Trailing

Pulse period. 20 nsto 10 s, 10 nsresolution.
FREE RUN, PULSE COUNT, or DURATION.

In the FREE RUN mode, the SPGU continues the pulse
output until the measurement is completed or stopped. Not
available for the SPGU Control classic test.

For the PULSE COUNT mode, specify the number of
pulses, within the range of 1 to 1000000. The SPGU will
output the specified number of pulses.

For the DURATION maode, specify the total time to output,
within the range of 1 usto 31556926 s (1 year). The SPGU
will continue to output until the specified time elapses.

2-Level Pulse or 3-Level Pulse. If you choose 3-Level
Pulse, the Additional Pulse fields become effective.

Pulse base and peak voltage. 0to + 40 V (open load), + 20
V (50 Q load), 1 mV resolution.

Delay time. 0 sto Period- 20 ns, 2.5 nsresolution.
Resolution will be set at 10 nsif the pulse transitiontime is
>8us.

Pulse width. 10 nsto Period- 10 ns, 2.5 nsresolution.
Resolution will be set at 10 nsif the pulse transitiontimeis
>8us.

Pulse transition time. 8 ns to 400 ms, 2 ns resolution.
Resolution will be set at 8 nsif the pulsetransitiontimeis >
8 us.
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3. (Optional) Set the Additional Pulse fields for the 3-Level Pulse. 3-level pulses
can be achieved by the Primary Pulse and the Additional Pulse. See Figure 4-16
for examples.

4. OntheLoad Z Setup window, specify the load impedance of the DUT (device
under test). The value is used to adjust the SPGU output voltage automatically.
The SPGU will output the voltage close to the specified Base or Peak value.

5. (Optional) On the Pulse Switch Setup window, enable the pulse switch, whichis
the semiconductor relay mounted in the SPGU output and is used to open the
SPGU channel output. Thisrelay is more durable than mechanical relays, andis
better suited for frequent switching applications.

SW Sync ENABLE (enablesthe pulse switch) or DISABLE (disables
the pulse switch).

Switching of the pulse switch status (open and close) will be
controlled automatically and synchronized with the output
pulse, as shown in Figure 4-17.

Delay, Width, and Normal fields will be active when SW Sync=ENABLE.

Delay Delay time from start of pulse output to changeover of pulse
switch. 0 sto Period- 100 ns, 10 nsresolution.

Width Duration to hold the switched state of the pulse switch.
100 nsto Period- Delay ns, 10 ns resolution.

Normal Switch status in the pul se switch normal condition. CLOSE
(normally closes the pulse switch) or OPEN (normally
opens the pulse switch). The pulse switch will change the
status after the Delay-sw time and keep the status until the
Width-sw time elapses, as shown in Figure 4-17. This
operation is repeated every pulse period.

Figure4-17 Pulse Setup Parameters

Start V/10 1

Trailin

! F-v/i0 ‘ ‘
3 Delay | Width i Delay |
! Period i
Normally open  Close _Open Close
Pulse switch | | ! 1 ;
Delay-sw Width-sw Delay-sw
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Pulse Output Operation Summary

The SPGU can be used for I/V Sweep, Multi Channel I/V Sweep, 1/V List Sweep,
and 1/V-t Sampling classic tests. The SPGU pulse output operation will differ as
shown in the following cases. Pulse output example of the sampling measurement is
shown in Figure 4-18.

»  Sampling measurement, simultaneous output mode. See Table 4-3.
e Sampling measurement, sequential output mode. See Table 4-4
e Sweep measurement mode. See Table 4-5.

SPGU Pulse Output Example for Sampling M easurement in Free Run Mode

Simultaneous output:

Start measurement End of measurement

!

| base hold time
1: SMUI1 ~——| source

|
|
—|0V base R
|
|
|

I
I
I
I

4 ov

e I
ey TUUT U U

0V i1 oV
base source

Sequencial output:

Start measurement End of measurement
| |
1- SMUT source :
0V | V14 ov
|
| ‘J
| ‘l
2: SPGU1 | |
oV 3 oV
“base ‘ :;
3: SPGU2 \ ‘ |
o U e
D
| base | N
sswuz | base | 731 oy
1
source —

base hold time
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Table 4-3 Output Timing for 1/V-t Sampling, Simultaneous
Pulse output Source Channel Operation
conditions Sarting During measurement After measurement Ending
Duration > SMUsand After the base hold SMUs continue the source | If the bias
Measurement | SPGUs start time, SMUs start the value output and SPGUs hold
time thebasevalue | sourcevalueoutputand | continue pulse output until | functionis
output SPGUs start pulse the specified time elapses ON, dl
simultaneously | output smultaneously. | or therepeat count reaches | source
the specified number. channels
SMUSs start After that, SMUs output fﬁggﬂfit
sampling the base or source value set put.
measurement by the Output Value after Else, al
operation. Measurement, and SPGUs | source
output the base value. output
goestoOV
Free run SMUs output the base or inthe
source value set by the reverse
Output Value after order of
Measurement, and SPGUS | ihe
continue pulse output. Channel
If the bias hold functionis | Setup
OFF, SPGUs output the definition.
base value.
Duration < After the base hold SMUs output the base or
M easurement time, SMUs start the source value set by the
time sourcevalueoutput and | Output Value after
SPGUs start pulse M easurement, and SPGUs
output simultaneoudly. output the base value.
After the specified time
elapses or the repeat
count reaches the
specified number,
SPGUs output the base
value.
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Table 4-4 Output Timing for I/V-t Sampling, Sequential
Pulse output Source Channel Operation
conditions Sarting During measurement After measurement Ending
Duration > Except for the | After the base hold SMUs continue the source | If the bias
Measurement | last SMU, time, thelast SMU start | value output and SPGUs hold
time SMUs start the | the source value output | continue pulse output until | functionis
source value and SPGUs start pulse | the specified time elapses ON, all
output. And output simultaneously. | or the repeat count reaches | source
SPGUs and the the specified number. channels
last SMU start After that, the last SMU continue
the base value the output.
output, The outputs the base or source
' value set by the Output Else, dl
source output
Lence s the Value after Measurement, source
sequen and SPGUs output thebase | output
definition order
value. goestoOV
on the Channel inthe
Freerun Setup screen Thelast SMU outputsthe | o eree
(top to bottom). base or source value setby | order of
SMUSs start the Output Value after the
sampling M ea_surement, and SPGUs Channel
measurement continue pul se output. Setup
operation. If the bias hold functionis | definition.
OFF, SPGUs output the
base value.
Duration < After the base hold The last SMU outputs the
M easurement time, thelast SMU start | base or source value set by
time the source value output | the Output Value after
and SPGUs start pulse | Measurement, and SPGUs
output simultaneoudly. | output the base value.
After the specified time
elapses or the repeat
count reaches the
specified number,
SPGUs output the base
value.
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Table 4-5 Output Timing for 1/V Sweep, Multi Channel I/V Sweep, I/V List Sweep
Pulse output Source Channel Operation
conditions Sarting During measurement After measurement Ending
Duration > SMUs and SPGUs start and continue Sweep sources output If the bias
Measurement | SPGUs start | the pulse outpuit. thestart or stop valueset | hold
time output. The SMUs start and perform by the Output Value functionis
source after Measurement. ON, 4l
output sween measUrement . source
. operation. SPGUs continue the
sequenceis . channels
pulse output until the .
the R continue the
A specified time elapses or
definition output.
the repeat count reaches
order on the o
Channdl the specified number. Else, al
After that, SPGUs source
Setup screen
output the base value. output goes
(topto )
bottom) S ot toOV inthe
Freerun . eep sources outpu reverseorder
Then, sweep thestart or stopvalueset | f the
SOUFCES by the Output Value Channél
output the after Measurement. Setup
start value, SPGUSs continue pu|se definition.
constant output.
sources . .
output the _If the bias hold function
source is OFF, SPGUs output
value, and the base value.
Duration < SPGUs SPGUs start the pulse Sweep sources output
M easurement gutputélhe output. the start or stop value set
; ase value.
time SMUs start and perform %giﬂﬁ;ﬁ%\égﬂ?e
Theconstant | qeen measurement '
Sources operation. SPGUs output the base
continue the value
output until SPGUs continue the pulse '
Ending. output until the specified
time elapses or the repeat
count reaches the specified
number. After that, SPGUs
output the base value.
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Sequence data

Figure4-19

Function Details
SPGU Module

ALWG Operation M ode

In the ALWG mode (arbitrary linear waveform generator operation mode), SPGU
can output an arbitrary linear waveform voltage as shown in Figure 4-19. The
waveform is the voltage pattern sequence specified by the pattern data and the
sequence data, which can be created by using the Define ALWG Waveform Window
(p. 2-68).

For asummary of source output operation in sweep or sampling measurement mode,
see “Pulse Output Operation Summary” on page 4-31. One sequence output will be
handled as same as one pul se output.

Specifies al of the voltage patterns set to a channel. A pattern consists of some
vector data. A vector datais defined by the output level and the time data.

»  Number of patterns. maximum 512 for a channel

*  Number of vector data: maximum 1024- N (N: number of patterns) for defining
all patternsto a channel

*  Output level: 0to + 40 V (open load, 1 mV resolution)
» Time data (incremental time): 10 ns to 671.088630 ms (10 ns resolution)

Specifies the output channel, the output pattern, the repeat count of the pattern, and
the output sequence of patterns applied in a single sequence.

* Repeat count of a pattern: 1,048,576

» Number of patternsin a sequence: maximum 512

ALWG Output Example

Start
1 sequence

! setup change (50 ns) !

! 1 1 1 !

! | o | | !

SPGU1 I ! P ! ! I
|n|t|alvalue: Pattern2 : Pattern2 : : Pattern1 : Pattern1 : Pattern1 :lnltlalvalue

| | o | | |

SPGU2 ! | | 1
initial val ! 1 + + initial value
mniatva ue: Pattern2 ! Pattern2 Lo Pattern1 ! Pattern1 ! Pattern1 :I el Ve
SPGU2 pulse switch 0: Open
(normally open)011 1111 011 1111 0 0111 11 11011 1 11 11011 1111 110 1: Close
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In the examplein Figure 4-19, SPGU1 and SPGU2 are used. The channels output
Pattern2 twice and Patternl three times in one sequence, although the two patterns
for SPGU1 are the same.

The SPGU channels simultaneoudly start the sequence output. The sequence will be
repeated in the same way as for the pulse period. The channels continue the
sequence output until the specified time elapses or the repeat count reaches the
specified number of sequences.

Setup delay time between the different patterns

When the pattern is changed to a pattern of adiffering index, a’50 ns setup delay will
always be inserted.

There is no delay between patterns of the same index.
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Sweep Abort Function

This function is used to stop sweep measurement automatically when one of the
following conditionsis detected. Thisfunction is useful to reduce sweep time and to
prevent damage to the device during measurement.

» [Effective measurement modes:

e |/V Sweep measurement

e Multi Channdl I/V Sweep measurement
e |/V List Sweep measurement

¢ C-V Sweep measurement

e Stop conditions:

« The output reaches voltage compliance or current compliance

* A measurement val ue exceeds the specified measurement range
* AnSMU oscillates

* Anerroriscaused inthe MFCMU

This automatic sweep abort function is enabled by using the Sweep [xxxx] status
field on the Measurement Setup screen of the Classic Test definition.

*  Sweep [CONTINUE AT ANY] status: Setsthe abort function OFF. Not
availableif the power compliance has been set.

*  Sweep [STOP AT ANY ABNORMAL] status: Setsthe abort function ON.

*  Sweep [SKIP AT ANY ABNORMAL] status: Sets the abort function ON.
However if astop condition is detected during a subordinate sweep
measurement, this function stops the VAR1 sweep once, changes the VAR2 step
value, and continues the sweep measurement. This mode is not available for
Desktop EasyEXPERT and for I/V List Sweep and C-V Sweep measurements.

When abort occurs
After measurement is aborted, the source forces the following value.

*  Sweep source: Start value

» Pulsed source or Pulsed sweep source: Pulse base value
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Sandby Function

This function forces the specified DC bias outputs (standby outputs) before starting
or after stopping a measurement.

Sandby Channels

Standby channels are SMU or UHV U that force the standby output. Standby
channels maintain the specified DC bias output when the standby modeisON andin
the non-measurement state.

Standby channel cannot be set for CMU, GNDU, and SMU connected to the atto
sense and switch unit (ASU) which makes the path to the AUX port.

To specify the measurement resource connected to the selector (N1258A,
N1259A-300, N1265A) or N1266A expander, the channel must be set to the Default
output in the Configuration window.

See “ Standby Channel Definition” on page 1-83 to define the standby channels and
set the standby mode.

Sandby Sate

Standby state is the state before starting or after stopping a measurement, in which
only the standby channels perform DC bias outputs. The other channels will bein
theidle state, which is 0 V output, 100 uA compliance, SMU filter OFF, and series
resistor OFF. When the standby mode is OFF and in the non-measurement state, all
channels will bein theidle state.

When the B1500 isin the standby state, the measurement trigger stops the standby
state, so the standby channels stop the standby output and the measurement channels
perform a measurement (measurement state). After the measurement, the standby
channels start the standby output (standby state). During this series of operations,
the state is never changed to the idle state. See Figure 4-20 for an example
operation.

If the bias hold function is enabled for the standby channel, after the measurement,
the channel forces the bias output set by the bias hold function. After the bias hold
period, the channel starts the standby output. During this series of operations, the
state is never changed to the idle state.
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Output Sequence of Sandby Channels

The standby channelswill start to output in order, from the top to bottom, aslisted in
the Standby Channel Definition on the Standby Channel Definition window. The
order of bias stop is bottom to top.

Figure 4-20 shows the standby and measurement operations for the following
exampl e setup. This example assumes that the channel setup is defined in the
Standby Channel Definition as follows in the order show, and that the output value
in the standby state is the same as the output value in the measurement state.

» SMU1: Voltage source, non-standby channel
» SMU2: Voltage source, standby channel
» SMUS3: Voltage source, standby channel

Sandby Function

V1-_
SMU1 Idle state force V Idle state
1 1
1 1
1 1
1 1
1 1
Voo | |
1 1
SMU2 Standbyon ! foreeVo
1 1 1 1
:X i i ]:
1 1 1 1
1 1 1 1
1 : : 1
V3__ i ; ; :
: : force V : i
SMU3  ——4 i i Standby OFF b
1
Idle state | Standby state : : Standby state Idle state

1
! Measurement state
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To Use Sandby Function

To start the standby output, click the Standby ON button on the Standby Channel
Definition window. However, if no channel has been defined as the standby channel,
the standby mode cannot be turned ON. In the standby state, the Standby ON
indicator appears at the bottom of the EasyEXPERT main screen. The Standby
Channel Definition window is opened by clicking the Standby button on the main
screen.

To stop the standby output, click the Standby OFF button on the Standby Channel
Definition window.

In the standby state, you can change the setting parameters for non-standby channels
without changing the operation state. However, if you modify the settings for the
standby channels, the operation state is changed from the standby state to theidle
state.

In the standby state, the following functions are set to OFF.

e SMU filter

» Seriesresistor

In the standby state, the following functions cannot be performed.
» Diagnosis

o Sdf-test

» Self-calibration (SMU calibration and CMU calibration)

*  SMU zero offset measurement

» ASU connection path change

In the standby state, self-calibration isnot performed even if auto calibration is set to
ON. Also the state cannot be changed to the standby state while self-calibration is
being performed.

When the workspace is opened, it will bein theidle state.

If the workspace or EasyEXPERT is closed while the standby modeis ON, the mode
isautomatically changed to OFF in the closing process.

If Windows session is stopped while the standby mode is ON, the mode is not
changed to OFF in the closing process.
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Function Details
Bias Hold Function

Bias Hold Function

This function is used to keep source output after measurement. Source modules
apply the specified bias between measurementsin a quick test or application test
that defines some classic test setups, or arepeat measurement. And the source
modul es change the output val ue and the unused modules are disconnected when the
next measurement is started.

If the bias hold function is OFF, the channel stops the output immediately after
measurement.

If the function is ON, the channel continues the output as shown below.
[/V Sweep measurement:.

* VARl and VARY' output channels: Sweep start or stop value

* VAR2 output channel: Sweep stop value

* CONST output channels: Output value

*  SMU pulse output channels: Base value

C-V Sweep measurement:

» Bias sweep output channel: Sweep start or stop value

e CONST output channels: Output value

[/V-t Sampling measurement:

» Constant source output channels: Base or source value

SPGU output:

»  SPGU keepsthe output as shown in Table 4-6.

» From the end of a measurement to the end of a single measurement

» From the end of a measurement to the start of the next measurement during a
quick test, application test, or repeat measurement

The source output isreset after aquick test, application test, repeat measurement, or
single measurement. The SMU isset to O V output and 0.1 mA compliance. The
MFCMU issetto OV DC biasand 0 V oscillator level.
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Function Details
Bias Hold Function

Setup method This function can be set by using the Advanced Setup window.

» Biashold after measurement
Set the function ON (enable) or OFF (disable, default setting).
* Output value after measurement

Select the bias output value START (default) or STOP for the I/V or C-V sweep
measurement, or BASE or SOURCE (default) for the sampling measurement.
Thisisinvalid for the VAR2, CONST, and constant source for C-V Sweep.

Table 4-6 SPGU Channel Output after Execution when BiasHold is ON

SPGU output

oper ation mode SPGU output

FREE RUN Continues the pulse output in the VPUL SE mode or the
sequence output in the ALWG mode.

SPGU trigger reset is performed at the beginning of the
simultaneous sampling measurement.

COUNT Continues the base voltage output in the VPUL SE mode
or theinitial voltage output in the ALWG mode.

DURATION
SPGU channel initialization is performed at the beginning

of the next measurement.
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Enabling offset
cancel function

Function Details
Current Offset Cancel

Current Offset Cancel

This function subtracts the offset current from the current measurement raw data,
and returns the result as the measurement data. This function is used to compensate
the error factor (offset current) caused by the measurement path such asthe
measurement cables, manipulators, or probe card.

The offset cancel is not available for measurement over 100 nA range. For 10 nA
range measurement, the offset cancel is performed by using the 1 nA range offset
value. For measurement by arange less than 10 nA, the offset value measured by
each rangeis used. See Table 4-7 for the effective measurement range, the allowable
offset value, and the module type of the measurement channel.

You can perform the offset current measurement and enable the offset cancel
function as shown bel ow.

1. Click the Calibration button on the main screen to open the Calibration window.
See “Calibration” on page 1-58.

2. Specify the channelsto perform the offset current measurement on the SMU
Zero Cancel tab screen of the Calibration window. To specify the channel, check
the check box to the left of the Namefield.

3. Toenablethe 1 pA range offset current measurement of SMU+ASU, check the
Full Range check box. Can be set for each channel.

4. Settheintegration time for the offset measurement to the Integration Timefield.
Available value: 1 PLC (power line cycle) to 100 PLC, initial setting 16 PLC.
Can be set for each channel.

Set the value longer than the integration time for the measurement of the device
under test. Otherwise, the offset cancel will not be performed.

5. Click the Measure... button. A dialog box is opened.

Follow the instruction of the dialog box, and perform the offset measurement.
After the measurement, the offset cancel function is automatically enabled.

Open the measurement terminals at the cable end of the device side during the
offset current measurement.
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Function Details
Current Offset Cancel

NOTE Except for HYSMU, the high resolution A/D converter is used for the offset current
measurement.

To disable the offset cancel function, remove the check from the check box to the
left of the Name field.

Table 4-7 Measurement range, allowable offset value, and module type
Measurement Allowable offset value Module type
range
1nA +10 pA SMU+ASU, HRSMU,
MPSMU, HPSMU,
HVSMU
100 pA +1 pA SMU+ASU, HRSMU
10 pA +400 fA SMU+ASU, HRSMU
1pA +100 fA SMU+ASU

If the offset value for a measurement range of a channel exceeds the allowable
value, the offset dataiis not effective in this range and lower for this channel. Then,
if the ranging mode setting of this channel covers thisrange or lower, the offset
cancel is not performed for any data measured by this channel.
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Function Details
SMU CMU Unify Unit

SMU CMU Unify Unit

Only for the B1500A. The SMU CMU Unify Unit (SCUU) isavailable for the
B1500A installed with the multi frequency capacitance measurement unit
(MFCMU). The MFCMU must be installed inthe ot N (integer, 3 to 10) and the
SMUsmust beinstalled inthe slot N- 1 and N- 2. See Agilent B1500A User’s Guide
to install the SCUU properly. The SCUU cannot be connected to the high power
SMU (HPSMU).

The Guard Switch Unit (GSWU) controls the connection of the CMU High and Low
guard lines (CMU return). The connection will be broken when using the SMU and
made when using the MFCMU.

The SCUU can switch the measurement resources, MFCMU or SMU, and can
configure four setups shown in Figure 4-21. When the B1500A isturned on, no
measurement resource is connected to the output. The SCUU has input connectors,
four coaxial and four triaxial, connected to the MFCMU and SMU directly or by
using the dedicated SCUU cable.

The SCUU front panel LEDs indicate the following conditions of the SCUU.

SMU SMU in the slot N- 1/N- 2 can be used.

CMU Internal Bias MFCMU can be used. CMU internal DC bias source is used.
CMU SMU Bias MFCMU can be used. SMU is used as DC bias source.

The SCUU has output connectors, four triaxial, that must be connected to the DUT
interface such as manipulators and probe card. When the measurement resource is
the SMU, they are the Forcel/Sensel and Force2/Sense2 connectors for the Kelvin
connection. And when the resource isthe MFCMU, the CMU High/Low are
connected to the Forcel/Force? respectively, and the Sensel/Sense? are not used.

To realize accurate impedance measurements, connect the CMU return terminals
together. The CMU return terminal means the shield end of the outer shield
conductor extended to the DUT interface. The shield end must be opened as close as
possible to the DUT. See Figure 4-14 on page 4-26.

The GSWU has one connector and two terminals. The connector must be connected
to the SCUU by using the SCUU cable. And the terminals must be connected to the
CMU High/Low guard lines at the shield ends of the DUT interface by using awire.
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Function Details
SMU CMU Unify Unit

Figure4-21 SCUU Input/Output Connections
Setup 1: CMH/Force1/Sensel: SMU (slot N-1) Setup 4: CMH/Forcel: CMUH (slot N)
CML/Force2/Sense2: Open CML/Force2: CMUL (slot N)

Sense1/Sense2: Open

Force Forcel
Heur @—4 CMUH
SMU in slot N-1

CMU Return

LSense Sensel
Hpot  ( G} to GSWU through

DUT interface
MFCMU in slot N

Setup 2: CMH/Forcel1/Sensel: Open Leur @—4 CMUL
CML/Force2/Sense2: SMU (slot N-2) *
)

CMU Return

Lpot to GSWU through

Force Force2 DUT interface

SMU in slot N-2

Sense Sense2

Setup 3: CMH/Force1/Sensel: SMU (slot N-1)
CML/Force2/Sense2: SMU (slot N-2)

Force Forcel
SMU in slot N-1
Sense Sensel
Force Force2
SMU in slot N-2
Sense Sense2
NOTE Before using SCUU

I nstrument connection must be done before the B1500A is turned on.
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Figure 4-22

Function Details
Atto Sense and Switch Unit

Atto Sense and Switch Unit

Only for the B1500A. To use the Atto Sense and Switch Unit (ASU), it must be
connected to the SMU which is connected together when the calibration is
performed. Using the ASU permits use of the 1 pA range. Also the ASU can switch
the measurement resources, SMU or an instrument connected to the AUX input
connectors. The ASU can configure two setups shown in Figure 4-22. When the
B1500A isturned on, the ASU will be the Setup 1 condition. See Agilent B1500A
User’'s Guideto install the ASU properly.

The ASU has input connectors, one triaxial and two coaxial. The triaxial connector
must be connected to the SMU Force, and the coaxial connectors must be connected
to an instrument. Also the ASU has the control connector to be connected to the
SMU by using the ASU cable.

ASU Input/Output Connections

Setup 1: AUX Off ( SMU input to ASU output )

Force

©

@

From SMU

L >

D-sub

Setup 2: AUX On ( CMU/AUX input to ASU output )

CMU-cur/AUX In

@ \@ CMU/AUX

CMU-pot

©

O CMU Return

The ASU has the following status indicators (LED).
SMU The SMU can be used (Setup 1).
AUX The AUX instrument can be used (Setup 2).
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NOTE

NOTE

Function Details
Atto Sense and Switch Unit

The ASU has output connectors, two triaxial, that must be connected to the DUT
interface such as manipulators and probe card. When the measurement resource is
the SMU, they are the Force/Sense connectors for the Kelvin connection. And when
theresource isnot SMU, the CMU/AUX is connected to the Force, and the Senseis
not used.

If you connect the MFCMU or the LCR meter with the four-terminal pair
configuration, two ASUs are required. Then the CMU-pot/CM U-cur connectors of a
ASU must be connected to the Hpot/Hcur of the instrument. And the other one must
be connected to the L pot/L cur in like manner.

To realize accurate impedance measurements using the four-terminal pair
measurement method, connect the CMU Return terminals of ASUs together. See
“Four-Terminal Pair Configuration” on page 4-24 and Figure 4-14 on page 4-26.

To use 1 pA range

The measurement channel connected to the ASU (Atto Sense and Switch Unit)
supportsthe 1 pA range. To usethe 1 pA range, set the 1 pA fixed range or the 1 pA
limited auto ranging.

The B1500A automatically performs the compensation of the data measured by the
1 pA range and returns the compensated data. You can use either the pre-stored
offset data or the pre-measured offset data.

To measure the offset data, perform the self-calibration before starting the
measurement for a DUT. This offset data is temporarily memorized until the
B1500A isturned off.

Before using ASU
ASU connection must be done before the B1500A is turned on.

The combination of ASU and SMU isimportant. The B1500A can work with wrong
combination, but it cannot satisfy its specifications. The specifications are
guaranteed for the correct combination which the performance verification was
performed. See “ASU” on page 1-66 and check if the combination is correct.

The CMU-pot connector isfor the MFCMU or the LCR meter that uses the
four-terminal pair. For the other instrument, connect a BNC open connector or
nothing to there. The line will beinternally connected to the CMU-cur/AUX-in line.

It is unavailable to use the series resistor in the SMU connected to the ASU.
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Figure 4-23

Function Details
SMU/PG Selector

SMU/PG Selector

Not available for the B1505A. Agilent 16440A SMU/PGU selector (B1500A-A04)
provides the built-in switching capability to select ameasurement path connected to
the Output port. See Figure 4-23 for the simplified circuit diagram of the selector.
The selector has the channels CH 1 and CH 2 which provide the following
conditions. It can be controlled by using the SMU/PG Selector tab screen of the
Configuration window. See “ SMU/PG Selector” on page 1-69.

CH1 Open (no connection), SMU connect, PGU connect, and PGU open
CH2 Open (no connection), SMU connect, and PGU connect

The PGU open isavailable only for the CH 1, and is made by keeping the PGU side
mechanical relay close and opening the semiconductor relay. Thisis effective for
frequent switching applications because the semiconductor relay is more durable
than mechanical relays. The PGU open can be set by using the Advanced Setup
window of the Measurement Setup. See “ Advanced Setup Window” on page 2-53.

SMU/PG Selector Circuit Diagram and Connections

16440A Selector 16440A Selector #2 for DUT terminals 3 and 4
CONTROL
SMU Input— O OO0 Input _ Output O 00
l @ CH1 e Iil CH2

Quiput g, BT terminal 1

> Output Input g, SMU #1 Force

CH1 f @ Input P PGU #1 or others

Output

|_ ——— P DUT terminal 2
@ —— 2 g SMU #2 Force
B

PGU Input —

|In';m> PGU #2 or others
SMU Input—| d b il ) C!)
CH1

@ H ;I Ouput__ CH 2
16440A Selector #1
CH2 —» Output

?/ ® 16445A Selector Adapter
PGU Input — IU CONTROL

utput Input
Co

CONTROL

@ Mechanical relay P AC power
@ Semiconductor relay P> B1500A Digital 1/0

The selector must be connected to the B1500A through the Digital 1/0 connector
and the Agilent 16445A Selector Adapter. Up to two selectors can be used by
connecting the selector control cable between the CONTROL Output connector of
the first selector and the CONTROL Input connector of the second selector.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 4-49



Figure 4-24

L
DUT low —~-o—0 Open o L AC power

CAUTION

Function Details
Module Selector

M odule Selector

Available for the B1505A. The Agilent N1258A Module Selector is used to switch
the measurement resources (HCSMU or DHCSMU (dual HCSMU), HPSMU, and
HVSMU) connected to DUT (device under test). The Input ports should be
connected to the HCSMU or DHCSMU, GNDU, HPSMU, and HVSMU. At least,
two SMU modules must be connected to the Input ports. And the Output port must
be connected to the DUT interface.

For the packaged devices, use the Agilent N1259A test fixture which can install the
modul e selector.

The module selector can be controlled by using the Module Selector tab screen of
the Configuration window. See “Module Selector” on page 1-69.

Module Selector Circuit Diagram and Connections

— B1505A Digital 1/0

P HCSMU Force+Sense
Module Selector P HPSMU Force+Sense

—» GNDU Force+Sense

DUT high —~o—»o Open —» HVSMU Force

O——— 1 HPSMU

m«vsmu B 6O DD D |
T L HCSMU ] oo

High

Rear view

GNDU

o
T T 4 Front view

99 9@ =

P DUT high terminal
P DUT low terminal

If dual HCSMU (DHCSMU) is used with the modul e sel ector, the maximum current
must be + 30 A to prevent the module selector from performance degradation and
failure.
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Ultra High Current
Unit

Figure 4-25

Function Details
Ultra High Current Expander/Fixture

Ultra High Current Expander/Fixture

Available for the B1505A. The N1265A is atest fixture which contains the current
expander to enable 500 A or 1500 A (option N1265A-015) output and measurement,
and contains the selector to switch the measurement resource connected to the DUT.

The current expander is used to configure the ultra high current unit (UHCU).

The selector is used to switch the measurement resource connected to the DUT. The
measurement resource will be the UHCU, HVYSMU, HP/MPSMU, or GNDU. See
Figure 4-26.

The selector output can be extended to your prober station by using the
N1254A-524 ultra high current prober system cable. This cable supports current up
to 500 A.

The N1265A also provides the connection paths for UHVU, MFCMU viabias-tee,
and HP/MP/HC/DHCSMU.

The ultra high current unit (UHCU) can be configured by using the N1265A and
two MC/HCSMU modules as shown in Figure 4-25. The UHCU output can appear
on the Selector Output by controlling the built-in selector.

The ultra high current expander/fixture can be controlled by using the UHC
Expander / Fixture tab screen of the Configuration window. See “UHC Expander /
Fixture” on page 1-72.

To Configure UHCU

B1505A N1265A UHC expander/fixture
Digital 1/0 Digital 1/0
Interlock Interlock High
GNDU GNDU - put _{Prei
=
HVSMU }----> HVYSMU—o =3 [
HP/MPSMU f---->{ SMU—o <
— ¢
° Source
UHCU «
MC/HCSMU I-control Low
MC/HCSMU V-control
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Function Details
Ultra High Current Expander/Fixture

Figure 4-26 N1265A Built-in Selector Simplified Internal Connections
Gate Low High
Low@ High

SenseG.D Force Sense@ ?Force F: Force

S: Sense
I ® l ® ® I l P.A: Protection adapter

\ \ \'
100 kQ
PA _
HVSMU force is
S F connected to
S| |F UHCU High sense line.
S F V—controIT Tl-control S F

F
MCSMU GNDU MCSMU MCSMU  SMU HVSMU
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Figure 4-27

Function Details
HVSMU Current Expander

HVSMU Current Expander

Available for the B1505A. The N1266A is a current expander for HYSMU. The
N1266A isused to configure the high voltage medium current unit (HVMCU) with
the HV SMU module and two MC/HCSMU modules as shown in Figure 4-27.
Selector isinitially installed for switching the HY SMU or the HYMCU connected

to the DUT.

The HVSMU current expander can be controlled by using the HVSMU Current

Expander tab screen of the Configuration window. See “HV SMU Current

Expander” on page 1-75.

To Configure HYM CU

B1505A N1266A HVSMU current expander
MC/HCSMU I-control
MC/HCSMU V-control High
HVMCU
HVSMU HVSMU
o
Open
GNDU GNDU—
Low
Digital 170 >| Digital 1/0

DuT

N1261A-002
or 004(*1)

*1: N1261A-002/004 protection adapter is required for connecting prober.
Not requred for connecting N1258A, N1259A, N1259A-300, or N1265A.

Drain

Source
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Figure 4-28

Function Details
Ultra High Voltage Expander

Ultra High Voltage Expander

Available for the B1505A. The N1268A is a voltage expander to enable 10 kV
output and measurement. The N1268A is used to configure the ultra high voltage
unit (UHVU) with two MC/HCSMU modules as shown in Figure 4-28.

The ultra high voltage expander can be controlled by using the UHV Expander tab
screen of the Configuration window. See “UHV Expander” on page 1-77.

To Configure UHVU

B1505A N1268A UHV expander
MCSMU I-control DUT Drain
MC/HCSMU V-control High |—
Digital 1/0 Digital 1/0 [«
Interlock Interlock Input ~ Low |—
|— Interlock Output Source

Interlock circuit
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For measurement
channels

For output
channels

Function Details
SMU Ranging Mode

SMU Ranging Mode

Agilent B1500 provides the following operation modes for the measurement range
and the output range. The ranging mode must be set for each channel.

“Auto Ranging”
“Limited Auto Ranging”
“Fixed Range”
“Compliance Range”

“Enhanced Auto Ranging for Current Measurement”

To Set Ranging M ode

The following points must be noted when setting the ranging mode.

If you do not specify the ranging mode, the auto ranging mode is set
automatically.

For the channels that perform Vf/Vm (voltage force and voltage measurement)
or If/Im (current force and current measurement), the measurement range is
always the same as the output range.

For measurement with pulse output, the measurement channel uses the
compliance range or the specified fixed range. The channel cannot perform the
auto ranging operation or the limited auto ranging operation.

For the SMU connected to the atto sense/switch unit (ASU), the 10 pA rangeis
the minimum for the auto ranging operation. To use the 1 pA range, select the 1
PA limited auto ranging mode or the 1 pA fixed range mode.

The auto ranging mode and the limited auto ranging mode are available for the
output channels.

When the voltage output range or the voltage compliance range is changed, the
channel forces 0V at that moment.
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For measurement
channels

For output
channels

Function Details
SMU Ranging Mode

Auto Ranging
Range changing is performed as below.

The measurement channel automatically searches for and measures at the range that
provides the best resolution as follows:

» For current measurement, the measurement channel uses the present range if the
following formulais satisfied; otherwise, the channel changes the range.

Range x 0.1 < Measurement value < Range x X/100
where X=115, or 100 at the maximum range.
See also “Enhanced Auto Ranging for Current Measurement” on page 4-58.

» For voltage measurement, the measurement channel uses the present range if the
following formulais satisfied; otherwise, the channel changes the range.

Next lower range value < Measurement value < Range x X/100
where X=110, or 100 at the maximum range.

The output channel automatically searches for and forces at the lowest range that
covers the output value as follows:

» For staircase sweep output, the output channel uses the lowest range that covers
the start and stop values. However, it uses the lowest range that covers the step
output value for the logarithmic current sweep. For the voltage sweep that sets
the power compliance, the channel uses the lowest range (20 V range or more)
that covers the step output value.

» For pulsed bias output, the output channel uses the lowest range that coversthe
base and peak values.

» For pulsed sweep output, the output channel uses the lowest range that covers
the base, start, and stop values.

» For quasi-pulsed output and search source output, the output channel uses the
lowest range that covers the start and stop values.

The maximum output value is as follows:
e Maximum current output value = Range x X/100
where X=115, or 100 at the maximum range.

e Maximum voltage output value = Range value
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NOTE

Function Details
SMU Ranging Mode

Limited Auto Ranging

Limited auto ranging is similar to auto ranging. However, limited auto ranging does
not use the range(s) less than what you specified. For example, if you select 10 mA
limited auto ranging, the measurement modul e does not use the 1 mA range or less.
Consequently, the measurement time for limited auto ranging is less than for auto
ranging.

Fixed Range

The channel uses the specified range only.

For the current measurement channel, if you specify a range higher than the
minimum range that covers the compliance val ue, the measurement channel uses
this range (compliance range).

Compliance Range

The compliance range is effective for the Vf/Im (voltage output and current
measurement) or If/Vm (current output and voltage measurement) channel. The
measurement channel automatically selects and usesthelowest range that coversthe
specified compliance value.

For the measurement channel that performs constant voltage or current output, you
can set the compliance range.

For the measurement channel that performs sweep output, you can set the power
compliance value. If you set the power compliance value, the channel usesthe
lowest range that covers the lower value of either the specified compliance value or
the compliance value given by the following formula

Current compliance = Specified power compliance value / Step voltage
Voltage compliance = Specified power compliance value / Step current

For details about setting compliance, refer to “SMU Compliance” on page 4-59.

Range change is performed when the compliance value is set, not when the
measurement is performed.
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Function Details
SMU Ranging Mode

Enhanced Auto Ranging for Current Measurement

Expanded functions are available for the auto ranging operation of the current
measurement channel. To use the functions, set Range Change Rule. See “SMU
Range Setup Window” on page 2-48. Rate value defines the boundary of ranging.

» Range Change Rule=BY FULL RANGE:

Performs normal auto ranging operation. If a condition shown below is satisfied,
the range changes immediately, even during measurement.

Measurement value > Range x X/100
Measurement value < Range x 0.1
where X=115, or 100 at the maximum range.
* Range Change Rule=GO UP AHEAD:
If the following condition is satisfied, the range changes up after measurement.
Measurement value > currentl
» Range Change Rule=UP AND DOWN AHEAD:

If the following condition is satisfied, the range changes down immediately,
even during measurement.

Measurement value < current2
If the following condition is satisfied, the range changes up after measurement.
Measurement value > currentl

where current1 and current2 are given by the following formula. Then rate must be
an integer, 11 to 100.

currentl = Range x rate/100

current?2 = Range x rate/1000

For example, if therange valueis 10 mA and rate is 90, they are:
currentl = 9 mA

current2 = 0.9 mA
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Function Details
SMU Compliance

SMU Compliance

Compliance is the output limiter to prevent damage to the test device from
overcurrent, overvoltage, or overpower. Voltage complianceisfor the current output
channels, and current complianceis for the voltage output channels.

When a channel reaches compliance, the channel acts as a constant voltage source or
aconstant current source. The channel keeps the output value when reaching
compliance.

Compliance can be set with the same resolution and accuracy as output current or
output voltage. For the values, see Agilent B1500A or B1505A User’s Guide.

Polarity and Output Area

» Polarity of current compliance

The B1500 automatically sets current compliance for both positive and negative
polarity. For opposite polarity as the output voltage, the compliance valueis
increased by an amount that is 2.5 % to 12 % of the range value in the lowest
range that covers the specified compliance value. See Figure 4-29.

» Polarity of voltage compliance

The B1500 automatically sets voltage compliance to the same polarity as the
output current. There is no compliance for opposite polarity.

Figure 4-29 Relation of Compliance and Output
Current Voltage
_
+| Compliance | +| Compliance |
V<0 V>=0 <0 I >=0
; Output Voltage ; Output Current
—| Compliance | —| Compliance |
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Function Details
SMU Compliance

Power Compliance

In addition to V compliance or | compliance, you can set power compliance for the
staircase sweep source. Power compliance is not available for HYSMU.

If you specify power compliance, SMU changes the current or voltage compliance
value every sweep step. The value is the lower value of either the specified
compliance value or the compliance value given by the following formula. See
Figure 4-30.

Current compliance = Specified power compliance value/ Step voltage

Voltage compliance = Specified power compliance value / Step current

Figure 4-30 Power Compliance Output Area
For voltage sweep: For current sweep:
Current Voltage
<— Specified power compliance <— Specified power compliance

\ <— Specified current compliance value

| < Specified voltage compliance value

Actual current compliance Actual voltage compliance

Available values

Voltage Current

The following values are available for the power compliance:
MPSMU/HRSMU ImWto2W

HPSMU 1 mwWto20 W

HCSMU 1mWto40 W (DC), 1 mW to 400 W (pulse)

DHCSMU 1 mwW to 80 W (DC), 1 mW to 800 W (pulse)

MCSMU 1mWto3W (DC), 1 mW to 30 W (pulse)

UHCU 1 mW to 7.5 kW (pulse, 500 A range), 1 mW to 22.5 kW
(pulse, 1500 A range)

UHVU 1 mW to 100 W (DC), 1 mW to 200 W (pulse)

HVMCU 1 mW to 600 W (pulse, 2200 V range), 1 mwW to 900 W

(pulse, 1500 V range)
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Conditions after
compliance

SMU output values

Function Details
SMU Compliance

When a channel reaches compliance, the staircase sweep source automatically stops
the sweep and forces the start value. After reaching the compliance, the
measurement datawill be “NaN”.

If you specify power compliance, the SMU changes the current or voltage
compliance every sweep step. Hence, the SMU can apply voltage or current with the
maximum power. Figure 4-31 shows the differences between the output with power
compliance and the output without power compliance, for MPSMU.

Figure4-31 Allowable Current in Voltage Sweep (0 V to 100 V, MPSM U)
When power compliance is set: When power compliance is not set:
Current (mA) Current (mA)
100 100
<—For the sweep 0 Vto 20 V
For the sweep 0 Vto 40V
50 L B0} +-ss+esmeieeeenene-; For the sweep 0V to 100 V
20 20 f l |
| H
20 100 Voltage (V) 20 m 100 Voltage (V)
NOTE If you specify power compliance, the measurement time increases slightly because

the B1500 adjusts the compliance for every sweep step.

To Set Compliance
The following points must be noted when setting the compliance.

» If the current compliance valueistoo low, the SMU will take along settling
time.

e The SMU will reach voltage compliance if the SMU cannot force the specified
current for the following reasons:

e Over current for test device.
« Another channel has reached compliance.

* Current measurement data of another channel has reached the limit for the
present measurement range.
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SMU Pulse

SMU can apply voltage or current pulse. This section describes the pulse setup
parameters. The parameters are different by the number of pulse output channels as
shown in Figure 4-32.

To Set Pulse Output
The following points must be noted when setting the pulse output.

e Cannot use the 1 nA output range and lower ranges.

e Cannot use multiple pulse output channels for the tests other than the Mullti
Channel 1/V Sweep.

e Cannot use multiple measurement channels for the tests other than the Multi
Channel 1/V Sweep.

e The measurement channel uses the compliance range. The channel cannot
perform the auto ranging operation or the limited auto ranging operation.

Figure 4-32 SMU Pulse Setup Parameters

1. Using one pulse output channel

Pulse period
Voltage or current < >
Measurement time
Peak val
e
cak valu i Hold time

Previous value —\I‘ i |

Base value Pulse width |

2. Using multiple pulse output channels

Pulse period
Voltage or current >
Measurement delay time , Measurement time

Peak value Hold time
—>
Previous value ‘\ |
Base value Pulse width i L

bt =
T

Pulse delay time

Time
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Pulse Setup Parameters

The pulse setup parameters and the available values are shown below.
Hold time 0st0655.35s, 10 msresolution

Pulse period 5msto 5 s, 100 usresolution

Pulsewidth HR/MP/HPSMU: 500 pusto 2 s, 100 psresolution

HCSMU / dual HCSMU: 50 usto 2 s, 2 pusresolution.
Maximum 1 msand duty ratio < 1 % for using 20 A range
or 40 A range.

MCSMU: 10 usto 2 s, 2 psresolution. Maximum 100 ms
and duty ratio< 5% for using 1 A range.

UHCU: 10 usto 1 msand duty ratio < 0.4 % for 500 A
range, 10 usto 500 ps and duty ratio < 0.1 % for 1500
A range, 2 usresolution.

UHVU: 100 usto 2 s, 2 usresolution. Maximum 1 msfor
using 100 mA range.

HVSMU: 500 usto 2 s, 2 usresolution

HVMCU: 10 psto 100 ps, 2 us resolution. Maximum 1 ms
for using 2200 V / 110 mA range.

Pulse delay time 0 to Pulse period - Pulse width, 2 usresolution
0 sfor using HR'MP/HPSMU

Measurement delay
time 2 usto Pulse period - Measurement time- 2 ms, 2 us
resolution

Measurement time HR/MP/HPSMU: 16 usto 20 ms, 2 usresolution
HC/MCSMU: 2 usto 20 ms, 2 usresolution
HVSMU: 6 usto 20 ms, 2 pusresolution
See “Integration Time” on page 4-65.

The setup values must satisfy the following conditions.

» Pulse period > pulse delay + width + 2 ms, for pulse delay + width < 100 ms
» Pulseperiod > pulse delay + width + 10 ms, for pulse delay + width > 100 ms
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e Pulse width must be the same for al of the HRIMP/HPSMU pulse output
channels. If adifferent valueis entered, the longest value is set.

Pulse period = AUTO sets the longest one of the followings automatically.

» Maximum period given by the pulse width and the duty ratio
» Pulseperiod =5 ms, for pulse delay + width <3 ms

» Pulseperiod = pulse delay + width + 2 ms, for 3 ms < pulse delay + width <100
ms

» Pulseperiod = pulse delay + width + 10 ms, for 100 ms < pulse delay + width

Measurement delay time = AUTO sets the optimum value automatically so that the
measurement is completed when the transition from peak to base is started by the
pulse output channel which starts the transition at first.
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SMU Measurement Time

M easurement time depends on integration time, measurement range, and other
measurement conditions, and can be expressed by the following formula:

Measurement time = Integration time + Overhead time

Integration time is the time required for measurement, and does not include such
factors as range changing or data compensation, which would be the overhead time.

Integration Time

Integration time is the time required to get measurement data. For accurate and
reliable measurement, integration time should be increased. Integration time can be
set for each type of A/D converter (ADC) used by the measurement channel.

High-speed ADC

Installed in each measurement module. For high speed measurement. Sets the
number of averaging samples for getting one measurement data by setting the
Mode and the Factor value. Only PLC and TIME are available for SMU pulse.

AUTO

MANUAL

PLC

TIME

Number of averaging samples = Factor x reference
Factor = 1 to 1023

where reference is the number of averaging samples
automatically set by the B1500; this cannot be changed.

Specify the number of averaging samples (Factor).
Factor = 1 to 1023

Number of averaging samples = Factor x 128
Factor = 1to 100

The B1500 gets 128 samplesin a power line cycle. Hence, the
Factor value is equal to the number of power line cycles.

Specify the actual measurement time (Factor).
Factor =2 usto 20 ms, 2 us step

For HRIMP/HPSMU, it performs the operation of MANUAL.
Then the number of averaging samplesis automatically set to
the following value.
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Number of averaging samples = Factor / Tm
Tm: Required time for one sample measurement

If Factor / Tm< 1, Number of averaging samples = 1.

» High-resolution ADC

For high accuracy and high resolution measurement. This ADC is mounted on
the mainframe, and used by the multiple modules alternately. Setsthe
integration time for getting one measurement data by setting the Mode and the
Factor value. The high-resolution ADC cannot be used for the measurements
using SMU pulse.
AUTO Integration time = Factor x reference

Factor = 1to 127

where reference is the integration time automatically set by the
B1500; it cannot be changed.

MANUAL Integration time = Factor x 80 usec
Factor = 1to 127
PLC Integration time = Factor / power line frequency
Factor = 1 to 100
The Factor value means the number of power line cycles.
The ADC zero function is available for the high-resolution A/D converter (ADC)
and not available for the high-speed ADC. Thisfunction measurestheinternal offset

of the high-resolution ADC and compensates it automatically. The measurement
data displayed on the LCD will be the data after compensation.

This function is especially effective for the low voltage measurement. Disable the
function in cases where measurement speed is more important than measurement
accuracy. This approximately halves integration time.
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Overhead Time

The overhead time is the time required for range changing and so on. Thistime
depends on the measurement condition, and cannot be specified. Major elements of
the overhead time are:

» Range changing time during measurement (when measurement ranging mode is
set to auto or limited auto)

» Range changing time at measurement start (when the measurement rangeis less
than the compliance value)

To Specify Source Output Time

You cannot specify the measurement time. However, in sweep measurement mode,
you can specify a source output time that includes the measurement time. To specify
the source output time, set the delay time and the step delay time. The step delay
time is defined as the time from the measurement trigger up to the trigger for
changing the source output value. See the figure below. The step delay time must
cover the measurement time to keep the source output time constant.

The EasyEXPERT does not support the step delay time. It is available only for the
GPIB remote mode.

Source output time ,Td ,, Tsd
Step delay time (Tsd)
only for Remote mode [

Td | Tsd
Delay time (Td)
—
[} |
Vstart— I ‘ Measurement time
"
Hold time
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Wait Time

Wait time is the time after starting source output until changing the source output
value or until starting measurement. You can set the source wait time and the
measurement wait time individually.

The source wait time is the time the source channel alwayswaits after it starts output
until it changes the output value. The measurement wait timeis the time the
measurement channel always waits after the source channel starts output until the
measurement channel starts measurement. Refer to Figure 4-33. Thewait timeis
given by the following formula:

wait time = N x reference

where reference is the wait time the B1500 automatically sets according to the
present settings; this wait time cannot change. Available N valuesare 0 to 10, 0.1
step. Initial valueis 1.

It is not easy to determine the best wait time. If you specify it too short, the
measurement may start before device characteristics stable. If too long, time will be
wasted. For measurements of low capacitance or fast response devices, if
measurement speed has top priority or is more important than reliability and
accuracy, set the wait time shorter. Theinitial wait time may be too short for
measurements of high capacitance or slow response devices. Then set the wait time
longer.

Source/M easurement Wait Time

Measurement wait time

Source wait time

= leasurement

Delay time
[

Hold time Step delay time )
Time

In the GPIB remote mode, if the delay time islonger than the wait time, the wait
time can be ignored.

The EasyEXPERT does not support the step delay time.
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Multiple M easurement Channels

To use multiple measurement channels, define multiple measurement parametersin
the Display Setup screen or the Function Setup screen. Then, measurement
sequence, time data, and measurement time for each measurement point are as
follows.

*  Sequence of measurement execution

M easurement channels perform measurement in the order shown below.

1. Measurement channels which use the high speed AD converter and the
FIXED measurement range start measurement simultaneoudly (parallel
measurement).

2. After the parallel measurement, the other measurement channels perform
measurement sequentially. The order istop to bottom of the channels defined
in the SMU Range Setup screen.

Asaspecia casg, for the sweep measurement with multiple pul se outputs and
for the linear sampling measurement with Interval < 2 ms, all channels start
measurement simultaneoudly.

 Timedata

Only the measurement start time of the channel which starts measurement at
first is recorded.

* Measurement time

Measurement time is the sum of the measurement time by all channels.
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SMU Filter

Thefilter is mounted on each source/monitor unit (SMU) module. It assures clean
source output with no spikes or overshooting. However, using afilter may increase
the SMU settling time.

To set thefilter, refer to “ Advanced Setup Window” on page 2-53.

NOTE The SMU filter is set to OFF for the standby channelsin the standby state.
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SMU Series Resistor

The series resistor (approx. 1 MQ) is mounted on each source/monitor unit module
(HRSMU, HPSMU, and MPSMU). The series resistor may be used for the device
protection, negative resistance measurement, and so on. It depends on the
characteristics of test device and measurement environment.

If you use a seriesresistor, the voltage you set is applied to the near side of the series
resistor. Thus, the voltage will be divided by the series resistor and the device under
test. The setting value is not the voltage at the device terminal.

To set the series resistor, refer to “ Advanced Setup Window” on page 2-53.
The series resistor is not mounted on MCSMU, HCSMU, and HVSMU.

Restrictions

The seriesresistor cannot be used for the measurements that use the SMU connected
to the Atto Sense and Switch Unit (ASU) or the measurementsthat use 1 A range of
the high power SMU (HPSMU).

The series resistor is set to OFF for the standby channelsin the standby state.
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Interlock Function

Theinterlock function is designed to prevent electrical shock when a user touches
the measurement terminals. If the Interlock terminal is open, maximum output is
limited to + 42 V.

To perform high voltage measurement more than + 42 V, connect the Interlock
terminal to aninterlock circuit of test fixture or connector plate. Theinterlock circuit
must have one LED and two mechanical switches placed near the shielding box
opening doors. And they must be connected together. For details on how to install
the interlock circuit, see Agilent B1500A or B1505A User’s Guide.

The interlock function works as shown below.

*  When theinterlock circuit is open, maximum output is limited to + 42 V.

»  Whentheinterlock circuit is close, source channel can forceits maximum output
value.

* When theinterlock circuit is opened in the high voltage condition more than
+ 42V, output voltageis set to 0 V immediately.

If the actual output valueis not set to 0 VV within 120 msec, the B1500 automatically
performs theinitiaization. Then perform self-test. Any module may be defective.

Danger ous voltage of up to the maximum voltage of SM Us may be present at
force, guard, and senseterminalsif the Interlock terminal is closed.
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Auto Power Off Function

If an abnormal voltage or current is detected in the B1500, the B1500 automatically
turns off to prevent damage.

If thisfunction is activated, the B1500 is turned off, but the Standby switch is left
ON. Perform the following stepsto turn the B1500 on again.

1

o g~ WD

7.

If Windowsis running, end all tasks, and shutdown Windows.
Open the measurement terminals.

Press the Standby switch to set it to the OFF position.
Remove the power cable from the B1500 rear panel.

Wait for 10 seconds or more.

Connect the power cable from the B1500 rear panel.

Press the Standby switch to set it to the ON position.

Abnormal voltage or current can be caused by incorrect connections of the B1500 to
the test device, excess voltage or current input, momentary power loss, defects of
the instrument, and so on.

If no cable is connected to the measurement terminals of the B1500, and the line
voltage s correct, the B1500 may have a defect. Contact the nearest Agilent
Technologies for assistance.
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Initial Settings

Agilent B1500 isinitialized by turning it on, the *RST command, or the device
clear. Initial settings of the B1500 are shown in the following tables.

Table 4-8 Initial Settings
Setup Item Initial Setting
Mainframe | Auto calibration off
SMU Output switch close

Filter on

Seriesresistor, only for HR/MP/HP off

ASU path/indicator SMU side/enable

ASU 1 pA auto range disable

Current measurement range with pulse compliance range
without pulse auto

Voltage measurement range with pulse compliance range
without pulse auto

A/D converter HR/MP/HPSMU: high resolution ADC
HC/DHC/MC/HVSMU: high speed ADC

ADC integration time high speed ADC: auto
high resolution ADC: auto

ADC zero function off

Sweep automatic abort function off

Hold time 0s

Delay time O0s

Pulse width 0.001s

Pulse period 0.01s
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Setup Item Initial Setting
CMU SCUU path/indicator open/enable

M easurement parameter Cp-G

M easurement range auto

Measurement time auto

Open/short/load correction off

Phase compensation mode auto

Measurement signal frequency 1k, 2k, 5k, 10k, 20k, 50k, 100 k, 200 k, 500 k,
1M,2M,5MHz

Automatic abort function off

Hold time 0s

Delay time Os

SPGU Operation mode VPUL SE (PG mode)

Pulse period 10us

Channel output mode Primary Pulse, 2-level pulse output

Pul se source setup Delay: 0s
Width 100 ns
Leading: 20 ns
Trailing: 20 ns

ALWG setup Cleared

Pulse switch Disable

DUT load impedance 500

SPGU trigger output Disable
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Built-in Programming Tool

This chapter explains the programming tool built into Agilent EasyEXPERT. The
programming tool is used to define user functions and analysis functionsin the
Classic Test definitions and to define the test contents in the Application Test
definitions.

This chapter contains the following sections.
» “Variables and Expressions’

* “Built-in Functions’

» “Read-out Functions”

e “Script Program Statements’
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Variables and Expressions

Variables can be used in Agilent EasyEXPERT setup editor for the following
applications. User functions and analysis functions can also be used for variables.

» To store the value of the measurement condition input parameter

» To store the value of the measurement result data or analysis data

» Variable used in the test execution flow of the Application Test definition
*  User function of the Classic Test definition

» Analysisfunction of the Classic Test definition

The following characters can be used for the variable name.

e Alphabetic characters A to Z and ato z, case sensitive

e (underscore)

* Numeric characters0to 9

e @ (at mark)

Numeric characters and at mark cannot be used for the first character of variable
name.

About variable names

The variable name must be unique. If avariableis defined asalocal variablein an
application test definition and its name isthe same as one of the following variables,
thelocal variable is effective and the following variable is not effective.

» variablethat defines a built-in function in atest setup
» variable that defines aread-out function in atest setup
» variable defined as atest parameter

» variable defined as a device parameter

» variable defined as an analysis parameter

Thelocal variables are defined by using the Local Variable Definition statement in
the Test Contents setup displayed on the Test Definition window. The test
parameters and the device parameters are defined in the Test Specification setup,
and the analysis parameters are defined in the Test Output setup.
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Expressions
Figure 5-1 shows the expression effective for variable definition. The elements are
explained below.

Figure5-1 Syntax of Expression

y { Expression '—“—>

Monomial
Operator

xpression Operator
—' Litetral }

—‘ Constant }

—' Variable }
Built-in
© ®

Function

Read Out
Function

User
Function

Analysis
Function

Constants

The following scientific constants are available.
« @ electric charge. 1.602177x1071°

«  k: Boltsmann’s constant. 1.380658x102

* e space permittivity. 8.854188x1012
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Literals
Numeric type and string type are available.
* Numeric type
To enter anumeric value, type as follows, where[ ] isoptional.
Dd[ . d] [ E[ S] d] [s]
D: Numeric character 0to 9
d: This means repeating D 0 times or more.
E: Exponent symbol, E or e
S: Sign, + or -

s: Prefix symbol. The subsequent symbals (y, z, a, f, p, n, u, m, k, M, G)
separated by the comma mean the value following the colon.

y: 1024, 2102, & 10718, f: 1015, p: 1022, n: 10°°, u: 106, m: 1073,
k: 103, M: 105, G: 10°
e String type

Enclose the string by using the double quotes. To contain the double quotes into
the string, type as shown below. The example string is ABC" DEF.

" ABC' " DEF"

Monomial Operatorsand Binomial Operators

Table 5-1 shows monomial operators and binomial operators available for an
expression. The table also shows the priority of operators and the type of operand.
For the expression that contains the same priority operators, the operations are
performed from |eft to right. Module type variable is one of SMU, HPSMU,
HCSMU, DHCSMU, HVSMU, MPSMU, MCSMU, HRSMU, HRSMU/ASU,
CMH, CML, UHCU500, UHCU1500, UHVU, or HYMCU.

Operation between arrays

Operation is performed between data at the same index.

Agilent EasyEXPERT User’s Guide Vol. 1, Edition 1 5-5



Built-in Programming Tool
Variables and Expressions

Table5-1 Monomial Operator and Binomial Operator
T Type of operand
Q Operator
=z Numeric Vector? Sring M odule
T O Yes Yes Yes Yes
S| NOT Yes Yes No No
A Yes Yes No No
*or/ Yes Yes No No
+or -, monomial Yes Yes +:Yes,-:No | No
+or -, binomial Yes Yes +:Yes, - :No | No
> >= < <= Yes Yes Yes No
=, <> Yes Yes Yes No
AND Yes Yes No No
—| XOR Yes Yes No No
g OR Yes Yes No No

a. Two-dimensional array. The primary planeisfor the primary sweep index, and the
secondary planeis for the secondary sweep index.

Built-in Functions

Agilent EasyEXPERT built-in function can be used. See “Built-in Functions’ on
page 5-7.

Read-out Functions

Adgilent EasyEXPERT built-in read-out function can be used. See “Read-out
Functions” on page 5-16.

User Functionsand Analysis Functions

User functions and analysis functions are the user-defined functions that consist of
the variable name, unit, and expression. The functions are effective for numeric or
vector type data. To define the functions, see “Function Setup” on page 2-42.

Numeric literal, scientific constants (g, k, €), variableto store the test result data, and
abuilt-in function that returns the numeric or vector type data can be used in the
expression. The read-out function can aso be used for the analysis functions.
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Built-in Functions

This section describes Agilent EasyEXPERT built-in functions. The functions
appear in alphabetical order. In the function name, the character in parenthesesis a
variable.

Returns the absolute value of the expression A.

Example B=abs(A)

Datatype A:numeric, B: numeric. Or A: vector, B: vector.

Returns the arccosine value of the expression A. The A value must be between - 1
and 1.

Example B=acos(A)

Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Returns the arcsine value of the expression A. The A value must be between -1 and
1

Example B=asi n(A)

Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Finds a data el ement in the expression A, and returns the value. The dataelement is

specified by index B. The index number startsfrom 1. If B isnot an integer, alinear
interpolated A value will be returned.

Example C=at (A B)

Datatype A: vector or numeric, B: numeric, C: vector.

Finds a data e ement in the expression A, and returns the value. The data element is
specified by the indices B and C. B isthe index for the primary plane of a

two-dimensional array and C istheindex for the secondary plane. Theindex number
starts from 1.

If B isnot an integer, alinear interpolated A value will be returned. The linear
interpolation will be executed between A[n,C] and A[n+1,C], wheren < B < n+1.

If Cisnot aninteger, C will ben, wheren < C < n+1.
Example D=at (A B, O

Datatype A: vector or numeric, B: numeric, C: numeric, D: numeric.
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Returns the arctangent value of the expression A.

Example B=atan(A)

Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Returns the radian value of the angle made by the X-axis and the line that passes
through the coordinates (0, 0) and (A, B).

Example C=at an2(A, B)

Datatype A: numeric, B: numeric, C: numeric. If A and/or B is vector, C: vector.
Returns the average value of datain the expression A. For subordinate sweep
measurement, this function returns the average values for each primary sweep.
Example B=avg(A)

Datatype A: vector or numeric, B: vector.

Returns the minimum integer value more than or equal to the expression A.
Example B=ceil (A)

Datatype A:numeric, B: numeric. Or A: vector, B: vector.

This function does the following.

« If A<B,returnsC.
 If A>B,returnsD.

If the A or B valueisinvalid, the value for the previous measurement index number
is used for the comparison.

Example E=cond(A, B, C, D)

Datatype A, B, C, D: numeric, E: numeric. If A, B, C, and/or D is vector,
E: vector.

Returns the cosine value of the expression A.

Example B=cos(A)

Datatype A:numeric, B: numeric. Or A: vector, B: vector.
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Returns the difference of the expression A. Calculation is performed as follows.

D,=(A>Ay) whenn=1
Dh=An1-AnD/2 whenl<n<N

Dp = (AN~ An.1) whenn=N

where,

D, difference for the index number n

Aq A value for the index number n

N number of sweep steps or number of samples

For subordinate sweep, the first index number of each primary sweep is always 1.

If A isadatavariable for a secondary sweep source, this function returns the sweep
step value of the secondary sweep.

For frequency data of C-V sweep, the calculation is performed for all frequencies.
Example B=del ta(A)
Datatype A: vector or numeric, B: vector.

Returnsthe differential coefficient of the expression A by B. Calculationis
performed as follows.

A= (A A)DI(By- By) whenn=1

A= (Apir- An)/(Brag- Broy) whenl<n<N
A= (An- An.)/(By- B.) whenn=N

where,

Ay differential coefficient for the index number n
Ap: A value for the index number n

By B value for the index number n

N: number of sweep steps or number of samples

For subordinate sweep, the first index number of each primary sweep is always 1.
Example C=diff (A B)
Datatype A, B: vector or numeric, C: vector.
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Returns the number of elementsin the primary plane of the vector variable A.
Example B=di mLSi ze( A)
Datatype A: vector, B: numeric.

Returns the number of elementsin the secondary plane of the vector variable A.
Example B=di n2Si ze( A)

Datatype A: vector, B: numeric.

Raises e (exponential) to the power of the expression A. The following example
enters & calculation result to the variable B.

Example B=exp(A)

Datatype A: numeric, B: numeric. Or A: vector, B: vector.

Returns the maximum integer value less than or equal to the expression A.
Example B=fl oor (A)

Datatype A:numeric, B: numeric. Or A: vector, B: vector.

Returns data of the numeric variable specified by A. Thisfunction is effective for
the variables defined in the Function Setup or Display Setup of the last Classic Test
or the analysis parameters of the last Application Test. The variables are validin a
test definition.

Example B=get NumericData("A")

Datatype A: string (name of numeric variable), B: numeric.

Returns data of the vector variable specified by A. This function is effective for the
variables defined in the Function Setup or Display Setup of the last Classic Test or

the analysis parameters of the last Application Test. The variables are valid in a test
definition.

Example B=get VectorData("A")
Datatype A: string (name of vector variable), B: vector.
Findsthe string B in the string A, and returns the index number where the string B is

first found. Theindex O indicates the first character. The following example returns
3.

Example C=i ndex("AGQ LENT","L")
Datatype C: numeric.
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integ(A,B)

isvalid(A)

Igt(A)

Built-in Programming Tool
Built-in Functions

Performs numerical integration of the expression A by B. Calculation is performed
asfollows.

Whenn=1,a,=0
Whenn > 1, o, isdefined asfollows:

1 n
0, =20 0 )0, )
i=2

where,

Op: integral of A for the index number n
Yi: A value for theindex number i

X;: B value for the index number i

If A or B contain some invalid values, theinvalid values are ignored for the
calculation.

For subordinate sweep, the first index number of each primary sweep is always 1.
Example C=int eg(A, B)
Datatype A, B: vector or numeric, C: vector.

Returns 1 if the expression A isvalid and is not double.NaN, or else returns 0.
Example B=isValid(A)

Datatype A:numeric, B: numeric.

Returns the logarithm (base 10) of the expression A.
If A=0, - Over f | owisreturned with the status “ Arithmetic error”.

If A isanegative value, the logarithm of the absolute value is returned with the
status “ Arithmetic error”.

Example B=l gt (A)
Datatype A: numeric, B: numeric. Or A: vector, B: vector.
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log(A)

mavg(A,B)

Built-in Programming Tool
Built-in Functions

Returns the logarithm (base €) of the expression A.
If A=0, - Over f | owisreturned with the status “ Arithmetic error”.

If A isanegative value, the logarithm of the absolute value is returned with the
status “ Arithmetic error”.

Example B=l og( A)
Datatype A: numeric, B: numeric. Or A: vector, B: vector.
Returns the moving average value of datain the expression A. B specifies how

many data to use for the average. The moving average at the index number nis
defined as follows.

Whenn< r

Whenr<n< N-r

2r+1 e

When N-r<n

_ 1

X = 0 - X.

" p+ N-ntl l_% rl

where,
Xp moving average of A for the index number n
X A value for theindex number i
r: B value
N : number of sweep steps or number of samples

If A contains someinvalid values, theinvalid values are ignored for the calculation.
For subordinate sweep, the first index number of each primary sweep is always 1.
Example C=mavg(A, B)

Datatype A: vector or numeric, B: numeric, C: vector.
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max(A)

min(A)

readThermometer
OfN1265A(A)

setDeviceld(A)

sin(A)

sqrt(A)

Built-in Programming Tool
Built-in Functions

Returns the maximum value of datain the expression A. For subordinate sweep
measurement, this function returns the maximum value of the primary sweep for
each secondary sweep step.

If thereareinvalid valuesin A, invalid values are ignored.

Example B=nmax(A)

Datatype A: vector or numeric, B: vector.

Returns the minimum value of data in the expression A. For subordinate sweep

measurement, this function returns the minimum value of the primary sweep for
each secondary sweep step.

If A containsinvalid values, the invalid values are ignored.

Example B=mi n( A)

Datatype A: vector or numeric, B: vector.

Performs the temperature measurement by using the thermometer channel specified
by the expression A, and returns the measured value. If this function is executed
when aclassic test isin progress, this function returns the last measured temperature

value. To enable the thermometer channel, see “UHC Expander / Fixture” on page
1-72. If the thermometer channel is disabled, this function returns NaN.

Example B=readTher nonmet er O N1265A( A)
Datatype A:numeric (1 or 2), B: numeric (°C).
Sets the value of the string variable A to the Device ID parameter of the test result

record. Thisvalueis effective for the test result records created after this function
cal. If the A value is an empty string, this function does nothing.

Example B=set Devi cel d( A)
Datatype A: string, B: numeric. B (returned value) is always 0.

Returns the sine value of the expression A.
Example B=sin(A)

Datatype A:numeric, B: numeric. Or A: vector, B: vector.

Returns the square root of the expression A.
Example B=sqrt (A)

Datatype A:numeric, B: numeric. Or A: vector, B: vector.
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storeAt(A,B,C,D)

string(A)

NOTE

substring(A,B,C)

swmToModule(A)

tan(A)

Built-in Programming Tool
Built-in Functions

Finds a data element in the expression A, and replaces it with the D value, and
returns the result vector data. The data element is specified by theindices B and C.
B istheindex for the primary plane of atwo-dimensional array and C is the index
for the secondary plane. The index number starts from 1. The following example
replaces the A[5, 5] value with the D value and enters the result vector datato the
variable E.

Example E=storeAt (A 5,5,D)
Datatype A: vector or numeric, B, C, D: numeric, E: vector.

Translates the expression A to a string data, and returnsiit.
Example B=string(A)
Datatype A: numeric or module, B: string.

Tranglating the variabl e defined with the numeric-symbol assignment

If the argument of the string function is a numeric variable defined with the
numeric-symbol assignment, the string function execution result will be the symbol
assigned to the numeric value, not the string value just trand ated from the numeric
value. The numeric-symbol assignment is defined in the “ Test Specification” on

page 3-5.

For the following example setup of the numeric-symbol assignment,
st ri ng( Mode) execution result at Mode=0 is the string OFF, not the string O.

Parameter Mode, Value=0, Symbol=OFF

Extracts astring from the string A, and returnsit. B is the index used to specify the
first character to extract, and C is the number of characters to extract. The index
number startsfrom 0. If B or C isnot an integer, digits over the decimal point are
used as the integer. The following example returns G.

Example D=substring("AGQ LENT", 1, 1)

Datatype A: string, B, C: numeric, D: string.

Searches the measurement module connected to Agilent B2200/E5250 switching
matrix input port number A. And returns the module name.

Example B=swnifoModul e( A)

Datatype A: string (Input port number 1 to 14), B: module.

Returns the tangent value of the expression A.
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Example B=tan(A)
Datatype A: numeric, B: numeric. Or A: vector, B: vector.
value(A) Translates the string A to a numeric data, and returnsit. If the A valueisinvalid as
numeric literal, 0 isreturned.
Example B=val ue(A)
Datatype A: string, B: numeric.
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NOTE

@Ml

@MX

@My

@MYn

Built-in Programming Tool
Read-out Functions

Read-out Functions

The read-out functions are built-in functions for reading various values related to a
analysistool which ismarker, cursor, or line. You can use these functionsto perform
complex analysis of the measurement results.

To read the value of the read-out function, use a numeric variable. The following
example reads the X intercept of the line 1 and entersit to the variable A.

Example A=@1X

In this section, n of the function nameis an integer (1to 8), and mis1or 2.

You cannot assign a data variable that includes a read-out function to an axis of a
graphics plot.

If the analysistool that isreferred to by the read-out function is not displayed, the
read-out function uses the position at which it was most recently displayed. If the
analysistool has not been displayed, the read-out function returnsinvalid data.

In the application test definition, to use aread-out function in a component such as
ASSIGN, IF, FOR, Application Test, and Classic Test, place the Auto Analysis
component before the component, and set the analysis tool associated with the
read-out function.

Functionsfor Marker

Returns the index number of measurement data at the marker location.

If interpolation mode is enabled and the marker is located between the measurement
data, this function returns a non-integer value.

Returns the value of the X coordinate at the marker location.

Returns the value of the Y coordinate at the marker location.

If therearetwo Y axes, this function returns the value for the selected axis.

Returns the value of the Y n coordinate at the marker location (n: 1 to 8, integer).
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@CX

@cCy

@CYn

@LmCO

@LmG

@LmGn

Built-in Programming Tool
Read-out Functions

Functions for Cursor
Returns the value of the X coordinate at the active cursor position.

Returnsthe value of the Y coordinate at the active cursor position. If therearetwo Y
axes, this function returns the value for the selected axis.

Returns the value of the Y n coordinate at the active cursor position (n: 1 to 8,
integer).

Functionsfor Line

Returns the correl ation coefficient of the regression for Linem (m: 1 or 2).

Line m must be in regression mode. If not, this function returnsinvalid data.

Returnsthe slope of Linem (m: 1 or 2).
If therearetwo Y axes, this function returns the value for the selected axis.
This function cal cul ates the slope by using the following formula:

» IftheX andY axesare both linear scale;
a = (Y1~ Yo) / (X1~ Xo)

» If the X axisislog scale, and the Y axisislinear scale:
o = (y1- Yo) / (I0g X3~ 10g Xg)

» If the X axisislinear scale, and the Y axisislog scale:
a = (logys- log yo) / (x1- Xo)

» IftheX andY axes are both log scale:

a = (logys- log yo) / (log x4- log Xp)

where,
a: Slopeof Linem
Xg,Y0,X1,Y1: XandY coordinate values at the two points where Linem

intercepts the perimeter of the plotting area.

Returnsthe slope of Linem (m: 1 or 2) for the Yn axis (n: 1 to 8, integer).

This function cal cul ates the slope by using the following formula:
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If the X and Y n axes are both linear scale:
a = (y1- Yo) / (X1~ Xo)
» If the X axisislog scale, and the Yn axisislinear scale;

a = (Y1~ Yo) / (log X3~ log Xp)

» If the X axisislinear scale, and the Yn axisislog scale:
a = (logys- log yo) / (x1- Xo)
» If the X and Y n axes are both log scale:

a = (log ys- log yo) / (log x4~ 10g Xg)

where,
a: Slope of Linem
Xo0,Yo,%X1,Y1:  XandY coordinate values at the two points where Linem
intercepts the perimeter of the plotting area.
@LmX Returns the X intercept value (Y=0) of Linem(m: 1 or 2).

If Line mis horizontal, this function returns invalid data.

@Lmy Returnsthe Y intercept value (X=0) of Linem(m: 1 or 2).
If therearetwo Y axes, this function returns the value for the selected axis.

If Line misvertical, this function returns invalid data.

@LmYn Returnsthe Yn (n: 1 to 8) intercept value (X=0) of Linem (m: 1 or 2).

If Line misvertical, this function returns invalid data.

Functionsfor Two Line Display

@IX Returns the value of the X coordinate at the intersection of Line 1 and Line 2.
This function cal cul ates the intersection by using the following formula.
X=(y2 ) | (0 0tg)
where,

X: Value of the X coordinate at the intersection. If the X axisislog scale,
this function returns 10X,
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@lYn
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Ym : Y intercept value of Linem (m: 1 or 2). If theY axisislog scale, y,,, is
thelog value of the Y intercept of Linem.

Om - Slopeof Linem

If Line 1isparalel to Line 2, this function returns invalid data with the status
“Arithmetic error”.

Returnsthe value of the Y coordinate at the intersection of Line 1 and Line 2.
If therearetwo Y axes, this function returns the value for the selected axis.

This function cal culates the intersection by using the following formula:

Y =yitaq x(Yo- y1) / (0g- ap)

where,

Y: Value of the Y coordinate at the intersection. If the Y axisislog scale,
this function returns 10" .

Y - Y intercept value of Linem (m: 1 or 2). If theY axisislog scale, y,is
thelog value of the Y intercept of Linem.

Om Slopeof Linem

If Line 1isparalel to Line 2, this function returns invalid data with the status
“Arithmetic error”.

Returnsthe value of the Yn (n: 1 to 8, integer) coordinate at the intersection of Line
landLine2.

This function cal cul ates the intersection by using the following formula:

Yn=yi+ag x( Y- Y1) / (0g- ap)

where,

Yn: Value of the Yn coordinate at the intersection. If the Yn axisislog
scale, this function returns 107",

Y - Ynintercept of Linem(m: 1 or 2). If theYn axisislog scale, y, isthe
log value of the Yn intercept of Line m.

Om Slopeof Linem

If Line 1isparalel to Line 2, this function returns invalid data with the status
“Arithmetic error”.
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ASSIGN
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Script Program Satements

The program statements are used to define the test execution flow on the Test
Contents tab screen of the Test Definition window. On the screen, click the Program
Component tab. The program statements are listed in the component selection area.
See also “Program Component” on page 3-26.

This statement defines the local variables used in the test definition. For the setup
editor, see “Local Variable Definition” on page 3-24. For the available names and
variable types, see“Variables and Expressions’ on page 5-3.

Thelocal variables are effective only for thistest definition.

This statement enters a value or expression to the variable as follows:
<variable> = <definition>

where, <variable> is the variable to define, and <definition> is the value or
expression.

Beginning of the BLOCK/END BLOCK block. The statements are added to the
program list as a pair. The test execution flow (program) must be defined between
the statements. Optionally, the following statements can be used in this block.

*+  ON ERROR

This statement enables an event-initiated branch performed when an error
occurs. The routine to be performed when error occurs must be defined between
ON ERROR and END BLOCK or between ON ERROR and FINALLY.

*  FINALLY

This statement enables an event-initiated branch performed just before
terminating the block. The routine to be performed before terminating the block
must be defined between FINALLY and END BLOCK.

The statements or components between the BLOCK and END BLOCK statements
are performed from top-down. If no error occurs during program execution, the
routine below FINALLY is executed and the block is terminated.

If an error occurs, the error code is stored in the @ERROR system variable, the
routine below ON ERROR is executed, and the block is terminated. If FINALLY is
used, the routine below FINALLY is executed before the block is terminated.
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END

ERROR

FOR
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Script Program Statements

This statement enters acomment in the program line.

This statement terminates program execution. After the END statement, the routines
defined by the FINALLY statement are performed.

This statement causes an error. However, no error code is stored in the @ERROR
system variable because of the fictious error.

Beginning of the FOR/NEXT loop block. FOR and NEXT are added to the program
list as a pair. The statements repeatedly performed when looping must be defined
between the statements. The FOR/NEXT statements are entered as follows:

FOR <variable> = <initia value> TO <terminate value> STEP <step value>
NEXT <variable>

where, <variable> is a variable used for the loop counter. <initial value>,
<terminate value>, and <step value> are values for the loop counter start value, stop
value, and step value respectively.

The EXIT FOR statement is available to exit from the loop before the loop count
reaches <terminate value>. After looping, the next line of NEXT is performed.

Beginning of the IF/END IF block. The statements are added to the program list asa
pair. The IF statement specifies the primary branching condition. The routines
performed when the condition is satisfied are defined between the statements. The
statements are entered as follows:

|F <expression>
END IF

where, <expression> is the condition of branching. Optionally the following
statements can be used in this block.

» ELSE IF <expression>

This statement specifies the additional branching condition used when the
previous condition is not satisfied, and defines the routines performed when this
branching condition is satisfied.

» ELSE

This statement defines the routines performed when no branching condition is
satisfied.
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LOOP Beginning of the LOOP/END L OOP block. LOOP and END LOOP are added to the
program list as a pair. The statements repeatedly performed during looping should
be defined between the statements.

The EXIT LOOP statement isavailable to exit from the loop. After looping, the next
line of END LOORP is performed.

Example 1 Test definition name: Vth_gmMax

Local Variables Definition
BLOCK
I****xx | ntegration Tinme Setting *****
I F I ntegTi me=" SHORT"
I nt egMode = " MANUAL"
AdcFactor = 8
ELSE | F | ntegTi me="MEDI UM
I ntegvbde = "PLC'
AdcFactor =1
ELSE | F | ntegTi me="LONG'
I ntegvbde = "PLC"
AdcFactor = 16
END | F
xxxkx | J\/ Sweep **rr*
Vt h_gmrax
**%%% Analysis ***x+
Aut o Anal ysi s
END BLOCK
Line 1: Defines local variables.

Line 2: Beginning of program. Program ends by the END BLOCK statement.

Line 3: Comment line. The COMMENT statement is used.

Lines 4 to 13: Changes the integration time setting by the variable IntegTime value.
Line 14: Comment line. The COMMENT statement is used.

Line 15: Executes Vth_gmmax of the Application Test component to perform Id-Vg
measurement.

Line 16: Comment line. The COMMENT statement is used.

Line 17: Executes Auto Analysis of the Analysis component.
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Example 2 Test definition name: NandFlash 1V-Write-1V

Local Variables Definition
BLOCK
I****xx | ntegration Tinme Setting *****
| F I ntegTi me=" SHORT"
I ntegvbde = " MANUAL"
AdcFactor = 8
ELSE | F | ntegTi me="MEDI UM
I nt egvbde = "PLC'
AdcFactor =1
ELSE | F | ntegTi me="LONG'
I ntegvbde = "PLC"
AdcFactor = 16
END | F
I*xx%x | [V Sweep & Analysis Initial Characteristics *****
For ceP&
Id-Vg_lnitial
Reset PG
Aut o Anal ysi s

(continues to the next page)

Line 1: Defineslocal variables.

Line 2: Beginning of program. Program ends by the END BLOCK statement.

Line 3: Comment line. The COMMENT statement is used.

Lines 4 to 13; Changes the integration time setting by the variable IntegTime value.
Line 14: Comment line. The COMMENT statement is used.

Line 15: Executes ForcePG2 of the Application Test component to apply pulse from
the Output 2 terminal of Agilent 81110A pulse generator connected to the B1500.

Line 16: Executes |d-Vg_lInitia of the Application Test component to perform
|d-V g measurement.

Line 17: Executes ResetPG of the Application Test component to reset Agilent
81110A.

Line 18; Executes Auto Analysis of the Analysis component.
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(continues from the previous page)

Vthlnitial = getNurericData("VthBefore")

Vgat eLi st = get Vect or Dat a("Vgate")

IdlnitialList = getVectorData("ldrain")

I ****xx Force Pul se *****

For cePGL

Reset PG

I*xxxx | [V Sweep & Analysis after Wite *****

For ceP&

Id-Vg_Witten

Reset PG

Auto Anal ysis

VthWitten = get NumericData("VthAfter")

IdWittenLi st = getVectorData("ldrain")
END BLOCK

Lines 19 to 21: Entersthe value of the variables (VthBefore, V gate, Idrain) defined
in the Function Setup or Display Setup of the Id-Vg_Initial test into the local
variables (Vthinitial, VgatelList, IdInitialList). The ASSIGN statements are used.

Line 22: Comment line. The COMMENT statement is used.

Line 23: Executes ForcePG1 of the Application Test component to perform the
NAND-type flash memory write operation.

Line 24: Executes ResetPG of the Application Test component.
Line 25: Comment line. The COMMENT statement is used.
Line 26: Executes ForcePG2 of the Application Test component.

Line 27: Executes |d-Vg_Written of the Application Test component to perform
|d-V g measurement.

Line 28: Executes ResetPG of the Application Test component.
Line 29: Executes Auto Analysis of the Analysis component.

Lines 30 to 31: Entersthe value of the variables (VthAfter, Idrain) defined in the
Function Setup or Display Setup of the Id-Vg_Written test into the local variables
(VthWritten, IdWrittenList). The ASSIGN statements are used.

Line 32: End of program
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